e @ .“

Oracle Fusion
Cloud Applications

Help Desk: Questions and Answers




Oracle Fusion Cloud Applications
Help Desk: Questions and Answers

F84747-37
Copyright © 2025, Oracle and/or its affiliates.

Author: JKOLB


https://docs.oracle.com/pls/topic/lookup?ctx=en%2Flegal&id=cpyr&source=

Oracle Fusion Cloud Applications
Help Desk: Questions and Answers

Contents

ORACLE

Get Help i
1 Questions and Answers 1
What's a resource team? 1
How do | configure infolets for my users? 1
What's Import and Export Management? 2
How do | modify lookups for Help Desk requests? 3
How are inbound messages processed? 5
How do | configure the media toolbar? 7
How do | create an inbound message filter? 8
How do | view Help Desk analyses using OTBI? 9
What's Computer Telephony Integration (CTI)? 9
What are work assignments? M
How do | manage SmartText entries? 12
How do | configure an email channel? 13
How do | configure profile options for inbound and outbound email in Help Desk? 15
How do | assign work to agents? 21
How do | set channel capacity? 22
What happens if a newly created request isn't assigned to a queue? 22
How do | enable Smart Text for Help Desk? 23
What are the different infolets, and who has access to them? 24
Can | add a logo to help desk outbound emails? 28
How do | configure the presence and availability privilege? 30
Is reporting and analytics available in Help Desk? 31
How do | set up a delegation for users to create Help Desk requests on behalf of others? 32
How do | manage action plan actions for Help Desk? 34
How do | manage resource teams? 39
How are business units for set up for Service and Help Desk? 40
How do | enable multiple business units for Help Desk? 41
How do | manage resource teams? 42
How do | set up request visibility based on queue? 42
How do | change acknowledgment messages for inbound email? 43



Oracle Fusion Cloud Applications
Help Desk: Questions and Answers

How do | set notification preferences?

How do | define notification triggers?

How do | set up groovy notification triggers in Help Desk?

How do | enable notifications?

Export Data

Can | configure the prefix for Help Desk requests?

How do | set up a Slack channel: Method 2?

How do | automatically route chat work assignments to agents?

How do | change email templates to display the email thread?

How do | display email thread of past conversations?

How do | configure profile options to display an email thread?

What's the life cycle of a help desk request?

Why assign an owner to a queue?

How do | add the queue owner field to the page layout?

What's a Coverage Schedule and how does it work?

How do | set up more condition columns for standard coverage entitlement rules?
How do | set up a milestone based on a field | created?

How do | add the milestone to the Manage Service Milestone Configuration Task in Help Desk?
What are some examples of inbound message filters?

How do | enable subscription coverages for entitlements?

How do | use Groovy script to notify an agent that a service request has been assigned?
How do | assign work to a queue?

How can | be notified when someone replies to a message?

How do | create queues?

Can | use surveys with Help Desk?

Can | manually close a Help Desk Request?

How do | enable the Help Desk offering and its features?

How do | define email templates?

How's a help desk request closed?

How do | enable the Help Desk offering and its features?

What functional areas are supported by the Help Desk offering?

How do | configure email for Help Desk?

How do | synchronize worker data loaded through HDL in Help Desk?

How do | manage assignment objects and assignment rules for Help Desk?
How do | manage help desk request categories and product usage groups?
How do | set up a role with read-only access?

What happens when a customer sends an HR Help Desk email?

ORACLE

44
47
48
48
49
54
55
56
57
58
58
61
63
64
64
66
66
68
70

71

71
72
73
74
75
75
76
76
77
77
78
79
81
82
84
85
86



Oracle Fusion Cloud Applications
Help Desk: Questions and Answers

How do | enable the ability to add all contacts and team members or add additional email recipients? 86
How do | set up a Slack channel? 87
How do | make a field read only or required? 87
What are the profile options for Help Desk? 88
How do | manage scheduled processes for help desk requests? 92
What happens when an employee sends a help desk email? 95
What are the job and duty roles for Help Desk? 96
What roles does the Help Desk product support? 97
How do | create a saved search? 97
How do | make my saved search the default search? 98
What are the roles for Help Desk? 99
How do | resolve a request? 99
What are the analytics roles in Help Desk? 100
What subject areas are available in Help Desk Analytics? 102
How do | associate assets and work orders to Help Desk work requests? 102
What's a sample groovy script for a notification for when a help desk request is assigned? 104
How can | add fields to the Help Desk request UI? 104
What high-level steps do | need to do for creating Help Desk users? 105
What's Case Management? 105
How do | manage Digital Assistant for Help Desk? 106
How do | configure Visual Builder Studio for Help Desk? 106
How do | use Adaptive Search for Help Desk? 107
What's a sample Groovy script for when a Help Desk request is resolved? 108
What dynamic forms can | extend in Help Desk? 109
How do | control the display of channels used only for internal conversations? 15
How do | define system-access-group-based data security policies? 16
How do | define access group-based data security policies? 18
How do | Set Up a Microsoft Teams Channel? 18
How do | install the Microsoft Teams app and add it to my team? 19
How do | collaborate with Slack? 120
How do | create an email channel for collaboration or internal conversations? 120
Where do | find more information about and resources for Help Desk analytics? 120
What job roles do | grant to users for Help Desk? 121
Can | have the product and category auto-populate when a help desk request is created from an inbound email?

122
How do | restrict contact search results? 122
How do | enable Elastic Search for the Help Desk object? 123

ORACLE



Oracle Fusion Cloud Applications
Help Desk: Questions and Answers

How do | set global locale for knowledge? 124
How do I hide quick actions from the home page? 125
How do | add a custom field to the landing page for Adaptive Search? 125
Can | create a reminder notification for requests still waiting for a response? 127
How do | enable Audit History for Help Desk? 128
How do | enable mass update for help desk requests? 128
What are some common reasons why my Help Desk requests aren't getting assigned? 130
Where can | get more information about routing and queues for help desk? 130
Can | change what predefined Help Desk roles can do? 130
Can | use HCM Data Loader (HDL) or HCM Spreadsheet Data Loader (HDSL) to convert requests to cases? 131

Can | copy a Help Desk request and keep the attachment? 131
What's the maximum attachment size? 131
Can | notify all members of a queue? 131
Can | recall an email that was sent through Object Workflow? 132
Can | default the business unit (BU) of the primary contact? 133
How do | enable the Group By drop-down for HR Help Desk? 133
How do | set up tags to use with Help Desk requests? 133
How long can a help desk request remain in the application? 134
How do | configure live chat for Help Desk? 134
How do | implement chatbot for Help Desk? 138
How do | secure my help desk? 139
How do | configure Slack or Microsoft Teams for Help Desk? 139
How do | create an Internal Help Desk Request (ISR) card? 139
Can | limit actions provided to employees? 139
Can | change the standard text in an email acknowledgment that's appended to the email template? 140
How do | remove a resource user from the resource directory? 140
How do | enable Help Desk to use Intelligent Advisor? 140
How do | integrate and assign HCM journeys from Help Desk? 142
How do | change the default subject line in a help desk request? 143
Can | define which values | want to be copied when copying a help desk request? 144
How do | configure personalized signatures for help desk agents? 145
How do | manage my personal signature for Help Desk? 146
How do | control user types displayed in the contact picker? 147
Why can't | add my help desk managers as resources to new queues? 148
What happens when multiple object workflow conditions are met? 148
What's the difference between a message and a conversation? 148
How can | restrict access to categories in Help Desk? 149

ORACLE



Oracle Fusion Cloud Applications
Help Desk: Questions and Answers

How do | remove a smart action from the Smart Navigator?

How can | remove the Copy or Close options from the actions bar?

How do | configure Help Desk so that requests can be escalated to a case?

How can | remove the standard text from the email acknowledgment?

How can I restrict who can view help desk requests by category or type?

How can | hide the queue for employees in HR Help Desk (Classic)?

Can | enable milestones for requests that were created before milestone configuration was completed?
How do | enable Computer Telephony Integration (CTI) for Help Desk in the Redwood user experience?
How do | enable the Create Request by Interview button for Help Desk?

149
150
151
153
153
153
154
154
155

How can | populate the Primary Point of Contacts Area of Responsibility (AOR) details in the Help Desk SR Details

page?

How can | notify all members of a queue for help desk related events?

How do | configure Help Desk so that agents can enable their presence in the global header?
How do | do enable dynamic links for email notifications in Help Desk?

How can | enable or disable email addresses in the email channel?

How can | hide the Add Infolet option from agents?

How can | get the Help Desk Requests tile to appear on my homepage?

156
156
157
158
159
159
159

How do | make sure the only resources shown in the AssignTo field are associated with the queue that's assigned

to the help desk request?

How do | change the display name of attachment categories?

Can | manually delete a closed help desk request?

How can | automatically update a help desk request status after a customer response?
How do | remove agent access?

How do | enable dynamic links for email notifications in Help Desk?

ORACLE

159
160
160
160
161
161



Oracle Fusion Cloud Applications
Help Desk: Questions and Answers

ORACLE



Oracle Fusion Cloud Applications Get He]p
Help Desk: Questions and Answers

Get Help

There are a number of ways to learn more about your product and interact with Oracle and other users.

Get Help in the Applications

Some application pages have help icons ® to give you access to contextual help. If you don't see any help icons on
your page, click your user image or name in the global header and select Show Help Icons. If the page has contextual
help, help icons will appear.

Get Training

Increase your knowledge of Oracle Cloud by taking courses at Oracle University.

Join Our Community

Use Cloud Customer Connect to get information from industry experts at Oracle and in the partner community. You
can join forums to connect with other customers, post questions, suggest ideas for product enhancements, and watch
events.

Share Your Feedback

We welcome your feedback about Oracle Applications user assistance. If you need clarification, find an error, or just
want to tell us what you found helpful, we'd like to hear from you.

You can email your feedback to oracle_fusion_applications_help_ww_grp@oracle.com.

Thanks for helping us improve our user assistance!

ORACLE
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1 Questions and Answers

What's a resource team?

A resource team is a group of resources formed to work on work objects. A resource team can comprise resource
organizations, resources, or both. A resource team is neither hierarchically structured nor intended to implement an
organization structure.

You can use resource teams as a quick reference to groups of related resources to which you can quickly assign work
objects.

Note: You can either individually assign the members of a team to a task or assign entire teams to tasks.

How do | configure infolets for my users?

You can configure infolets that aggregate key information for a specific area, for example, personal profile.
Your users use infolets arranged in tabs in the Analytics section of the home page.

If your users don't find infolet pages on the home page, you can enable them by using the Home Configuration tab in
the Structure work area. Let's look at some tasks you can do to configure infolets.

- Create infolets.
- Add content to infolets. For example, you can add a task flow or a performance tile report, and if an infolet
contains a performance tile report, then you can add a link to a detailed report in the same infolet.

Note: In the context of infolets, a report is an analysis, not an Analytics Publisher report.

- Edit infolets. For example, edit infolet content and add, change, or remove link to detailed report.
- Delete infolets.

But before you start creating and editing infolets, here are a few things to keep in mind:

- You can add analyses from the catalog to an infolet, but not Analytics Publisher reports, or other objects like
filters or prompts.

- To create or edit infolets, you must first either create and activate a sandbox, or activate an existing one. But
make sure the sandbox has the Page Composer tool selected. If you want to make changes in a context layer
that isn't the default layer, Site, you must create a separate sandbox just to use Page Composer in it. You can
then change the context layer from Site to the other layer. For example, to create or edit infolets for a user with
a specific job role, you must select the Job Role context layer.

- You can validate your changes in the sandbox in preview mode before you publish it.

ORACLE
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Related Topics
» Configure Infolet Display

« Best Practices for Using Page Composer in Sandboxes

What's Import and Export Management?

Import and Export Management is used to import and export a wide range of application data using import and export
management in your service application.

For example, you can use Import and Export management to export object data so that you can import it into another
instance. You can also import records to the applications so that you don't have to create the records in the user
interface. Only users with the or Help Desk administrator role can import and export objects.

Overview of Import Objects
You can import several objects into the application using the import management framework.

To import objects, Click Tools > Import Management > Import Objects.

The following is a sample list of top-level and sublevel objects that you can import into the service application. For more
information on these and other objects available for import, see the Oracle Fusion Understanding Import and Export
Management for Sales and Service guide.

- Help Desk Requests

o Messages
o Contact Members
o Resource Members

o References
« Queues

o Queue Party Resources

o Queue Team Resources

- Categories

Note:

o Since the request data depends on queues and categories, you must import the queues and
categories before importing your help desk requests.

- Interactions: You can't import interactions into the application, but you can export the interactions for the help
desk requests.

- Inbound email

- Inbound Message Filters: You can import the inbound message filters through Setup and Maintenance.

ORACLE
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- Milestone Configuration: You can import and export milestone configurations only through Setup and
Maintenance.

- Channels
o Channel Resources

- Standard Text Folders: The import facility doesn't support importing hierarchical data directly. To import folders
hierarchies, such as parent and child relationships, you must import the standard text folders data twice. The
first time you import the file, the object data is added, and the second time you import the same file, the
relationships are created.

- Standard Text Variables
- Standard Text
o Standard Text Relations

- Self-Service Roles

Overview of Export Objects

You can extract large volumes of data from the application using bulk export. You can either extract a full set of records
for an object, or perform incremental extracts. For example, you can extract the complete set of service requests data or
extract an updated set of records every week.

To export objects, Click Tools > Export Management > Export Objects. For more information, see the Oracle Fusion
Understanding Import and Export Management for Sales and Service guide.

How do | modify lookups for Help Desk requests?

Administrators can change lookups for help desk requests. Optionally, you can map status values to status types. By
default, the following five Status types exist for help desk requests:

A help desk request always has one of these status types. However, administrators might want to display different labels
for status types or change the display sequence. For example, this might be useful in situations where you want to
distinguish between statuses as "In Progress - Troubleshooting" versus "In Progress - Repairing." This procedure maps
one or more Statuses to status types.

The following tasks are used to change the request lookups for Internal Help Desk:
Internal Help Desk Tasks
Task Description

Manage Severities for Internal Help Desk Manage the values and color coding that indicate the severity of the issue to the employee for Internal
Requests Help Desk Requests.

Manage Status Values for Internal Help Set up Status Values for Internal Help Desk Requests and map them to the required status type.
Desk Requests
Manage Outcomes and Resolutions for Set up Outcomes and Resolutions for Internal Help Desk Request wrap-ups.

Internal Help Desk Requests

ORACLE



Oracle Fusion Cloud Applications
Help Desk: Questions and Answers

Task

Manage Profile Options for Internal Help
Desk Requests

Manage Categories for Internal Help Desk
Requests

Chapter 1
Questions and Answers

Description

Set up Profile Options for Internal Help Desk Requests.

Set up the category hierarchy that describes the nature of the Internal Help Desk Requests submitted
by the employee.

The following tasks are used to change the request lookups for HR Help Desk:

HR Help Desk Tasks

Task

Manage Severities for HR Help Desk
Requests

Manage Status Values for HR Help Desk
Requests

Manage Outcomes and Resolutions for HR

Help Desk Requests

Manage Profile Options for HR Help Desk
Requests

Manage Categories for HR Help Desk
Requests

Description

Manage the values and color coding that indicate the severity of the issue to the employee for HR Help

Desk Requests.

Set up status values for HR Help Desk Requests and map them to the required status type.

Set up Outcomes and Resolutions for HR Help Desk Requests wrap-ups.

Set up Profile Options for HR Help Desk Requests.

Set up the category hierarchy that describes the nature of the HR Help Desk Requests submitted by the
employee.

The following tasks are shared between Help Desk (both HR and Internal Help Desk) and the Service offering (used by
the CX solution). Important: See the Caution note in the following procedure.

Shared Tasks Between Help Desk (both HR and Internal Help Desk) and B2B Service

Task

Manage Service Request Internal Priorities
Manage Service Request Channel Types
Manage Service Request Sources

Manage Service Request Resolutions

Manage Service Request Problem Types

ORACLE

Description

Review and define lookup values that provide choices for a Service Request's Priority.

Specifies the origin of the service request and the communication mechanism of each message.
Specifies the source or user interface where the request was created.

Specify the values identifying how the Service Request was ultimately resolved.

Specifies the type of problem reported in the request.
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To change lookups:

1. Inthe Setup and Maintenance work area, go to the following:

o Offering: Help Desk
o Functional Area: Help Desk Request
o Task: Select All Tasks and click the task you want to change.

CAUTION: If the task doesn't specifically say Internal Help Desk or HR Help Desk, it's a shared task.
Changes in tasks that are shared with the Service offering will impact the setup for existing service
requests (used in CRM and the previous generation HR Help Desk). If your company is using the CRM
Service application or the previous generation help desk, be sure to coordinate any changes to shared
tasks with the Service Administrator.

In Lookup Codes, click the lookup code that you want to change.
Change the fields to correspond to your needs.
Click Save and Close.

5. Repeat the procedure for all the help desk request lookup tasks.
The help desk request lookup is changed.

PUuN

How are inbound messages processed?

An inbound message is created when you receive an incoming service email from an employee. This flowchart
describes the process flow for an incoming employee email:
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An employee sends an email requesting support.
If an inbound message filter exists, then the filter is applied to the incoming message.
If the message is accepted, then an inbound message is created, and any associated attachments are extracted.
The message is verified to see if it's related to an existing help desk request.
o If the inbound message is related to an existing help desk request:

The related request is identified. If the related request can be edited, then the email content and
attachments are added to the request. If the original request can't be edited, then a new request is

created.
o If the inbound message isn't related to an existing request, then a new request is created.

5. The email ID of the sender is validated against the employee records in the database.
o The primary contact is set to the employee who sends the email. The Account field isn't updated.

o If the From email ID doesn't exist in the database, then a message is added to the request that the sender
can't be identified.

PUWUNS

ORACLE



Oracle Fusion Cloud Applications Chapter 1
Help Desk: Questions and Answers Questions and Answers

o If an SRis created with no contact or account populated.
o If more than one employee with the same email ID exists in the database, then the following scenarios

are possible:
Scenario Primary Contact in the Help Desk Acknowledgment Sent
Request
Sender's email address matches the email The matching contact is set as the An acknowledgment email is sent to the
address of one employee. primary contact in the help desk request. = sender.

Sender's email address matches the email No primary contact is set in the help desk  An acknowledgment email is sent to the

address of 2 employees. request. sender. The email states that the sender
couldn't be identified because multiple
employees were found with the email
address of the sender.

More information is requested from the

sender.
Sender's email address matches the email The matching partner is set as the An acknowledgment email is sent to the
address of 1resource. primary contact in the help desk request. = sender.

6. If any other email IDs in the message in the To or CC fields can be identified, then those IDs are added as
contacts.

Note: If the other email IDs can't be identified, then such email IDs aren't added as employees or help desk
request team members. But they're displayed in the request message.

7. Theincoming message content and the attachments are added to the new help desk request.

How do | configure the media toolbar?

An administrator can configure both the horizontal toolbar and vertical media toolbar. Live Window is an alternative to
the media toolbar. For more information about the live window, see the Configure Live Window and Companion Tab for
CTl topic in the Related Topics list.

- If the company has enabled partner Computer Telephony Integration (CTI) service.
- When the signed-in user has the access privileges to a toolbar.

An administrator can configure multiple media toolbars, and specify a default.

The default toolbar gets assigned to all users.

Tip: Set the toolbar with the greater number of users as the default toolbar.

An administrator can also set other users to the non-default toolbar, or alternatively the agents can do this themselves.

ORACLE
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An administrator can set the alternative toolbar for users by using the
SVC_OVERRIDE_PARTNER_TOOLBAR_SELECTION profile option and creating a user row with the alternative toolbar for
each user.

Agents can set an alternative toolbar by doing the following:

1. Click the Settings and Actions menu, and select Set Preferences.

2. Click Media Toolbar, and then click the Override Media Toolbar drop-down list and select the alternative
toolbar.

3. Click Save and Close, then sign out and log back in.

While configuring the toolbars, you can also configure incoming call notification window. The notification window
displays basic details about the incoming call.

Related Topics
« What's Computer Telephony Integration (CTI)?

» How do | configure screen pop pages?

How do | create an inbound message filter?

To create an inbound message filter:

1. Inthe Setup and Maintenance work area, go to the following:
o Offering: Help Desk
o Functional Area: Email Communication Channel
o Task: Manage Email Filters

2. Onthe Inbound Message Filters page, click Create.
3. On the Create Message Filter page, select a filter type. Filter type indicates the message part on which the
filter is applied. A filter type can be one of the following:

o File attachment: A filter is applied to the file type of an attachment.

o Header: A filter is applied to a message header.

o Mime attachment: A filter is applied to the mime type of an attachment.
o Reply to: A filter is applied to the Reply To address.

o Sender: A filter is applied to the sender of the message.

o Subject: A filter is applied to the subject of the message.

Note: File attachment and Mime attachment filters prevent attachments from getting added to a help desk
request or help desk request message. But they don't prevent the creation of the help desk request or help
desk request message.

Specify a Field Name. The field name is required only for Header filters.

Specify an alphanumeric Filter Pattern. For examples, see "Examples of Inbound Message Filters".
Select an Action on Pattern Match to Accept or Reject.

Specify an optional Description.

Click Create.

0o vk
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Note: All filters are enabled by default. To disable a filter, update the properties as described in "Update an Inbound
Message Filter."

How do | view Help Desk analyses using OTBI?

Oracle Transactional Business Intelligence (OTBI) is a real time, self-service reporting solution bundled with your
application. You can view analysis for the help desk on the Help Desk Dashboard which is accessed from the Help Desk
Request list page.

OTBI provides prepackaged analytic content built on the Oracle Business Intelligence (BI) platform. These include
subject areas for building your own dynamic analyses using an intuitive interface, industry standard metrics, and role-
based, best practice reports and dashboards that deliver up-to-the-minute business insight across the entire extent of
your service-related business operations.

Here's how you can view the analyses:

- To access Bl Catalog, select Navigator > Tools > Reports and Analytics. The Reports and Analytics page is
displayed.

o Click the Hierarchical Selector >> icon and select My Folders or Shared Folders from the menu.
Alternately, you can click the Browse Catalog button. The Bl Catalog is displayed, where you can view
your personal and shared analyses. You can also create your own analyses based on your business
requirements using subject areas. You need to have the necessary privilege for authoring analyses.

- To access the Analytics page, from the Home page, click the Service group icon, and then click the Analytics
icon. The Analytics page is displayed. You can search for the analyses available in Bl Catalog, and mark your
favorites. These favorites stay on the Analytics page as long as they remain favorites. This page also shows the
analytics recently viewed by the signed in user.

- The Help Desk Dashboard is accessed from the Help Desk Request list page. Click the Dashboard icon.

How You Manage Service Infolets

For the prebuilt Service roles, the Service Infolets page displays the infolets based on the user's role. For administrator-
defined roles, administrators must enable the Service Infolets page for each new role.

The procedures to create, manage, and enable Service infolets are the same as that for Sales infolets.

For information about how to build analytics, see Create and Edit Analyses Using a Wizard.

What's Computer Telephony Integration (CTI)?

Computer Telephony Integration (CTI) enables integration of third-party media toolbars with Service Center, Help Desk,
Fusion Sales, and CX for utilities. You can display a media toolbar by enabling the Partner CTI Service and by assigning
users the Access Partner Media Toolbar privilege which provides users access to the media toolbar.

Here's a look at a basic CTI flow. A customer calls the customer care number which is received by an agent. Customer
information is displayed to the agent on a Customer 360 page. The CTl provider eases the communication between the
customer and the customer care agent.

ORACLE
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Use CTl to:
- Make an outbound call and skip manual dialing
- Receive phone calls

Integrate with CTl to:
- Receive notifications of incoming calls and either accept or reject the call
- Use automatic caller identification
- Search for a contact
- Get optional caller verification
- Display administrator-defined screen pop pages
- Record interactions

- Use optional call wrap up

Here's an overview of how all the pieces fit together:
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- CTl enables the integration of third-party media toolbars with your Fusion application.

- Oracle provides the MCA (Multi Channel Architecture) framework for communication between the Fusion
application and the Media Toolbar application (also known as, the Partner application) through a JavaScript
library, the Ul Events Framework (UEF).

10
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- Consider the media toolbar a container provided by Fusion and the Partner application is embedded in it.

The Partner application is a web application that you must implement. You can do this, or your Systems
Implementor can do it, or you can contact one of Oracle’s telephony partners listed on Oracle Cloud
Marketplace.

What are work assignments?

You use the assignment engine to assign resources (for example, service personnel or territory owners) to the business
objects they must work on, such as a help desk request. Being assigned to business objects gives resources and their
manager's visibility into the business object.

You also use rule-based assignment to assign additional resources to objects.

Candidate and Work Objects

When setting up assignments, you must be familiar with two types of assignment objects: candidate objects and work
objects.

- Work objects are the business objects that are assigned, for example, help desk requests.

- Candidate objects are the possible pool of assignment candidates, for example, resources.

Rule-Based Assignment

Rule-based assignment lets you set up more rules that are used to assign resources to work objects. After you set up
the rules containing the conditions that records must meet when resources match the rule conditions, they're assigned
to the object.

For example, you use rules to assign a certain agent to a certain queue when the customer is in a specific state or
region.

Rule-based assignment requires that you plan your rules, create the rules using the rules Ul, and set profile options to
configure the assignment behavior, in addition to any scheduled processes that must be run.

Assignment Profile Options

Each of the business objects available in assignment has its own set of profile options that enable you to further
configure the application behavior.

Scheduled Processes

Scheduled processes are batch jobs that capture data and let business objects to act on that data. You must schedule
several processes when using assignment. See the Service Request Queue Assignment topic in the Oracle Fusion Cloud
Sales Understanding Scheduled Processes guide.

Assignment Reports

You use the Diagnostic Dashboard to generate reports about the assigned objects and the volume of territory data
involved in assignment.
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Assignment Resources

To learn more about assignment, see the following resources:

- Online help: Use the keyword assignment to search for the relevant topics.

- Assignment Resource Center: See the Assignment Manager Resource Center page on My Oracle Support (Doc
ID 1522958.1) for more resources.

How do | manage SmartText entries?

A SmartText entry is a reusable fragment of text that you or your users can create and use in help desk request
messages. You can also create SmartText messages to use in chat.

As an administrator, you can create public SmartText entries that all users can use. Users can’t edit these entries.

You can create SmartTexts in multiple languages. You can use rich-text to create SmartText entries in help desk request
message fields by enabling HTML. Other help desk request fields, such as Problem Description, Solution Description
and Transfer Help Desk Request only support plain text.

You can define where to save the SmartText entry, insert variables in the entry, and choose to share the SmartText entry
by using the following availability options:

- Always: Select this option to make the SmartText entry available to users at all times.
- Interval: Select this option and define the period during which this entry is available to users.

- Disabled: Select this option to disable the SmartText entry and display it in the public folders for the users.

Required Privileges

The following table shows the different privileges you grant to allow your users SmartText access.

Privilege Code Description

Use SmartText SVC_USE_STD_TXT_PRIV Allows a user to view, search and insert
SmartText.

Manage SmartText SVC_MANAGE_STD_TXT_PRIV Allows a user to create, update, and delete

SmartText for their own use.

Publish SmartText SVC_PUBLISH_STD_TXT_PRIV Allows a user to set the scope of SmartText to
GLOBAL which allows any user with the correct
privilege to view and use that entry.

Administer SmartText SVC_ADMIN_STD_TXT_PRIV Allows the user to administer SmartText.
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Require Agents to Provide User Entered Values when Inserting SmartText

You can enable your application to require agents to enter values for user variable prompts when they select a
SmartText. This ensures that all requested data is captured.

Here's the profile option you need to set to activate the functionality:

1. Inthe Setup and Maintenance work area, go to the following:
o Offering: Service

o Functional Area: Productivity Tools
o Task: Manage Global Search Profile Options

2. Search for the profile option code ORA_SVC_SMARTTEXT_MANDATORY_USER_VARIABLES
3. Set the site level profile value to Yes.
4. Click Save and Close.

How do | configure an email channel?

To send emails to your employees and to receive emails from them, you must first set up an email channel.

You can create separate email channels for different application stripe codes. For example, one for CRM and one for
HCM. However, you can use the same email channel for both inbound and outbound emails:

Note: You can add attachments totaling 10MB to an email.

Inbound email: Indicates the service emails received from your employees. As part of your implementation,
you must set up a forwarding rule on your company email server to redirect these emails to Oracle's
inbound email ID. This is the same email account that Oracle provided at the time of provisioning.

For example, all the support emails that are sent to TechSupport@mycompanydomain.com are forwarded

to pod_name.fa.extservice.incoming@pod name-opcwf.mail.dcsn.oraclecloud.com for processing. The
SVC_INBOUND_EMAIL_ADDRESSES profile option indicates the Oracle email ID to which the support mails
must be forwarded.

If it's required for your company, you can also create different support email channels for different business
units or divisions. For example, TechSupportDivl@mycompanydomain.com, TechSupportDiv2@mycompanydomain.com,
and so on. All the support emails sent to these different support email channels are forwarded to

pod_name.fa.extservice.incoming@pod name-opcwf.mail.dcsn.oraclecloud.com for processing.

Note: If you're implementing HR Help Desk or Internal Help Desk, then you must define a channel with
the appropriate application stripe. The account name of the channel must match the email address of your
mailbox from which you're redirecting or forwarding emails to the Oracle mailbox mentioned above. If you
don't define the appropriate channel, the requests created for the emails are set with the CRM application
stripe. In such cases, you must run an ODI import process to update the application stripes of the SRs.

The SVC_INBOUND_EMAIL_ADDRESSES profile option contains two email IDs:

o For HR Help Desk, use the email ID that contains the text 'intservice' as a part of the ID, as the forwarding
email ID.
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Note: You must avoid updating these inbound email addresses. If you need to update these inbound email
addresses for some reason, you must complete the following steps:

o Update the corresponding forwarding rule.

o Ensure that you register the updated inbound email addresses as access points for inbound
email. See How do | register or unregister access points for inbound email?

- Outbound email: Indicates the emails that are sent by the Help Desk application from the help desk request.
For example, when an agent responds to the primary employee contact.

To ensure that your outbound email is delivered successfully to your external recipients, you must set up a
Sender Policy Framework (SPF) policy on your domain.

To enable Oracle to send out an email on your behalf, you must do the following:

o Set up an SPF policy on your domain as an authentication mechanism. The exact method
of setting up an SPF policy varies from one domain provider to another. For example, v=sp£1

include:spf_c.oraclecloud.com ~all.

o To set the support agent's name as the From Name in outbound emails, set the value for the
SVC_USE_RESOURCE_NAME_IN_OUTBOUND profile option to Yes. For more information, see How do |
set the From Name in outbound emails?

To configure an email channel for an employee:

1. In the Setup and Maintenance work area, go to the following:

o Offering: Help Desk
o Functional Area: Other Communication Channels
o Task: Manage Communication Channels

2. Inthe Service Channels page, click Create Channel.
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3. Inthe Create Channel window:

a.

Select a Stripe Code.
Select the Channel Type as Email.
Specify the support email ID of your company as the Account Name. For example:

support@mycompanydomain.com

If a forwarding rule is configured, all the mails that are sent to the specified support email ID are
forwarded to Oracle's inbound email ID. If an outbound email is configured, Oracle can send mails to the
customer as the specified support email ID, on your behalf.

Verify whether the generated Channel Code is unique.

The channel code is autogenerated and it uniquely identifies a communication channel when exporting
or importing channels from one environment to another.

- If the auto-generated channel code is unique, you can leave it unchanged.
- If the auto-generated channel code isn't unique, add a set of characters to the code to make it
unique.
(Optional) Specify a Display Name to indicate any information about the channel, such as the name of
the deploying company for which the channel is being configured.

When a new channel is being created, it's active by default. To deactivate it, clear the Active option.
(Optional) From the Business Unit drop-down list, select a Business Unit (BU).

The BU set in the scope is selected by default, but you can select a different BU. This column appears
only if the multiple business units feature is turned on.

Click Save.

How do | configure profile options for inbound and
outbound email in Help Desk?

You can set options for incoming and outgoing emails by configuring email profile options. For example: You can set the
Reply To email ID that's used to send out a receipt to the employee who sends a message.

Configure the inbound email profile options as specified in the following table.

Inbound Profile Options Description
SVC_ENABLE_INBOUND_EMAIL _ Indicates whether inbound emails from employees must be processed automatically by creating or
DEFAULT_PROCESSING updating an help desk request. If this option is disabled, only the inbound message object is created,

without creating a request.

SVC_INBOUND_EMAIL_ADDRESSES Indicates the inbound email IDs that are monitored by the Service application. The email IDs are

separated by a comma and are automatically populated during provisioning. You must use the address
to set a forwarding rule.

Try to avoid updating these inbound email addresses. If you update these inbound email addresses for
some reason, you must complete the following steps:

Update the corresponding forwarding rule.
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Inbound Profile Options

SVC_INBOUND_ENABLE_INLINE_
ATTACHMENTS

SVC_INBOUND_EMAIL_MAX_ATTACH_
SIZE

SVC_INBOUND_MESSAGE_BATCH_SIZE

SVC_EMAIL_PROCESS_UNKNOWN_CUST

SVC_ENABLE_INBOUND_EMAIL _
ACKNOWLEDGEMENT

SVC_INBOUND_ACK_EMAIL_LIMIT_PER_
USER

SVC_INBOUND_ACK_EMAIL_TIME_
INTERVAL

ORACLE
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Description

- Ensure that you register the updated inbound email addresses as access points for inbound
email.

Enables the display of images inline within the help desk request messages in the Ul.

The default value is Yes.

Indicates the maximum size in MB of attachments that are allowed in an inbound email.
The default value is 10 MB.

Here are some key points to note:

- The recommended maximum limit for the email size is 15 MB. Email size includes email headers,
attachments, and the email content.

Note: You can increase the size of the attachments past 15 MB, but this isn't recommended as it
might cause server issues

- If an email contains non text content or attachments, that gets base64 encoded, and this can
increase the overall size of the email. So when your users send emails that exceed a total size of 15
MB, such emails aren't processed by the server.

Indicates the number of emails that can be processed at a given time. This is the maximum number of
emails retrieved by every run of the Retrieve Inbound Email Messages scheduled process.

The default value is 10.

Indicates whether a help desk request must be created for emails sent by unknown employees.

Indicates whether an acknowledgment must be sent for an incoming email.
If you prefer not to have emails sent when SRs are created, disable this profile option.
To disable it, use the Manage Administrator Profile Values task in Setup and Maintenance. Search for

the SVC_ENABLE_INBOUND_EMAIL_ACKNOWLEDGEMENT profile option, and then set the profile
value to No.

Specifies the maximum number of emails to be sent to one user within a specific time interval. This
time interval is specified in the SVC_INBOUND_ACK_EMAIL_TIME_INTERVAL profile option.

The default value is 3.
Note:
Let's say you don't want to use this feature, and you want to send an acknowledgment email for
every email received from a user. In that case, you can set this profile option to a high value such as

100. It's a good idea to simultaneously set the SVC_INBOUND_ACK_EMAIL_TIME_INTERVAL profile
option to a low value such as 5 minutes.

This profile option also helps to prevent the creation of infinite email loops.

Specifies the time interval for which the limit check is applied for the maximum number of emails to be
sent to a user.
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SVC_INBOUND_EMAIL_PATTERN_TO_
STOP_ACK

ORA_SVC_ENABLE_FAILED_INBOUND_
MESSAGE_PROCESSING

ORA_SVC_ADD_FIRST_ATTACHMENT_
TO_SR_MESSAGE

ORA_SVC_INBOUND_MSG_LAST_
REPROCESSING_DAYS

ORA_SVC_ENABLE_INBOUND_PARTIAL_
STATUSES_FOR_REPROCESSING

ORA_SVC_ADD_EMAIL_RECIPIENTS_TO_
SR
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Description

This means that only the maximum number of emails specified in the SVC_INBOUND_ACK_EMAIL_
LIMIT_PER_USER profile option can be sent to one user in this time interval.

The default value is 60 minutes.
Note:

Let's say you don't want to use this feature, and you want to send an acknowledgment email for
every email received from a user. In that case, you can set this profile option to a low value such as

5 minutes. It's a good idea to simultaneously set the SVC_INBOUND_ACK_EMAIL_LIMIT_PER_USER

profile option to a high value such as 100.

This profile option also helps to prevent the creation of infinite email loops.

Specifies the email patterns that must be blocked, so that the application stops sending
acknowledgment emails to email addresses having those patterns. The default email pattern is
postmaster@.*.oraclecloud.com.

Enables the automatic processing of inbound messages that weren't processed earlier because of
internal issues.

The default value is Yes.

To stop the retrieval of unprocessed messages at any time, you can set the value to No.

Enables the agents to see the images or attachments from the first email received on a help desk
request in both the request header and the request message.

The default value is No.

Specifies the number of days before the current date when the failed inbound messages are to be
reprocessed.

The default value is 1.

Enables the reprocessing of unprocessed inbound emails from the past.

The default value is No.

When it's enabled, reprocessing starts from the last point where the processing stopped earlier.
Enables you to choose whether to add the sender and recipients of inbound emails as an SR contact
or SR team member. For a new SR, the recipients in the To or Cc lists are added as SR contacts or SR
team members, if their email IDs exist as valid party records in the application. For a reply email to
an existing SR, the sender and the contacts or team members in the To or Cc lists are added as SR
contacts or SR team members if they don’t already exist in the SR.

The default value is Yes.

When you set the value to No, the sender and recipients of inbound emails aren’t added to the SR.

Note: The sender of the first email is always added as the primary contact on the SR, irrespective of

the value of this profile option.
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ORA_SVC_UNREGISTER_INBOUND_
ACCESS_POINT

ORA_SVC_INBOUND_REPROCESSING_
OFFSET_IN_MINUTES

SVC_INBOUND_EMAIL_REGEX_TO_
EXTRACT_SR_NUMBER

ORA_SVC_INBOUND_MSG_EXCHANGE_
ONLINE_BATCH_SIZE

ORA_SVC_INBOUND_MSG_EXCHANGE_
ONLINE_FETCH_SIZE_PER_BATCH

ORA_SVC_INBOUND_MSG_EXCHANGE_
ONLINE_DELETE_SIZE
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Description

Specifies whether to make the Unregister button available. The default value is No. When it’s set to
the default value, the Unregister button isn’t available. This setting helps to prevent unregistering of
access points accidentally.

Only when you specifically need to unregister an access point, you can change the value to Yes so that
the Unregister button is available. After unregistering the access point, you can set the value of this
profile option back to No.

Used to reprocess inbound emails when it fails to create customer message on the SR. The default
value of this profile option is set to 120 (2 hours). After this duration, the reprocessing logic will try to
create customer message again on the SR.

Used to create and send a new message for an existing SR.

Note: If the default value can't extract the SR number from the inbound email body, then try adding
an extra # to the default value.

Specify the maximum number of inbound messages to read from Microsoft Exchange online in one
ESS Job iteration.
The default value is 10

The maximum value is: 200

Specify the maximum number of inbound messages to be processed from Microsoft Exchange online
in one subset of a batch.

The default value is 10

The maximum value is: 20

Specify the maximum number of inbound messages to be deleted from Microsoft Exchange online in
one subset of a batch.

The default value is 10

The maximum value is: 20

Configure the outbound profile options for HR Help Desk and Internal Help Desk as specified in the following table.

Outbound Profile Options

SVC_OUTBOUND_EMAIL_FROM

ORACLE

Description

Indicates the From email that's used for sending outbound emails to employees. The default value is
noreply@oracle.com. You must set the value to the no reply address for your company to prevent
auto-replies from creating unintended help desk requests.

This profile option can have the no reply email address with or without the display name. Example
without display name: noreply@mycompanydomain.com. Example with display name: Acme Support
<noreply@mycompanydomain.com>. If the profile option value doesn't contain a display name, the
display name of the email channel is used in the From address.

Let's say you set the value of this profile option as your support email ID such as
support@mycompanydomain . com. If your From email address isn't displayed in your email received
by your employee, then you'd receive a verification email at support@mycompanydomain . com. You
must follow the instructions in that email to verify the account. If you don't have access to the inbox for
support@mycompanydomain . com, then you must do one of the following:

- Contact Oracle support to get your email account verified.
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SVC_SR_FORWARD_TEMPLATE_NAME

SVC_SR_RESPONSE_TEMPLATE_NAME

SVC_SR_SYSTEM_RESPONSE_
TEMPLATE_NAME

ORA_SVC_SR_EMAIL_ATT_SIZE

SVC_ENABLE_ACKNOWLEDGMENT_TO_
ALL

SVC_ENABLE_DEEPLINKS_IN_
OUTBOUND_EMAIL

ORA_SVC_ENABLE_RESOURCE_NAME_
USAGE_IN_OUTBOUND

ORA_SVC_ENABLE_RESOURCE_EMAIL _
USAGE_IN_OUTBOUND

ORA_SVC_ENABLE_INLINE_
ATTACHMENTS_IN_OUTBOUND_EMAIL
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Description

- Set the value of this profile option to another valid email address that you can access. Now when
you send your first email to an employee, you receive a verification email. You must click the
confirmation link in the email to complete the verification.

Indicates the email template name for SR messages of type Forward.

Indicates the email template name for SR messages of type Response.

Indicates the template name for SR messages of type System Response.

Indicates the maximum permitted total size in MB of all the attachments in an outbound email that's
sent from the Service application. Oracle recommends keeping this value less than or equal to 10 MB.

The default value is 10 MB.

Here are some key points to note:

« The maximum limit for the email size is 15 MB. Emails greater than 15 MB in size aren't processed
by the email server. Email size includes email headers, attachments, and the email content. If an
email contains non text content or attachments, that gets base64 encoded, and this can increase
the overall size of the email.

- Use this profile option to restrict the email attachment size such that the total email size doesn't
exceed 15 MB.

Indicates whether an acknowledgment must be sent to users both in the To and Cc lists for every
inbound email that's received.

Indicates whether the deep links to KM articles are enabled in outbound emails and email previews.
When the deep links are enabled, this helps to translate and populate the complete URL to view the
articles.

Enables the use of the resource name as the sender name in outbound emails.
The default value is No.

Enables the use of the resource email as the sender email in outbound emails.
The default value is No.

This profile option only impacts inline attachments, not regular attachments.

Configure the outbound profile options for HR Help Desk, as specified in the following table.

Outbound Profile Options

SVC_OUTBOUND_EMAIL_FROM

ORACLE

Description

Indicates the From email that's used for sending outbound emails to customers. The default value is
noreply@oracle.com. You must set the value to the no reply address for your company to prevent auto-
replies from creating unintended SRs.
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SVC_SR_FORWARD_TEMPLATE_NAME_
HRD

SVC_SR_RESPONSE_TEMPLATE_NAME_
HRD

ORA_SVC_SR_EMAIL_ATT_SIZE

SVC_SR_SYSTEM_RESPONSE_
TEMPLATE_NAME_HRD

SVC_ENABLE_DEEPLINKS_IN_
OUTBOUND_EMAIL

ORA_SVC_ENABLE_RESOURCE_NAME_
USAGE_IN_OUTBOUND

ORA_SVC_ENABLE_RESOURCE_EMAIL _
USAGE_IN_OUTBOUND

ORACLE
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Description

This profile option can have the no reply email address with or without the display name. Example
without display name: noreply@mycompanydomain.com. Example with display name: Acme Support
<noreply@mycompanydomain.com>. If the profile option value doesn't contain a display name, the
display name of the email channel is used in the From address.

Let's say you set the value of this profile option as your support email ID such as
support@mycompanydomain . com. If your From email address isn't displayed in your email received
by your customer, then you'd receive a verification email at support@mycompanydomain.com. You
must follow the instructions in that email to verify the account. If you don't have access to the inbox for
support@mycompanydomain . com, then you must do one of the following:

- Contact Oracle support to get your email account verified.

- Set the value of this profile option to another valid email address that you can access. Now when
you send your first email to a customer, you receive a verification email. You must click the
confirmation link in the email to complete the verification.

Indicates the email template for the Help Desk Service Request Forward messages.

Indicates the email template for Help Desk Service Request Response messages.

Indicates the maximum permitted total size in MB of all the attachments in an outbound email that's
sent from the Service application. Oracle recommends keeping this value less than or equal to 10 MB.

The default value is 10 MB.

Here are some key points to note:

« The maximum limit for the email size is 15 MB. Emails greater than 15 MB in size aren't processed
by the email server. Email size includes email headers, attachments, and the email content. If an
email contains non text content or attachments, that gets base64 encoded, and this can increase
the overall size of the email.

- Use this profile option to restrict the email attachment size such that the total email size doesn't
exceed 15 MB.

Indicates the email template for Help Desk Service Request System Response messages.

Indicates whether the deep links to KM articles are enabled in outbound emails and email previews.
When the deep links are enabled, this helps to translate and populate the complete URL to view the
articles.

Enables the use of the resource name as the sender name in outbound emails.
The default value is No.

Enables the use of the resource email as the sender email in outbound emails.
The default value is No.
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To configure email profile options:

1. Inthe Setup and Maintenance work area, go to the following:
o Offering: Help Desk
o Functional Area: Email Communication Channel
o Task: Manage Inbound Email Profile Options, or Manage Outbound Email Profile Options

2. Click the name of the profile option to be set.
3. In the Manage Email Profile Options page, in the Profile Values section, click the plus icon to add a value.

4. C(lick Save.

Note: Alternatively, you can click the Manage Email Profile Options task to display the Email Profile Options page.
On this page, you can view the list of all inbound and outbound email profile options and set their values. You can also
search for a specific profile option code using the search bar.

How do | assign work to agents?

Work assignment refers to interactions or work items such as help desk requests being assigned to queues for
processing.

Work items are assigned to a queue and an agent is assigned to one or more queues. All work items in a queue are
handled by the assigned agents.

A work item can be assigned to an agent manually or automatically based on whether the associated queue is
automatic or manual.

Note: In automatic queues, the priority of a request is calculated based on severity and wait time. Help desk requests
with highest severity are assigned first. If there are multiple requests with the same severity, those requests that have
been in the queue for the longest time are assigned first. But this rule applies only to bigger volumes of requests and
many agents and not on a small scale.

Work assignment in an automatic queue is done based on the following aspects:
- Agent capacity
- Availability of the agent
Presence of the agent
- Severity of the work item
- Age of the work item

Note: Omnichannel must be enabled to use the settings for presence of the agent, availability of the agent, and agent
capacity.

Here are the various ways a help desk request can be assigned to an agent:
Manually set the Assigned To field in the Summary tab of the Help Desk Request Details page.
- Click Assign to Me from the Actions menu on the Help Desk Request Details page.

Enable Omnichannel.
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How do | set channel capacity?

Channel capacity indicates the maximum number of active interactions that an agent can handle.

Help Desk supports channel capacity for non real-time work. Active non real-time interactions are decided by the
qualifying statuses. Any interaction that's in one of the specified qualifying statuses is considered to be an active
interaction.

For non-real-time interactions, you define what qualifying statuses are considered to be active when calculating an
agent's capacity. Decide if any interaction in one of the specified qualifying statuses is considered to be an active
interaction.

To set channel capacity:

1. Inthe Setup and Maintenance work area, go to the following:
o Offering: Help Desk

o Functional Area: Assignment and Routing
o Task: Manage Capacities

2. To provide queue owners and managers the ability to change the channel capacities for individuals by
overriding the global default capacities:
In the Override Individual Capacities region, select the Enable Channel Capacities to Be Overridden for
Individuals checkbox.

3. To change the capacity of a non real-time work:

a. Inthe Work Assignments region, change the default value in the Capacity field to a new value.

b. The status in the Qualifying Status Values column indicates the status of the work items that decide
the capacity. For example, if the status is set to New, In Progress, only the work items that are in the
specified status add up to the total capacity. To specify the active statuses, click the status value.

c. Inthe Qualifying Status Values window, select a status from the No Effect on Workload list and move it
to the Adds to Workload list to qualify the status as active.

d. Click Apply.

4. C(lick Save and Close.

Note: When you export or import the functional setup data for the Service offering by using the export and import
feature in Functional Setup Manager, the Manage Capacities setup is also exported or imported. But the value of
the Override Individual Capacity checkbox isn't exported or imported. You must manually select or deselect the
checkbox.

What happens if a newly created request isn't assigned
to a queue?

If a help desk request is created without an associated queue, and Omnichannel is enabled, then the routing feature
selects a queue.
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If the queue is automatic, then the routing feature assigns the associated agent for the request. If a request is created
with an associated queue, then the routing feature selects only the agent.

How do | enable Smart Text for Help Desk?

Productivity tools such as Smart Text are features you can add to help desk request create or edit pages. A SmartText
entry is a reusable fragment of text that you or your users can create and use in service request messages. You can also
create SmartText messages to use in chat.

The following table lists productivity tools that are available for help desk requests.

Productivity tool Description Profile Option Code

SmartText A reusable fragment of text that you caninsert = SVC_ENABLE_STD_TEXT_IN_SR
in messages and fields

Productivity tools are disabled by default. Here's how you enable them:

Navigate to Setup and Maintenance.
Click the Tasks icon.
Click the Search link.
Enter Manage Administrator Profile Values in the Search field.
Click Search.
Click the Manage Administrator Profile Values link.
Enter the profile option code you want to set.
Click Search.
In the Profile Values section, for the profile option code, select Yes in the Profile Value drop-down list.
Click Save and Close.
11. Click Done.
Now, you can set up and configure each tool according to your requirements.

OCVvVONOCSUTAWUNRA
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Update the Status List Order

The status list on the Summary Details page shows a list of statuses that can be associated with a help desk request.
The order of statuses displayed in the list depends on their assigned ranking. Here's how you update the status ranking:

1. Inthe Setup and Maintenance work area, go to the following:

o Offering: Help Desk
o Functional Area: Help Desk Request

o Task: Manage Service Request Status Values for Internal Help Desk Requests or Manage Status Values for
HR Help Desk Requests
2. Update the Ranking column to position the status in the status list according to your requirements.

3. Click Save and Close.
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What are the different infolets, and who has access to

them?

This section describes the Service infolets available to customer service representatives, customer service managers,
help desk agents, and help desk managers.

Infolet

My Resolve Time

Pending Tasks

Waiting on Customer

Waiting on Me

ORACLE

Description

Shows the average time you took to resolve
assigned service requests over a 30 day period.
It enables you to view that information against
the average time taken by all agents to resolve
service requests over the same period of time.

Displays the pending tasks that are assigned to
you along with the priority (high, medium, or
low) of each. You can also view tasks that are
past their due date.

Displays an overview of the service requests
that are waiting on the customer. You can view
the following information:

« Number of service requests in the Waiting
status.

- Number of service requests that are
resolved.

- Total number of service requests assigned
to the user, which includes both resolved
requests and requests waiting on the
customer.

- Total number of critical service requests
assigned to the user, which includes both
resolved requests and requests waiting on
the customer.

Displays an overview of the service requests
that are waiting on the user. The infolets
contain the following information about the
service requests waiting on the user:

- Number of new service requests.

« Number of services requests that are in
progress.

- Total number of service requests that are
awaiting a response from the user and are
in progress.

Job Role

- Customer Service Representative
« Human Resource Help Desk Agent
- Sales Administrator

- Human Resource Help Desk Administrator

« Customer Service Representative
- Human Resource Help Desk Agent
- Sales Administrator

« Human Resource Help Desk Administrator

- Customer Service Representative
« Human Resource Help Desk Agent
- Sales Administrator

« Human Resource Help Desk Administrator

- Customer Service Representative
« Human Resource Help Desk Agent
- Sales Administrator

- Human Resource Help Desk Administrator
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Infolet

My SR Compliance

My Open Work Orders

My Completed Work Orders

My Action Plan Actions Past Due

My SR Work Time

SR Movement in Queues

ORACLE

Description

- Total number of unresolved service
requests that are assigned to the user and
are in critical status.

Displays an overview of all the milestones
and their status on the service requests
assigned to the user. This infolet contains
the following information about the service
requests milestones for the user:

« Number of SRs assigned to the user that
have milestones that are nearing their due
date.

« Number of SRs that are assigned to the
user where the milestone due dates have
passed.

« Number of SRs that are nearing and
already have noncompliance issues with
milestones.

- The number of SRs that have a critical
status.

Shows a listing of open work orders assigned
to the signed in user, which are expected to

be noncompliant, where the estimated end
date is past the resolution due date. A listing of
work orders that are noncompliant (where the
actual end date is past the resolution due date),
and are expected to be compliant, can also be
optionally viewed.

Shows a listing of noncompliant work orders
assigned to the signed in user, where the actual
end date is past the resolution due date. You
can also optionally view the compliant work
orders.

Shows the actions that have end dates in the
past. The total count represents unique actions.
The actions for the action plans associated

with the SRs assigned to the signed in user, are
considered.

Shows the actual duration an SR was with the
agent before it was resolved. This excludes
customer wait time, the duration when it wasn't
yet assigned, or assigned to other agents. The
KPI for all agents of the team that the signed in
agent belongs to, is also shown. Only the SRs
resolved in the last 30 days are considered.

Shows the average number of queues that an
SR has traversed before it was resolved. The
average days that an SR is in queue, not in
queue, and average days to resolve are also
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Job Role

- Customer Service Representative

- Sales Administrator

- Customer Service Representative

- Sales Administrator

- Customer Service Representative

- Sales Administrator

- Customer Service Representative

- Sales Administrator

- Customer Service Representative

- Sales Administrator

- Customer Service Representative

- Sales Administrator
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Infolet

Agents with Most Pending Service Requests

Long Wait on Agent

Queues by Unassigned Service Requests

Team Resolve Time

Critical Service Requests

Team SR Compliance

ORACLE

Description

shown. Team SRs resolved during the past 30
days are considered.

Displays the top-three agents that have the
most pending service requests, and the number
of service requests that are pending. Pending
service requests are requests that are in a New
or In progress state, and are pending action

by the agent. These requests don't include the
requests that are waiting on the customer.

Number of service requests that are waiting on
the agent for longer than 24 hours.

Number of unassigned service requests in each
queue. The graph also displays the priority of
the service requests in the queues.

The average resolution time of the service
requests resolved in the last 30 days, by any
user in the signed-in service manager's team.
The time is displayed in the number of days,
hours, and minutes.

The average resolution time of the service
requests resolved in the last 30 days, by any
user in the signed-in service manager's team.

Displays an overview of all the milestones
and their status on the service requests
assigned to the team. This infolet contains
the following information about the service
requests milestones in the team:

- Number of SRs assigned to the team that
have milestones that are nearing their due
date.

- Number of SRs that are assigned to the
team where the milestone due dates have
passed.

- Number of SRs that are nearing and
already have noncompliance issues with
milestones and are assigned to the team
members.

- The number of SRs that have a critical
status.
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Job Role

«  Customer Service Manager
« Human Resource Help Desk Manager
- Sales Administrator

« Human Resource Help Desk Administrator

«  Customer Service Manager
« Human Resource Help Desk Manager
- Sales Administrator

- Human Resource Help Desk Administrator

- Customer Service Manager
« Human Resource Help Desk Manager
- Sales Administrator

» Human Resource Help Desk Administrator

- Customer Service Manager
« Human Resource Help Desk Manager
- Sales Administrator

« Human Resource Help Desk Administrator

«  Customer Service Manager
« Human Resource Help Desk Manager
- Sales Administrator

- Human Resource Help Desk Administrator

- Customer Service Manager

- Sales Administrator
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Infolet

Inbound Emails

Inbound Social Posts

Omnichannel Agent Assignments

Omnichannel Assignments

Omnichannel Queue Assignments

Team Open Work Orders

Team Completed Work Orders

Team Action Plan Actions Past Due

Team SR Work Time

ORACLE

Description

Shows the total number of inbound emails
during the past 30 days. A breakdown of
this total by the number that resulted in SR
creations, SR updates, and number of emails
that failed is also shown.

Shows the total number of social posts during
the past 30 days. A breakdown of this total by
the number that resulted in SR creations, SR
updates, and number of posts that failed is also
shown.

Shows the top-five agents with the most work
assignments during the past seven days.

Shows the top-five queue assignments by
channel type for the past seven days.

Shows the top-five queues with the most work
assignments during the past seven days.

Shows a listing of open work orders assigned to
the signed in user and the user's subordinates,
which are expected to be noncompliant, where
the estimated end date is past the resolution
due date. A listing of work orders that are
noncompliant (where the actual end date is past
the resolution due date), and are expected to be
compliant, can also be optionally viewed.

Shows a listing of noncompliant work orders
assigned to the signed in user and the user's
subordinates, where the actual end date is past
the resolution due date. Compliant work orders
can also be optionally viewed.

Shows the actions that have end dates in the
past. The total count represents unique actions.
The actions for the action plans associated with
the SRs assigned to the signed in user's team,
are considered.

The average actual duration an SR was with

the agent before it was resolved. This excludes
customer wait time, the duration when it wasn't
yet assigned, or assigned to other agents. The
metric for all agents is also shown. Team SRs
resolved during the last 30 days are considered.
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Job Role

- Customer Service Manager
« Human Resource Help Desk Manager
- Sales Administrator

» Human Resource Help Desk Administrator

- Customer Service Manager

- Sales Administrator

«  Customer Service Manager

- Sales Administrator

«  Customer Service Manager

- Sales Administrator

«  Customer Service Manager

- Sales Administrator

« Customer Service Manager

- Sales Administrator

- Customer Service Manager

- Sales Administrator

- Customer Service Manager

- Sales Administrator

« Customer Service Manager
« Human Resource Help Desk Manager
- Sales Administrator

- Human Resource Help Desk Administrator
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Can | add a logo to help desk outbound emails?

A predefined subtemplate has common components for all workflow notifications based on predefined report layouts.
You can edit these shared components so that the same changes apply to your notifications.

Here are some of the shared components in the subtemplate:

Branding logo, if you add one to the subtemplate, which would appear as the first component in the email body.
The logo appears in email notifications only.
- Action buttons in email notifications.

Links at the end of the email notification, one to the corresponding transaction page, and another to the in-app
notification.

For example, you can add a branding logo in the designated place in the subtemplate, or change the text on the buttons
and links.

Note:
- When you make a copy of a predefined layout template to edit, the copy automatically inherits the same
predefined subtemplate.

- Other than this central subtemplate for all notifications, you might also find predefined subtemplates specific
to a product family. We talk about the central one here, but you would generally follow the same steps for other
subtemplates.

- You must edit a copy of the subtemplate in the Custom folder of the Bl catalog. Don't directly update the
predefined subtemplate, including renaming it.

- When you work on your copy of the subtemplate, add your own content or edit what's already there, but don't
remove anything.

- The exact steps can vary depending on your version of Microsoft Word.

Modify Shared Components in the Subtemplate

Here's how you edit a copy of the predefined subtemplate that has the shared components:

Click Navigator > Tools > Reports and Analytics.

Click the Browse Catalog icon.

In the catalog (the Folders pane), expand Shared Folders > Common Content > Templates.
For Workflow Notification Subtemplate, click More and select Customize.

If you're not using the Customize option, even though it's recommended:

POUNa
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a. Click Copy in the toolbar with Workflow Notification Subtemplate selected.
b. Inthe catalog, expand Shared Folders > Custom > Common Content > Templates. Create a Templates
folder in this location if it doesn't exist.
c. Click Paste in the toolbar.
In the catalog, with the Templates folder open under the Custom folder, click More for the subtemplate and
select Rename to give it a new name.
Click the Edit link for the renamed subtemplate.
In the Templates section, click the link in the Locale column.
Save the subtemplate .rtf file to your computer.
Open the .rtf file with Microsoft Word.

o Toadd alogo, insert your own image in the subtemplate.

o To change button or link text, edit the text accordingly. Make the same edits wherever that button or link
text appears in the subtemplate.

CAUTION: To make sure that your layout templates reflect these changes without more rework, don't
edit any other text in the subtemplate .rtf file.

L4

03O

10. Update Word options so that existing links remain intact in the subtemplate.
a. Click File > Options > Advanced.
b. Inthe Word Options dialog box, click Web Options in the General section.
c. Inthe Web Options dialog box, open the Files tab.
d. Deselect the Update links on save check box.
11. Save your changes in Word.

Upload the Modified Subtemplate

Now you upload your subtemplate to the Bl catalog:

In the catalog, expand Shared Folders > Custom > Common Content > Templates.

Click Edit for your subtemplate.

In the Templates section, click the Upload icon.

Select your modified .rtf subtemplate and a locale, and click OK to replace the original subtemplate.

PUNA

Point Layout Templates to Your Subtemplate
Update all the report layout templates that you want to apply your subtemplate to:

1. In Microsoft Word, open the .rtf file for the layout template, as you would to make any other changes to the
notification.

2. At the beginning of the document, change the subtemplate reference. For example, change <»
import:xdoxsl:///Common Content/Templates/Workflow Notification Subtemplate.xsb?>tO <?import:xdoxsl:///
Custom/Common Content/Templates/My Workflow Notification Subtemplate.xsb?>.

3. Save your work.

4. Test things out to make sure you see your subtemplate changes in the notification output.

Related Topics
« What is a subtemplate?

» Customize Pixel-Perfect Reports
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How do | configure the presence and availability
privilege?

To set the presence and availability, an agent must be given the Manage Omnichannel Presence and Availability
privilege.

This privilege is available by default to the following job roles:
Next Gen Human Resource Help Desk Agent
Next Gen Human Resource Help Desk Manager
Internal Service Request Help Desk Agent
Internal Service Request Help Desk Manager

To grant the Manage Omnichannel Presence and Availability privilege to any other role, do one of the following in the
Security Console:

- Create a role and provide the privilege to the role.

- Copy one of the default job roles with the privilege and create a role to add the privilege.

For more information about copying job roles, see the Oracle Fusion Cloud Customer Experience Securing Sales and
Fusion Service guide.

I Note: After you add the privilege to the new role, you must associate a user to the new role.

Configure the Presence Toolbar

In addition, for the Presence toolbar to be visible for Help Desk in the Redwood Experience, the Profile Option with the
name SVC_HD_SHOW_AVAILABILITY is required.

There are two steps to configure this:

1. Create a new profile option to enable the latest version and set the value to 'Y'.
2. Add the new profile option to the profile categories so it is available for REST queries.

Create a New Profile Option

Navigate to Setup and Maintenance.
Click Tasks.
Search for the task Manage Profile Options.
Click Search.
Click the Manage Profile Options task link.
On the Manage Profile Options page, in the Search Results region click Add .
On the Create Profile Option page, enter the following:
o Profile Option Code: SVC_HD_SHOW_AVAILABILITY

o Profile Display Name: Help Desk Show Availability

NOURWNA

o Application: Service
o Module: Service
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o Description: Enables Help Desk agent to set availability.
o Start Date: 12-Dec-2022
o End Date: blank
8. C(lick Save and Close.
9. On the Manage Profile Options page, select the Enabled and Updatable checkboxes for the Site level.

10. Click Save and Close.
11. Click Done.

Set the Profile Option Value on the Newly Created Profile Option

1. Navigate to Setup and Maintenance.

2. Click Tasks.

3. Search for the Manage Administrator Profile Values task.

4. C(lick Search.

5. Click the link for the Manage Administrator Profile Values task.

6. On the Manage Administrator Profile Values page,enter the Profile Option Code: SVC_HD_SHOW_AVAILABILITY

7. Click Search.
8. Inthe Profile Values region, set the Profile Value for Site to Y.
9. Click Save and Close.

10. Click Done.

Note: It can take a few minutes for the new Profile Option to take effect. You can verify you're seeing the new
Ul version by the URL patch. The new version contains 'fscmUIl/redwood/helpdesk'. If the URL contains 'crmUl/
helpdesk’ then the previous version is still enabled.

Related Topics
» Copy and Edit Duty Roles

Is reporting and analytics available in Help Desk?

Reporting and Analytics are features native to Oracle Fusion Cloud Sales can be used with Help Desk.

Note: Help Desk infolets are available for Agents and Managers. If the infolets are required for the Help Desk
administrator role, add these privileges.
« SVC_VIEW_HR_HELPDESK_AGENT_DASHBOARD_PRIV

« SVC_VIEW_HR_HELPDESK_MANAGER_DASHBOARD_PRIV

Note: If you are not using Fusion Sales and Fusion Service, you must complete the following tasks to see and drill
down from OOTB infolets:

Calendar

Org Hierarchy

Enable SR Audit
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How do | set up a delegation for users to create Help
Desk requests on behalf of others?

Predefined roles enable managers to log Help Desk requests for anyone in their employee hierarchy. Employees
normally can only log requests for themselves. But, managers can delegate their role to anyone in their employee
hierarchy to let them log requests on their behalf.

For example, if a manager goes on vacation and wants to give access to an employee to logging requests on their behalf
while they're away, they can delegate their role to that employee. The delegated person can use the employee picker on
the request to select another employee in the manager's hierarchy as the primary point of contact.

The remainder of this topic details the tasks an administrator must complete to enable the delegate role, how a
manager delegates the role, and what an employee must do to log a request on behalf of their manager.

The following figure shows the flow of tasks that are required when you set up the delegation of users.

Create Security Profile

.

Create Custom Data Role and
Assign Security Profile to Data Role

v

Add Custom Data Role
to Manager Security Profile

1

Delegate Custom Data Role
to Employee

1

Employee Log SR on Behalf of Manager

Administrator

Manager

Create a Security Profile

To create a security profile:

1. Signin as an administrator.
2. Navigate to Setup and Maintenance.
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3. Search for and select the Manage Person Security Profile task.
4. C(lick Create.
5. Onthe Create Person Security Profile page, enter a Name for the security profile. For example, enter Delegate

1

CovooN0o

Security Profile.

Select Enabled.

In the Manager Hierarchy region, select Secure by Manager Hierarchy.
Select Both from the Hierarchy Content choice list.

Click Save and Close.

Click Done.

Create a Custom Data Role and Assign Security Profile

Now, you must create a custom data (or delegate) role and assign the security profile to the data role.

_‘—I
-—

12
13.

14.
15.
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Sign in as an administrator.

Go to Setup and Maintenance.

Search for and select the Manage Data Role and Security Profiles task.
Click Create.

On the Create Data Role: Select Role page, enter a name for the Data Role. For example, Delegate Role.
Search for the job role Human Resources Analyst.

Select Human Resources Analyst from the search results.

Click OK.

Select Delegation Allowed.

Click Next.

In each of the following regions select the indicated value from the choice list:

o Organization Security Profile Value - View All Organizations
o Position - View All Positions

o Legislative Data Group - View All Legislative Data Groups

o Document Type - View All Document Types

o Payroll - View All Flows

In the Person region, select the new security profile you just created. For example, Delegate Security Profile.
In the Public Person region, select the new security profile you just created For example, Delegate Security
Profile.

Click Next through the remaining train stops.

Click Submit on the Create Data Role: Review page.

Add Custom Data Role to Security Profile

Now, add the custom data role to the manager's security profile.

Delegate Custom Role to Employee

The manager now can delegate the custom role to an employee in their hierarchy.

VhWNA

Sign in as a manager.

Navigate to Roles and Delegations.

On the Edit User Account Details page, scroll to the Roles and Approvals Delegated to Others region.
On the Roles Delegated to Others tab, click the Create icon.

Enter the Role Name.

33

ORACLE



Oracle Fusion Cloud Applications Chapter 1
Help Desk: Questions and Answers Questions and Answers

6. Enter Start and End Dates.
7. Search for and select the employee to delegate in the Delegated To drop-down list.
8. C(lick Save.

The designated employee can now log a service request on behalf of the manager. When logging the service request,
the employee selects anyone in the manager's hierarchy as the Primary Point of Contact on the service request.

Related Topics

How do | manage action plan actions for Help Desk?

Use the Manage Action Plan Actions task to create and edit actions for action templates or individual actions used
in help desk requests. In this task, you specify the category, type, duration, visibility, and attribute mappings for each
action.

To manage action plan actions, in the Setup and Maintenance work area go to the following:
- Offering: Help Desk
Functional Area: Action Plan
- Task: Manage Action Plan Actions

Create a New Action

Here's how to create a new action:

1. Click Create Action.
Enter the action name.
3. If you enabled business units for service requests for help desk requests or stripe codes, use the drop-down
lists to select the stripe code and BU.
4. Select Category.
Select Class.
5. Select the Action Type.
Depending on the Help Desk features you're using, Action types can include:
o Appointment
o Article

Note: You can create an Action of type Article. You must select Stripe Code of the action and then
select Sub Type of the action. The Attribute Mapping section must be populated as it's required for any
other type of actions.

o Case

o Dynamic Process

o HR Help Desk Request

o Internal Service Request

o Task
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10.

1n.

12.

Follow the next four steps if you're creating a Dynamic Process Action (with the Run Processes Through Action
Plans feature). If you aren't using this feature, you can skip the next four steps.

Click the Edit icon in the Process Name field.
Search for and select the process you want to add to the action.

Processes must already be created in Oracle Process Cloud and your connections to Oracle Process Cloud must
be working.

Also, the administrator must be added to the Process Application Administrator role in the process workspace
Ul so they can see all processes.

Note: When you create processes, you must define the following case-sensitive input parameters -
objectNumber, objectType, actionPlanld, actionPlanActionld, and processParentObjectType when configuring
dynamic processes. For Solo Actions, input parameter processparentobjectType Will have value 'actionplan’
while for Plan based actions it will have 'actionPlanaction'.

Click OK.
Select to use the default version of the process, if you want to use the default process version instead of the
version-specific process.

CAUTION: After a process is deployed, overriding it will remove all running instances. Oracle recommends
that you create a new version for more changes and mark it as default, if it's required. An action which has
Use default version selected will ensure that only the default version in Oracle Process Automation is used
to create process instances. For processes whose inputs are form based, make sure the interface argument is
the same.

Select the Action Visibility.
Visibility options include:

o Not Published - Only visible to the administrator. The action isn't available to add to a template and can't
be added by an agent as an another action.
o Customer Visible - Optional. Used only for user interface configurations to display or hide Actions.

o Internal Only - Visible internally only.

Enter a context for the action.
Context options include:

o Internal Help Desk Request
o HR Help Desk Request
o Case

Enter a numeric value for the Duration of how long the task should take. Select a unit of measure for the
numeric value (days, hours, or minutes).
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13.

Select a Stripe Code (HR Help Desk Request stripe, or Internal Service Request stripe)from the drop-down
list.

Note: If you select the type as SR, you shouldn't select stripe as ISR/HRHD. This leads to ambiguity whether
the underlying object created should be CRM SR or ISR/HRHD.

o If the agent wants the associated object to be CRM SR, select the following:

- Type:SR
- Stripe: ORA_SVC_CRM
o If the agent wants the associated object to be ISR, select the following:
- Type: ISR
- Stripe: ORA_SVC_ISR
o If the agent wants the associated object to be HRHD, select the following:
- Type: HRHD

- Stripe: ORA_SVC_HRHD

14. Select a Category from the drop-down list.
15. You can define a specific relationship to be created for the action by selecting an Object Link Type from the
drop-down list. If you don't select a specific object link type, the global setting is used.
16. Check the Copy Attachments check box if you want all attachments to be copied from the context object to the
target object. You can select to copy all attachments for the following object types:
o Cases
o Service Requests
o Help Desk Requests
o Internal Service Requests
17. Enter a description of the action and any pertinent details.
18. If necessary, make edits on the Attribute Mapping or Status Mapping tabs. These are explained next.
19. Click Save and Close.
Attribute Mapping Tab

Every action in an action plan has a related object (as in a task, appointment, opportunity, case, or help desk request)
that's automatically created when the action starts.

The attribute mapping tab is where you set up the mapping of information from the action, parent help desk request,
and user-defined values into the related object when it's created.

Note: There are no attributes to map for Dynamic Processes. If you're creating a Dynamic Process Action, there isn't
anything to do on this tab.

Mapped attributes come from the fields in the related object. Required attributes are automatically listed, and you can
add optional attributes. The Mapped To column shows where the information comes from that populates the field on
the related object.
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CAUTION: If you map attributes incorrectly, the creation of the business objects during orchestration in Action Plans
will fail.

Required fields are shown in the Required column. Additional fields might also be listed that can't be changed.
For example, Activity Type displays Task if that action type is Task or defaults to Appointment if the action type is
Appointment.

Here's how you add an attribute mapping:

1. Click the Add icon.
Select the field to be populated from the Attribute choice list.

3. Inthe Mapped To column, select from where the fields must be populated. Choices are: service request, action,
or a user-defined value.

4. Depending on the attribute you selected in the previous step, enter free-form text to the box for free-form
values. For service request or action, select the field from the choice list in the last column.

For more information about mappings for an article, see the topic Attribute Mappings for Knowledge Articles in this
chapter.

Status Mapping Tab

The related business objects created for actions can have different user-defined status values. However, they must be
mapped into a new set of status codes for an action in an action plan. You can do this at a global level for all actions, or
individually for one action if it has unique attributes. When a user updates an object, the status mapping rules decide
how the status of an action updates on an action plan. For example, when a task is set to closed or completed, then the
action status is completed.

Note: If you don't define the status mapping at the action level, then the default is the global status mapping. Also,
there are no statuses to map for Dynamic Processes. If you're creating a Dynamic Process Action, there isn't anything
to do on this tab. There are however, predefined status value mappings that can't be changed.

For more information about the global action status configuration, see the topic Manage Mapping of Action Plan Status
Values.

The following table shows the predefined Process Automation status values that are mapped with Action Plan status
values.

Process State Action Status

Active ORA_SVC_IN_PROCESS
Completed ORA_SVC_COMPLETED
Terminated ORA_SVC_COMPLETED
Closed ORA_SVC_COMPLETED

For more information about the global action status configuration, see topic Manage Mapping of Action Plan Status
Values.
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You can use the Status Mapping tab on an action to override the global status mappings. For example, if the global rule
is set to an action being closed when the status is complete, but instead you want it to be closed when it's canceled, you
can override the global mapping so that the action closes when both conditions are met.

1. Click the Status Mapping tab.
Click the Add icon.
3. Select a status from the Status choice list. This becomes the status that ends up on the action.

Status options include:

o Blocked
o Completed

o In progress

Note: Apart from these three status values, you should not set up rules for any other status.

4. Select an attribute from the choice list.
5. Select an operator.
Operators include:
o Contains
o Equals
o Is null
o Is not null
6. Select a value for the status.
Example of a Status Mapping

Let's say you want an action to be marked completed when a service request's status is completed or canceled.

The following table shows the values to enter on the Status Mapping tab.

Column Value
Status Completed
This is the status you want the action to

be.

Attribute Status

This attribute comes from the SR.
Operator is one of
Value Completed, Canceled

This is the request's status. You can select
multiple values from the list.
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Dependencies Tab

When an action is added to a template, the Dependencies tab shows the template name. You use this to know what
templates are impacted by a change to an action. If the action is in a template, you can also view and edit the template
from this tab.

I Note: Edits made to templates don't affect active action plans that use the template.

Action Errors Tab

The Action Errors tab lets you to recreate actions for users when there are errors in action attribute mapping. For
example, if the attribute in an attribute mapping is mapped incorrectly, the Action Errors tab is displayed. From the
tab, you can see all the action plans that the action is used in, and after they're fixed, the action plan actions can be
recreated directly from this tab.

This tab isn't used for Dynamic Process actions.
The Action Errors tab shows a table with the action plan number, action plan name, and the status details of the action.

Review the attribute mappings the action and correct the error. After attribute mapping for the action is corrected, you
can return to the Action Errors tab and click Recreate.

Edit an Existing Action

To edit an existing action:

1. In the Manage Action Plan Actions task, select the template you want to edit.
2. Edit the action.
3. Click Save and Close.

How do | manage resource teams?

This procedure describes how to manage resource teams. A resource team is a temporary group of resources formed
to complete a business task. A resource team can't be hierarchically structured and isn't intended to implement an
organization.

Create Resource Teams

To create resource teams:

1. Navigate to the Manage Resource Teams Ul page as follows: Navigator > Resource Directory > Tasks >
Manage Resource Teams.

2. Click the Create action menu option or button.

The Create Team page appears.
3. Enter an appropriate team name.
Optionally, enter a team description and specify team usage, resource members, and organization members.
5. Click Save and Close.

>

39
ORACLE



Oracle Fusion Cloud Applications Chapter 1
Help Desk: Questions and Answers Questions and Answers

Edit Resource Teams

To edit resources teams:

1. Navigate to the Manage Resource Teams Ul page as follows: Navigator > Resource Directory > Tasks >
Manage Resource Teams.
2. Search for the resource team that you want to edit.

You can search by entering criteria such as the team name, number, and usage. You can also use the saved
searches.

3. Select the resource team you want to edit from the Search Results region and click its name to navigate to the
Edit Team page.

4. On the Edit Team page, you can edit the team's details such as the team name, description, usage, resource
members and organization members.

5. Click Save and Close.

How are business units for set up for Service and Help
Desk?

With business units (BUs), you can deploy more than one service center within a single instance of your service or help
desk application. This topic gives an overview of the steps that you must perform to complete the business units setup.

You can use multiple BUs in the following ways:
- Segment SRs between BUs so that users can search and identify SRs from multiple BUs.
- Use product catalogs, categories, channels, and email templates specific to a BU.
- Assign SRs to queues by writing rules based on BU.
- Create service request Bl reports specific to a BU.

Currently, the following objects aren't supported by multiple BUs in Service: accounts and contacts, users, resources,
and lookups.

To set up business units in Service, you must perform the following tasks in the given order.

Step Description

Setting Up Business Units for Service Add the Manage Business Unit functional area to the Service offering by using the Change Feature
Opt In link in Setup and Maintenance.

Manage Common Profile Options Set the profile options to enable the multiple-BU functionality in the Manage Common CRM Business
Unit Profile Options task.

Manage Internal Resource Organizations Define internal resource organizations to be associated with the BU.

Manage Resource Organization Add the internal resource organizations to the internal resource organization hierarchy.
Hierarchies
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Step
Create Business Unit

Associate Resource Organization to
Business Unit

Create Employees

Reset Passwords for Users

Set the Scope in Service Setup Tasks and
complete Service Setup tasks.

Add additional BU fields in the SR if users
are associated with multiple BUs.

Configure Multiple Business Units with
Digital Customer Service

Chapter 1
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Description

Create a BU to be associated with the resource organization in the Manage Business Unit Task.

Associate the internal resource organization to the BU you created. Use the Resource Directory.

Add users to the organization in the Users, Roles and Delegations task, and make one of the resources
a manager for the organization.

Reset the password for the users.

Set the scope for Service tasks and set up the remainder of the Service offering.

Change the layouts of the SR pages if required. Use Application Composer to include multiple BU fields
in the SRs.

Note:

Only required if a user is associated with multiple business units.

If you implement multiple business units for Digital Customer Service, you must complete some
additional configuration.

How do | enable multiple business units for Help Desk?

To enable multiple business units (BUs) for Help Desk, you must set the following profile options:

1. Multiple Business Units Enabled (HZ_ENABLE_MULTIPLE_BU_CRM): Set this profile option to Yes. The default

value is No.

2. Customer Relationship Management Business Unit Default (HZ_DEFAULT_BU_CRM): Set this to the default
business unit for your service application.

Note: You must ensure that the value of the HZ_DEFAULT_BU_CRM profile option doesn't remain blank, and the
value is set to a BU. Otherwise, agents might see an error while creating SRs.

To set the profile options for Service BUs:

1. Inthe Setup and Maintenance work area, go to the following:

o Offering: Service

o Functional Area: Company Profile

o Task: Manage Common CRM Business Unit Profile Options

The Manage Common CRM Business Unit Profile Options page shows the two profile options.

ORACLE
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Click the HZ_ENABLE_MULTIPLE_BU_CRM profile option.

In the HZ_ENABLE_MULTIPLE_BU_CRM: Profile Values region, set the Profile Value for the Site Profile Level
to Yes.

Click Save and Close.

Click the HZ_DEFAULT_BU_CRM profile option.

In the HZ_DEFAULT_BU_CRM: Profile Values region, specify the Profile Value for the Site Profile Level.

Click Save and Close.

How do | manage resource teams?

This procedure describes how to manage resource teams. A resource team is a temporary group of resources formed
to complete a business task. A resource team can't be hierarchically structured and isn't intended to implement an
organization.

Create Resource Teams

To create resource teams:

1.

2

3.
4.
5. C(lick Save and Close.

Navigate to the Manage Resource Teams Ul page as follows: Navigator > Resource Directory > Tasks >
Manage Resource Teams.

Click the Create action menu option or button.

The Create Team page appears.

Enter an appropriate team name.

Optionally, enter a team description and specify team usage, resource members, and organization members.

Edit Resource Teams

To edit resources teams:

1.

2.

Navigate to the Manage Resource Teams Ul page as follows: Navigator > Resource Directory > Tasks >
Manage Resource Teams.

Search for the resource team that you want to edit.

You can search by entering criteria such as the team name, number, and usage. You can also use the saved
searches.

Select the resource team you want to edit from the Search Results region and click its name to navigate to the
Edit Team page.

On the Edit Team page, you can edit the team's details such as the team name, description, usage, resource
members and organization members.

Click Save and Close.

How do | set up request visibility based on queue?

When users view lists of requestsor create user-defined searches, access is based on the cumulative set of data security
policies assigned to all the roles associated with them. You can restrict access based on their queue membership.
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Restricting access ensures users see only the requests that are in their queue by completing the following processes in
the Security Console:

"Remove Data Security Policies from Users": If the users have been assigned other data security policies that
grant them access to a larger set of requests , then you must remove such data security policies from the users.

"Assign Data Security Policies Based on Queue": Grant queue-based visibility to requests for specific roles. This
ensures that users with these specific roles can see only the assigned to the queues where they're a resource
member.

How do | change acknowledgment messages for
inbound email?

When you receive an email from an employee to open a help desk request, an acknowledgment message is sent to
them automatically. Based on your company's requirement, you can change the predefined acknowledgment messages
provided by the application.

Note: You can't add new tokens to these messages. Only the predefined tokens are used in these messages.

For Help Desk, the following predefined messages are provided:
« SVC_EMAIL_ACK_FOR_KNOWN_EMP
- SVC_EMAIL_ACK_FOR_MULTI_EMP
« SVC_EMAIL_ACK_FOR_UNKNOWN_EMP

To change the acknowledgment messages that you send out to employees when you receive an inbound email:

In the Setup and Maintenance work area, go to the Tasks panel tab.

Click Search from the list of displayed tasks.

In the Search window, enter Manage Messages.

Click the Manage Messages task that's displayed.

In the Manage Messages window, in the Message Name field, enter ssvcsacks.

From the list of acknowledgment messages displayed, select the message that you want to edit and click Edit.
In the Edit Message window, navigate to the Message Text region.

Edit the Short Text and User Details the way you want.

Click Save.

To translate the changed messages, click Translation Editor.

The Edit Translations window displays the list of available languages for translating the messages.

COVOONOUAUWNRA

-—

Note: Inbound email can't detect the language. So it always uses the default language for your deployment.

11. Select a row and click in the Short Text field.

12. In the Short Text window, edit the message and click OK.

13. Click in the User Details field, edit the text, and click OK.

14. Select another row and repeat the same steps to edit the messages for all the available languages.
15. Click OK in the Edit Translations window to save the changes.

16. Click Save and Close in the Manage Messages window.
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How do | set notification preferences?

The Notification Preferences page enables administrators to configure the notification rules. Users who have the
ORA_SVC_INTERNAL_HELPDESK_ADMINISTRATION or ORA_SVC_HR_SR_ADMINISTRATIONduty roles can access this

page.

Notification preferences are used to select multiple recipients like team members, queue members, and so on. When
notification preferences is used, it will override the recipients that are set in the Groovy code.

Here's how you configure the notification rules:

Note: Ensure that your triggers are published.

1. Signin to the application as an administrator.
2. Inthe Navigator, click Tools > Notification Preferences.

The Notification Preferences page is displayed.
3. From the Object drop-down list, select Internal Help Desk Request or HR Help Desk Request .

Note: Other supported objects are also displayed in the Object drop-down list. For Classic Help Desk, use the
Service Request object.

a. Click Add. A blank row is added in the table.
b. To enable the notification trigger, select Yes from Enabled drop-down list.

c. To prevent users from personalizing this notification through the User Notification Preferences page,
select No from the OverrideFlag drop-down list.

Note: To clean up the user notification preferences data, in case the resource leaves your company
or is no longer active, run the Purge Obsolete User Preferences scheduled process. This scheduled
process lets your organization ensure that your data on user notification preferences isn't stale.

d. Select a Groovy notification trigger from the Triggering Event drop-down list.
e. Enter the Notification Name and Description.
f. Inthe Recipients column, click Edit.

The Configuration for Trigger Name dialog box is displayed.
g. Select the notification delivery options for the respective recipients.

For an enabled triggering event, notifications are sent to the specified recipients only if you select at
least one delivery option. If any delivery method is selected for a specific recipient, that recipient will also
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receive bell notifications. Also, if you don't select the Bell Notifications option, then no notifications will
be sent to the specified recipients.

The following tables describe the recipients and delivery options for the help desk request object:

Recipients for Help Desk Request
Object

ORACLE

Assigned To: Resource to
whom the help desk request is
assigned.

Manager of Assigned To:
Manager of the resource to
whom the help desk request is
assigned.

Resource Team: Extra
resources that have been added
to a help desk request on the
Team subtab.

If you've a team of resources
collaborating on a help desk
request, and a trigger such

as the help desk request
escalating to Critical status
happens, the entire team can be
informed.

Queue Owner: Owner of the
queue.

If your organization uses
manual assignment, the queue
owner can be notified when

a new help desk request

is associated with a queue
owned by the queue owner.
For information about the
setup steps required to send a
notification to a queue owner,
see the "Trigger a Notification
to the Queue Owner" section.

All Queue Members: Send
defined notifications to all
members of a specified queue,
so that they can effectively
monitor the queue for open
items.

Queue notifications reduce the
need for agents to manually
check each queue they're
associated with, to see whether
there's new work.

To enable this recipient option,
set the profile option ORA_
ENABLE_QUEUE_MEMBER_
NOTIFICATIONS to Yes. This

Delivery Options for Help Desk Request Object

- Bell Notifications: Sends a bell notification to the web application.

- Email Notifications: Sends an email notification to the selected internal recipients'
primary work email ID saved in the application.

Note:

The from email address is configured through the SVC_OUTBOUND_EMAIL _
FROM profile option. If that isn't specified, the default from email address
noreplyQRoracle.comis used.
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Recipients for Help Desk Request Delivery Options for Help Desk Request Object
Object

profile option is disabled by
default.

You should only enable this
option if your queues have
a few participants. If your
organization's queues have
many members, enabling
notifications to all of them
might affect application
performance.

- PrimaryContactPartylDNote:
For Help Desk in the Redwood
Experience only. If the use
case is to send notification
to PrimaryContactPartyID in
classic Help Desk, then only
Groovy should be used without
using Notification Preferences.

h. To let users follow a specific help desk request and receive all notifications for that help desk request,
select the Enable Followers check box.

When enabled, users with the correct permissions will see the Follow option in the Actions menu of the
Help Desk Request Details page.

The notification followers receive notifications for all supported channels, when any notification event is
triggered for the help desk requests they follow.

To enable this feature for the site, set the ORA_ENABLE_FOLLOW_NOTIFICATIONS profile option to Yes.

To follow a help desk request, users must have the SVC_GET_SR_FOLLOW_NOTIFICATIONS permission.
This privilege is added to the following ready-to-use duty roles:

- Internal Service Request Administration
- Internal Service Request Analysis

- Internal Service Request Management
- HR Service Request Administration

- HR Service Request Analysis

- HR Service Request Management

Note: To evaluate whether a resource is still valid and enabled to follow specific help desk requests,
run the Purge Obsolete Notification Followers scheduled process. This scheduled process removes
inactive and end-dated users from following the help desk request, so that the application doesn't get
overloaded with stale data. This scheduled process lets your organization ensure that your data on
notification followers isn't stale.

i. Click the New SmartText link and enter the Notification Text for the selected object.

For more information about using SmartText, see the "Using SmartText" topic.
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4. (Optional) To delete a notification preference, select the row and click Delete. The associated notification text is
also deleted.

Note: If you delete a notification that uses a Groovy notification trigger, you can create a new notification
using the same trigger, if no other notification uses it.

5. (Optional) To change an existing notification text, click the Update SmartText icon for the selected row.
6. Click Save.

How do | define notification triggers?

Here's how you define a Groovy script for a notification trigger:

1. Signin to the application as a setup or administrator user.

2. (lick Navigator > Configuration > Sandboxes.

3. Create a sandbox or select an existing one, and click Enter Sandbox to activate the sandbox. Your sandbox is
activated, and you can see its name on the sandbox bar over the global header.

In the Navigator, click Application Composer. The Application Composer page is displayed.

Select Objects > Standard Objects > Internal Service Request or HR Help Desk Request > Server Scripts .
The Server Scripts section is displayed.

Click the Triggers tab.

From the Action menu, click Add. The Create Object Trigger section is displayed.

Create a Groovy trigger:

a. Specify the Name, Error Message, and Trigger Definition details.

- Oracle recommends you to use the trigger type After Changes Posted to Database. This
trigger type enables you to stop potential issues if the Groovy script is accidentally written to run
indefinitely. If the trigger type is set to Before Update to Database, with a bad script, there may be
some issues.

- If you're creating a new object, and you want to trigger a notification when the object is created,
Oracle recommends you to use the trigger type Before Insert to Database. However, some of the
Before trigger types don't have all attributes exposed yet, resulting in some fields being blank.

To debug your triggers if you're not getting the expected results, follow the steps in the section
"Debug Groovy Triggers".

- The isattributechanged() function works only for the Before trigger types. The workaround for the
After trigger types involves retrieving the old value before the database is updated, then retrieving
the new value after the update, and then comparing the two values to see whether the attribute
is changed. However, this workaround works only for high-level attributes such as criticalriag
and status. This workaround may not work for the viewrow attribute, for example, when you're
retrieving the team from a help desk request.

When you create a Groovy script, you need the APl names of the fields you're trying to access. To create
your triggers based on parent/child fields, do the following:

i. Inthe Trigger Definition section, click Show/Hide Expression Palette.

ii. Click the Fields tab.
iii. Select an Object.

iv. Click the Maximize Edit Script arrow. The fields for the selected object are displayed.
v. Select the APl you want, and click Insert.

v A
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vi. To close the expression palette, click the Restore Edit Script arrow, and then click Show/Hide
Expression Palette.
b. Click Save and Close.
9. Navigate to the Notification Preferences page to configure your preferences for the notifications.

For more information about configuring notification preferences, see the "Set Notification Preferences" topic.
I Note: You can reuse a Groovy notification trigger if no other notification uses it.

How do | set up groovy notification triggers in Help
Desk?

As an administrator, here's how you configure notifications after you've enabled the notifications feature:

1. Define notification triggers as Groovy scripts in Application Composer, containing the conditions that must
be met for each notification. Notifications are triggered when the defined conditions are met. For example, a
trigger can be defined to send a notification when a high severity help desk request has been assigned to an
agent.

For more information about defining notification triggers, see the "Define Notification Triggers" section.

2. Configure the notification preferences using the Notification Preferences page. For example, to specify the

notification message using SmartText, and the notification recipient.

For more information about notification preferences, see the "Set Notification Preferences" section.

Note:

- You can temporarily disable all notifications using the profile option SVC_DISABLE_BO_NOTIFICATIONS.
Oracle recommends to use this option when you're doing a bulk import of data, so that you don't get multiple
notifications.

- You can temporarily enable or disable specific notifications from the Notification Preferences page.

How do | enable notifications?

A notification is an alert for users such as agents and employees, to notify them about an event on the help desk
request, and enable them to take the necessary actions.

As a prerequisite, to allow users to view notifications, you must enable a profile option.

Enabling notifications is a global setup and feature opt-in step. Here's how you enable the notifications feature for help
desk requests:

1. Sign in to the application as a setup or administrator user.
2. Navigate to Setup and Maintenance.
3. Select the Help Desk offering.
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4. Inthe Functional Areas section, select Change Feature Opt In.
5. Select the Enable check box for in the Productivity Tools row.

When the Notifications feature is enabled, bell notifications are automatically enabled for help desk requests.

6. Click the Edit icon in the Features column of the Productivity Tools row.
7. Enable your required notification delivery channels:
o To enable email notifications, select the Enable check box for Use Email as a Notification Delivery
Channel.
8. Click Done on the Edit Features Productivity Tools page.
9. Click Done.

Export Data

You can export your object data using the Export Management option from the Tools work area. This topic is your guide
to exporting data.

You can find the list of objects supported in Export Management in Manage Export Objects

To export data:

1. Click Tools > Export Management.
2. Onthe Manage Exports page, click the Create Export Activity button.
3. On the Enter Export Options page, enter values for each of the following fields:

Field Description of the value
Name The name of the export activity.
Object The object to export. You must select the parent or child object from the drop-down list.

If you can't find an object in the drop-down list, then click the Search link. In the Search and
Select dialog box, enter the object name in the Object text box and click the Search button.
Select your object from the result list and click OK.

You can also use the advanced search option by clicking the Advanced button. Here you can
search based on various filter criteria such as object name, attachment supported, creation
date, and so on.

Note:

If the object you're exporting isn't listed then verify if you have the roles and privileges
required to export the object. For information on the roles, see the topic Roles Required for
Import and Export Management referenced in the Related Topics section.

The object must not include any field with display name length greater than 120 characters.
Your export job may fail if it includes a field with display name length greater than 120
characters.
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Description of the value

The optional description of the export activity.

The name of the export file to generate in ZIP format. This field is populated based on the
object and date time stamp.

Select to export the attachments related to the object. This option is enabled only if the
selected object supports attachments.

4. Optionally to set additional export configurations, click the Advanced Options section. Here you can configure
settings in the Output File, Export Options, or Create Schedule sections.

o Following are the options in the Output File and Export Options regions:

Option

Delimiter

Escape Special Characters

ORACLE

Description Default Value

If your file doesn't use a comma to Comma
separate values, then select the correct

delimiter in the Delimiter drop-down list.

Possible values are:

- Caret Symbol

- Closing Curly Bracket

- Closing Parenthesis

- Closing Square Bracket
- Colon

- Comma

- Exclamatory Mark

- Minus

- Opening Curly Bracket
- Opening Parenthesis

- Opening Square Bracket
- Pipe Symbol

- Plus

- Question Mark

- Semi-Colon

- Star Symbol

- Tilde Symbol

If selected, then RFC4180 format is used, = Deselected

and quotes are escaped with another set
of quotes.

50



Oracle Fusion Cloud Applications Chapter 1

Help Desk: Questions and Answers Questions and Answers
Option Description Default Value
Decimal Separator The decimal separator used in your Period
export file. Possible values are Comma
and Period.
Date Format The format of the date fields in your file. = US - MM/DD/YYYY

Possible values are:

- EU-YYYY/MM/DD
- 1SO 8601- YYYY-MM-DD

- UK/Canada - DD/MM/YYYY
- US - MM/DD/YYYY

Time Stamp Format The format of time fields in your file. US - MM/DD/YYYY hh:mm: ss PM
Possible values are:

- Canada-DD/MM/YYYY hh:mm:ss
PM

- EU-YYYY/MM/DD 24:mm:ss

- 1S0 8601-YYYY-MM-
DDThh:mm:ss sss+/-hh:mm

- UK-DD/MM/YYYY 24:mm:ss
- US-MM/DD/YYYY hh:mm:ss PM

File Encoding The format in which the characters within  Unicode - UTF - 8
your source file are encoded. Possible
values are:

- Chinese Simplified - GB, CP936

- Chinese Traditional - CP950

- Eastern European - Win, CP1250

- Greek - MS Windows, CP1253

- Japanese - Shift-JIS, CP932

- Unicode - UTF -8

- Unicode - UTF - 16

- Unicode - UTF - 16BE, Mac, Unix

- Unicode - UTF - 16LE, MS Windows
- Western European - Win, CP1252

End of Line The character used to indicate end of line  Line Feed
in the export file. Possible values are:

- Carriage Return
- Carriage Return and Line Feed

- Line Feed

Quote Character The character used to indicate a quote. N/A
This field is read-only.
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Option Description Default Value
Language Independent Header Select to export column headers. If you're N/A

modifying the exported data manually,

then exporting column headers help in
automatic mapping during the reimport
process.

Notification Email The email to send export-processing N/A
notifications. The user submitting the
export receives an email notification
automatically. You use this field to specify
any additional recipients. If you want
to have more than one email recipient,
separate the email addresses with a
comma or semicolon. You can also
specify a mailing list address so that
a large number of recipients can be
notified. If you don't want to receive the
notification, then set the profile option
ORA_ZCA_IMPEXP_ENABLE_EMAIL_NOTI
to 'N' at user level.

Enable Split Select to split the export data set based N/A
on a specified record count. On selecting
this check box, you can see the Split Size
drop-down list, with a default value of
100k. You can specify the split size in
multiples of 100k records, ranging from
100k to 1000k.

The exported data is split into multiple
CSV files, and each file has a maximum
of 50K records. You can further split the
exported data into multiple ZIP files,
based on the specified split size. For
example, if your export job retrieves 300k
records and split is enabled with a split
size of 200k, then 2 export ZIP files are
generated. The first ZIP file contains 200k
records which is divided into 4 CSV files
each with 50k records. The second ZIP
file contains 100k records which is then
divided into 2 CSV files each with 50k
records.

o Inthe Create Schedule region, you can schedule the export to run either immediately or at a future date.
If you select a future date, then provide the date and time to start the export.
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You can save the Advanced Options for subsequent reuse by clicking on the Save advance options link in the UL.
The options will be retained till you click on the Reset link and reset the options to application defaults.

Note: All fields except Schedule Mode and Schedule start time will be saved.

5. Click Next. On the Map Fields page you can see the exportable object, its child objects, and the associated
attributes. The Export Mapping drop-down list shows the maps that were used in earlier export jobs. You can
select an existing mapping from the drop-down list and click Apply.

You can save your export maps for future use by clicking on the pencil icon (Save As) in the Create Export
Activity page. You can also mark your maps as private by checking the Private Map check box. Private maps
can only be viewed and reused by the user who created and saved the map. Maps marked as private won't get
purged by the daily purge job.

Note: Your maps will only be saved once the job is completed.

To select and apply your saved maps, check the My Maps check box, select the required map from the Export
Mapping drop down and click Apply in the Create Export Activity page.

6. You can select the child objects to export by selecting the Enabled check box. Selecting the Enabled check box
for a child object displays the associated attributes in the Available Fields section. You can select the attributes
to export by double-clicking the attribute in the Available Fields list. Alternatively, you can move the attribute
from Available Fields list to the Selected Fields list. If you select any formula fields for export, it might impact
your export performance.

7. You must provide a filter criterion for at least the top-level object. To filter the records to export using
conditions, click the Filter Name icon. On the Filter Name dialog box, you can create the filter for the export
attributes using the operators AND, OR, >, <, =, and !=. On the Fields tab select the attribute and click the Insert
button. In the Script Edit window, provide the filter conditions for the selected attribute. After creating the filter
criteria script, click Validate Script. Click Save and Close to save the filter.

Note: You must use GeographyCode="TM' filter to export the Zone Hierarchies. To export both Zone
Hierarchy information and Geography Country Information, you need to use filter GeographyCode="TM' Or
CountryCode='DE". For more information see How to Use Export Management to Export Territory Geography
Zone Hierarchies?

8. (lick Next. On the Review and Submit page, review the export activity configuration. If you want to change
any configuration, then click the Back button. Submit to activate the export activity. After the export activity
completes, clicking the My Completed Exports infotile shows your export status. Click the ZIP file link in the
Exported Data File column to download the exported file.

You can cancel the export by clicking the Cancel icon in the Manage Exports page when the job status is
Paused, Queued for Export, Preparing data to Export, or Exporting Data.

Note: The cancel job option is available for the logged in user and the hierarchy user only when the profile
option ORA_ZCA_IMPEXP_RESTRICT_USERACCESS is enabled.

Note: CSV String Escape: By default, the escape character is a " (double quote) for CSV-formatted files. If a value
contains a comma, a newline character, or a double quote then the string must be enclosed in double quotes. For
example: "Newline char in this field \n". A double quote must be escaped with another double quote. For example:
"The double quote character "" is offensive.".
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Note: By default, you can't view the Personally Identifiable Information(PIl) such as mobile numbers in the exported
data. To view this information, follow these steps:
1. Navigate to Tools > Security Console.
2. Search for the role ORA_MOT_QUOTA_EXPORT_MANAGEMENT_DUTY.
3. Edit role and click the Data Security Policies link.
4. C(lick the Create Data Security Policy button, and add a new data security policy on the database resource
Trading Community Contact Point with the following details.

o Policy Name: Custom Grant on Person Contact and Mobile Phone Data (you can provide any name)
o Database Resource: HZ_CONTACT_POINTS

o Data Set: All Values
o Actions: View Trading Community Person Contact, View Trading Community Mobile Phone Number

5. Click OK to save and navigate to Summary step to review and save changes.

Related Topics
« How You Monitor Export Activity

- Export Queues
« What are the roles required to import or export data?

Can | configure the prefix for Help Desk requests?

When a help desk request is created, a unique number or ID is generated for it by the application.

Users can't easily read or use these unique IDs because of their length and complexity. As an administrator, you can
configure the unique ID that's generated to make it more user-friendly, readable, and specific to your requirement.

This user-friendly value called the public unique ID consists of a prefix and a radix, and you can configure both of them.
For example, SR_0000027413 is a configured public unique ID, where SR_ is the prefix and 0000027413 is the radix or
suffix.

To configure the prefix and radix for help desk requests:

1. Signin to the application as a setup user or administrator.
2. Inthe Setup and Maintenance work area, go to the following:
o Offering: Service
o Functional Area: Productivity Tools
o Task: Manage Public Unique Identifier Sequence Generation

3. Onthe Manage Public Unique Identifier Sequence Generation page, for the Help Desk Request or Internal
Service Request Object Name, specify a prefix of your choice in the Prefix column. For example: HRHD- or
ISR-.
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4. Click in the Radix column for the HR Help Desk Request or Internal Service Request object.

5. From the multiple options displayed in the drop-down list, select the type of radix that you want for your help
desk requests .

This option determines the radix value of the request number. To format the auto generated radix value, you
can configure the SVC_PUID_FORMAT profile option as described in the "Help Desk Profile Options" topic.

6. Click Save and Close.

How do | set up a Slack channel: Method 2?

How you integrate with Slack depends upon your company's requirement. To create your own slash commands in Slack,
follow the steps listed in the following table:

Step no. Name of topic

1 Create a Slack App for Fusion Sales and Service

2 Update the Display Information for Your Slack App

3 Add a Redirect URL for Your Slack App

4 Add Scopes to Your Slack App

5 Set Up Interactive Components for Your Slack App

6 Set Up Slash Commands in Slack for Opportunities, Leads, and Accounts

(Required for your Sales application, Not Required for your Service application)

7 Update Functional Setup Manager with Credentials of Your Slack App

8 Create a Slack Channel in Your Fusion Application

9 Enable Notifications to Slack

10 Add a Slack Contact Point for Your Sales Representatives Who Use Slack

(Required for your Sales application, Not Required for your Service application)

1 Set Up a Scheduled Process to Synchronize Slack Users

(Required for your Service application, Not Required for your Sales application)
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How do | automatically route chat work assignments to
agents?

Routing rules identify queue assignments, which could be sent to a queue with live agents or the Oracle Digital Assistant
(ODA) queue. They also escalate a chat from ODA to a live agent queue. Also, If you enable Omnichannel, it's enabled for

both Fusion Service and Help Desk.

I Note: Chat assignments must be created in the Generic Queuing Rules Category and should be unique.

Here's how you create a rule set:

1. Inthe Setup and Maintenance work area, go to the following:
o Offering: Help Desk
o Functional Area: Assignment and Routing
o Task: (select All Tasks from the Show menu) Manage Service Assignment Rules

N

From the Category drop-down list, select Generic Queuing Rules.

Note: Depending on what application you're using, Service Center, Help Desk, you select the corresponding
generic category.

Click the Add Row (+) icon in the Rule Sets area.

Enter a name for the rule set.

In the Rules area, click the Create (+) icon, then do the following:

Enter a name and description in the respective fields.

(Optional) Set an effective start and end date.

Click the Add Row (+) icon in the Conditions area.

From the Object drop-down list, select Any.

From the Attributed drop-down list, select an attribute that you want to use in routing chats.

Select a value that must match to route your chats.
If you re setting up your chat requests to route to Oracle Digital Assistant, you'd select the Escalation Level
attribute and set the value to equal O (zero). Then, you'd create a second rule within the same rule set to route
to a live agent queue. The second rule would have the Escalation Level greater than O (zero).You can add other
criteria to use for routing as needed.

6. When you're finished, click Save and Publish.

7. To confirm the rule was published, click the Refresh button.

v W

~pRoFy

A few things to note with routing rules

- Custom Attributes: If you've added a custom attribute and want to use it in routing rules, you must expose the
custom field or object using the Communication Channels > Manage Service Assignment Objects page task
on Functional Setup Manager.

o You can select or deselect the Use Score option on a rule set. If you select Use Score, then for every rule
in the rule set, you must indicate the amount to increase the score when the rule is true. You must then
associate the rule set to queues that receive that score. All the rules in a rule set are executed, and the
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gueue with the highest total score is selected. - If the rule set has multiple rules and you didn't select the
Use Score option, you must define the criteria for each rule to be mutually exclusive from other rules

in the rule set. This ensures that the resulting queue assigned by the application is predictable in all
situations.

How do | change email templates to display the email
thread?

When an employee replies to an email from the Messages tab in an help desk request, it's good to display the email
thread. This way, the recipient clearly understands the context.

For this to happen, you must insert the #PastConversation# tag into the email templates for help desk requests. This
tag indicates the place within the email layout where you want to insert the previous messages from the email thread.

When the #PastConversation# tag is detected, the email-sending process automatically inserts the following details of
previous messages from the request:

- Type of message

- Sender
- To/Cc

Received date and time of the message for customer entries

- Sent date and time of the message for agent responses

- Creation date and time for other messages

Message content

When employees preview an email, the email thread is included in the preview. This helps them to verify the flow and
make changes as required, so the message is clearly understood.

To change an email template to display the email thread:

- —
—
H

-
N

COVPONOCURAUNRA

Sign in to the application as an administrator.

Navigate to Application Composer.

In the Application field, select CRM Cloud from the drop-down list.

Click Email Templates from the Common Setup region or the Overview page.

From the Object drop-down list in the Email Templates page, select Help Desk Request .
From the Active drop-down list, select Yes.

Click Search.

From the list of templates displayed, select the template that you want to change.

Click Edit.

Navigate to the Email Body region of the email template.

Insert the #PastConversation# tag at the place within the email body where you want the email thread to be
displayed.

. Click Save and Close.
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Related Topics
« How do | display email thread of past conversations?

« How do | configure profile options to display an email thread?
» How do | define email templates?

How do | display email thread of past conversations?

When an employee receives a response to an email from the Messages tab in a help desk request, it's a good idea to
display the email thread with the past conversations. This way, the employee easily understands the context.

This is also useful as the email thread is included when the email is previewed. Past conversations can be viewed in the
thread latest replies can be written as required.
To enable the display of the email thread, you need to complete a few simple processes:

- Configure a few profile options

- Change email templates to display the email thread

Related Topics
» How do | configure profile options to display an email thread?

- How do | change email templates to display the email thread?
« How do | define email templates?

How do | configure profile options to display an email
thread?

When an employee responds to an email from the Messages tab in a service request, it's good to display the email
thread. To enable the display of the email thread, you must configure the following profile options.

Profile Option Description
SVC_EMAIL_ENABLE_PAST_ Indicates whether to display past conversations. To enable past conversations, set the value to Yes.
CONVERSATIONS

The default value is No, so it's disabled by default.

SVC_EMAIL_NO_OF_PAST_ Indicates the number of past conversations to be included in the email thread.
CONVERSATIONS
The default value is 1.

You can specify a value from 1to 10. If you set the value to 0, no past conversations are included. And
even if you set a value greater than 10, only a maximum of 10 conversations are displayed.
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Profile Option

SVC_EMAIL_PAST_CONVERSATION_
START_MARKER

SVC_EMAIL_PAST_CONVERSATION_END_
MARKER

ORA_SVC_EMAIL_DEFAULT_LANGUAGE

SVC_EMAIL_PAST_CONVERSATION_
MSGTYPES

ORA_SVC_EMAIL_PAST_CONVERSATION_
SHOW_MSG_TYPES

ORA_SVC_EMAIL_DEFAULT_PAST_
CONVERSATIONS_IN_OUTBOUND_MSGS

ORACLE

Chapter 1
Questions and Answers

Description

Indicates the start marker for each conversation in the email thread.

This value is fixed and is displayed in English by default. To translate and display this value in the
language of your choice, you must set the required locale in the ORA_SVC_EMAIL_DEFAULT _
LANGUAGE profile option.

Indicates the end marker for each conversation in the email thread.

This value is fixed and is displayed in English by default. To translate and display this value in the
language of your choice, you must set the required locale in the ORA_SVC_EMAIL_DEFAULT _
LANGUAGE profile option.

Indicates the default language to format outbound emails and parse inbound emails.

The default value is blank. When it's blank, the existing values for the start and end markers are
displayed for the past conversations. For details about these markers, see the preceding two rows in
this table.

You can specify the locale as a value for this profile option. For example: en for English, fr for French,

and pt for Portuguese. When you specify the locale, the translated values for the following start and
end conversation markers are displayed in the specified language:

« SVC_EMAIL_PAST_CONVERSATION_START_MARKER: [##Send your response as a reply to the
above mail##]

« SVC_EMAIL_PAST_CONVERSATION_END_MARKER: [##End of conversation##]

Indicates the types of messages to include in the email thread. You must specify the codes for the
message types, separated by commas.

For example: ORA_SVC_INTERNAL_NOTE, ORA_SVC_RESPONSE, ORA_SVC_SYSTEM_NOTE, ORA_
SVC_CUSTOMER_ENTRY, ORA_SVC_FORWARD, ORA_SVC_SYSTEM_RESPONSE. You can't specify the
meaning or the display name of the message type.
The default value is ORA_SVC_CUSTOMER_ENTRY.

Note:

To add codes for other message types, see the "Search for Lookup Codes of Message Types" section
at the end of this topic.

Indicates whether to include the message type in past conversations.

The default valueis V.

The message type is translated based on the signed-in user's locale. But the default language might
be different. Let's say the signed-in agent's locale is Japanese and the default language is Chinese. So
while everything gets translated to Chinese, only the message types appear in Japanese.

If your customers contact you about this issue, you can set the value to No. The message type is no

longer included in past conversations.

Indicates whether to enable past conversations by default in outbound messages.
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Profile Option Description

ORA_SVC_EMAIL_PAST_CONVERSATION_ Includes messages from only one or more specific channels in past conversations.
CHAN_TYPES

Set the value to a comma-separated list of those specific channel types that you want.

To configure the profile options for displaying the email thread:

9.
10.

1.
12.

OO UAWNRA

Navigate to the Setup and Maintenance work area and open the Tasks panel tab.

Click Search from the list of displayed tasks.

In the Search field, type Manage Admin.

From the displayed list of tasks, click Manage Administrator Profile Values.

In the Manage Administrator Profile Values page, navigate to the Search: Profile Option region.
In the Profile Option Code field, type s.

Select %PAST_CONVERSATION% from the options displayed.

Click Search.

The Search Results: Profile Options region displays the list of profile options related to past conversations.
Select the profile options one by one.

In the Profile Values region, specify the values in the Profile Value column for the Site Profile Level as
described in the table.

Repeat the previous step for each profile option in the search results.

Click Save.

Search for Lookup Codes of Message Types

Follow these steps to search for the lookup codes of message types that you want to add in the
SVC_EMAIL_PAST_CONVERSATION_MSG_TYPES profile option. You can use the same steps to search for the lookup
codes of message types available in the Compose menu in the Messages sub tab of a help desk request.

NOUuRWNRA

Sign in as an administrator.

Navigate to the Setup and Maintenance work area and open the Tasks panel tab.

Click Search from the list of displayed tasks.

Search for and select Manage Standard Lookups.

In the Manage Standard Lookups page, in the Lookup Type field, type ora_svc MESSAGE TYPE CD.

Click Search.

From the Lookup Code column in the ORA_SVC_MESSAGE_TYPE_CD: Lookup Codes region of the page, copy
the lookup codes that you want to specify in the SVC_EMAIL_PAST_CONVERSATION_MSG_TYPES profile
option.

Note:
o Thelookup codes ORA_SVC_CHAT_TRANSCRIPT and ORA_SVC_WRAP_UP aren't applicable to
emails.
o If you disable any of the following lookup codes, the corresponding message types
disappear from the Compose menu on the Messages sub tab of a help desk request:
ORA_SVC_INTERNAL_NOTE, ORA_SVC_RESPONSE, ORA_SVC_CUSTOMER_ENTRY, and
ORA_SVC_FORWARD.
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What's the life cycle of a help desk request?

Here's an overview of the stages in a help desk request life cycle.

Typical Flow of the Help Desk Request Process

The following graphic depicts the typical flow of a help desk request
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Request setup
Status @

(c Request created by the
[3¢]' Customer/ Agent/ Administrator/ REST

|

Agent working on the requ
Status

___, Therequest can be updated
@ through channels such as

email, REST, and more

- The agent receives an inbound email from a Customer. This creates the request in "New" status.
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Use any of the following methods to create a help desk request:

o Customer sends email to create the request. This requires setup by an administrator.
o Customer creates the request using Digital Customer Service. This requires setup by an administrator.
o Agent manually creates the request by clicking the Create button.

o Use other methods such as REST or Import.
- The agent starts working on the request, and changes the status to "In Progress."
Use any of the following methods to update the request:

o Customer sends email to update the request.
o Customer updates the request using Digital Customer Service.
o Agent manually updates the request.

o Use other methods such as REST or Import.

- The agent realizes that they need some extra information from the customer. So they send an email to the
customer and flip the request status to "Waiting".

- The customer replies back to the email. Currently, the application changes the status back to IN PROGRESS.
Here status change isn't ready-to-use, and requires setup in the application.

- The agent replies back to the customer with the solution and sets the request status to Resolved.
Use any of the following methods to resolve the request:

o Automatic Resolve of the request from Waiting status. This requires setup by an administrator.
o Customer resolves the request using Digital Customer Service.
o Agent manually updates the request.

o Use other methods such as REST or Import.

- Resolved requests are automatically closed through an Enterprise Scheduler (ESS) job after a the number of
days that your administrator defines when the application is configured.

Why assign an owner to a queue?

It's a good idea to have queue owners if you find you've specific customer requests like if they want more information or
a demonstration. That way the queue owner can manually assign suitable resources.

When a new work item is assigned to a queue, the queue owner receives a notification. If required, the owner can
override the automatic assignment of a request and manually assign the request to a specialized or specific resource. If
the owner thinks that the automatic assignments are fine, the owner need not take any action.

Note: If you're an administrator or manager, you can assign owners to queues on the Queues page. Depending on
your settings, you can also assign queue owners while creating or editing a queue.
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You must complete the following processes:

- Add the Queue Owner field to the page layouts for queues (You need to do this step only once.)

- Assign a queue owner for a queue

How do | add the queue owner field to the page layout?

To add the Queue Owner field to the page layouts for queues follow this one-time process:

Sign in to the application as an administrator or setup user.

Within a sandbox, navigate to Application Composer.

In the Application field, select CRM Cloud from the drop-down list.

Search for gueue.

Click Standard Objects > Queue.

Click Pages.

Depending on your company's requirements, add the Owner field to some or all of the following page layouts
for queues: Landing Page Layouts, Creation Page Layouts, and Details Page Layouts.

NOUARWN

What's a Coverage Schedule and how does it work?

A coverage schedule is a service calendar containing detailed time intervals that identify when a help desk request is
expected to be worked.

Coverage schedules provide flexibility to define business hours and specific intervals during the year when different
operating hours are offered. For example, you can define a specific interval such as a particular week or seasonal
time period where you might extend service hours on specific days. You can also treat holidays or exceptions more
specifically, such as offering shortened hours on some holidays, instead of a full day inclusion or exclusion.

To identify the due date and time for a milestone, time outside the specified intervals is skipped. For example, if your
coverage schedule interval is 9:00 a.m. to 5:00 p.m. Monday through Friday, a milestone that started Friday at 4:00
p.m., which is due in 120 minutes, would be due 10:00 a.m. on Monday.

Coverage schedules can also contain holidays, nonworking times, or extended working hours, which identify days to be
skipped or hours to be added when deciding the due date. You must configure the coverage schedule exceptions before
you create or change a coverage schedule. In the previous example, when a milestone started 4:00 pm Friday and

had 120 minutes until due, if Monday was identified as a holiday, the milestone would be due at 10:00 am on Tuesday
instead.

Here's how the application calculates the Due Date and Time Remaining fields that are displayed on the Service
Request Milestone Details page:

Due Date: The due date for a milestone is calculated using the schedule that's associated with the applicable
entitlement or coverage rule. The schedule defines whether there are any hours of the day or week when the
clock isn't running for the organization, such as evenings, holidays, lunch breaks, and so on.

When a service request is updated, the application looks at the coverage rules and the associated schedule,
calculates the date and time the milestone expires, and assigns the milestone to the service request. The
milestone due date is calculated based on the time the milestone starts, which might not be the same as the
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time the service request was created. The application displays this due date for that milestone on the Service
Request Milestone Details page.

If the SR attributes change so that the milestone goes into a paused state, the clock stops running. The
application captures the time spent on the milestone up until the milestone was paused, for future use. The due
date for the milestone is no longer displayed, because it can't be determined until the milestone resumes the
countdown. After the pause is lifted and the countdown resumes, the application recalculates the milestone
due date. The recalculation is based on the original time you specified for that milestone when the help desk
request was created, minus the cumulative time spent by the agent up to that point.

Time Remaining: The Time Remaining field displays its value depending on whether the milestone is actively
counting, paused, or overdue. The application doesn't show time remaining for milestones that are complete or
canceled.

When the milestone is actively counting down, the exact due date is known. The Time Remaining field shows
an approximation of the amount of time between the due date and the current time. This approximation is
expressed in the largest indivisible unit of time and rounded down. For example, if the current time is 3:00 PM
and the milestone is due at 4:05 PM, the time remaining shows 1 hour. If the current time is 10:00 AM and the
milestone is due the next day at 11:00 PM, the time remaining shows 1 day.

When the milestone is paused and the due date can't be determined, the Time Remaining field identifies

only the time left in the milestone. The time left is determined by calculating the total time specified in the
coverage, minus the time spent so far. For example, a milestone that was set for 24 hours (based on the
coverage rules), and that was active for 10.5 hours before it paused, will have 13.5 hours remaining for the
duration of the time it's paused. The Time Remaining field uses the same approximation method as described
for active milestones, so 13.5 hours is rounded down to show 13 hours. Again, the actual due date isn'tin 13
hours, because it's unknown when the counting will resume and therefore how the schedule might affect the
due date. The 13 hours is given as an approximation of the working time you'll have once the milestone restarts.

When the milestone is overdue but still not complete, the Time Remaining field

shows how much time has elapsed since the milestone expired. The profile option
ORA_SVC_SLA_INCLUDE_PAUSED_MINS_IN_TIMEREMAINING indicates whether this calculation considers
paused minutes in the calculation.

Excluding paused minutes ignores whether the milestone has paused after expiration, and results in a more
exact calculation of actual time elapsed and improved performance. Including paused minutes considers how
much time was spent in the paused state after expiration and reduces the overdue time remaining value by
that amount. This requires more calculations, is less consistent with the calculation before expiration, and can
impact performance.

Note: Oracle recommends setting this profile option to N and starting with release 23D, all implementations
will have the value set to N. You can then change the value to Y if you want for backward compatibility.

A schedule named 24 by 7 is preconfigured for all implementations. This schedule doesn't specify holidays or
downtime, so the due date for a milestone that uses this schedule, is calculated without skipping any time.

Related Topics

How do | set up milestones and coverages?
How do | create a coverage schedule?

How do | create default coverages?

How do | create standard coverages?
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How do | set up more condition columns for standard
coverage entitlement rules?

The application has a default entitlement type called Subscription Entitlements (or Contracts Service Entitlements),
which is a matrix class, and a corresponding service mapping that you select when you create your standard coverage.

This default matrix class defines the structure of the entitlement rules for the standard coverage, including the
condition columns (Severity and Channel Type), and result columns (Calendar, and milestone values and warning
thresholds). Condition columns in the coverage are compared to field values in a help desk request to determine which
line is applicable, and the result columns display the schedule, milestones, and thresholds that are applied.

You can use other columns from the help desk request as condition columns in coverages, by editing the service
mapping and creating your own matrix class. To do this, first modify the service mapping to add the intended attribute.
After you modify the service mapping, create a matrix class including the attributes, and then select the matrix class as
the entitlement type for a standard coverage.

How do | set up a milestone based on a field | created?

The default entitlement type Subscription Entitlements (or Contracts Service Entitlements), is a matrix class. A
corresponding mapping is selected when you create your standard coverage. Here's how you create a matrix class and
add more conditional columns.

This default matrix class defines the structure of the entitlement rules for the standard coverage, including the
condition columns (Severity and Channel Type), and result columns (Calendar, and milestone values and warning
thresholds). Condition columns in the coverage are compared to field values in a help desk request to determine which
line is applicable, and the result columns display the schedule, milestones, and thresholds that are applied.

You can use other columns from the help desk request as condition columns in coverages, by editing the service
mapping and creating your own matrix class. To do this, first modify the service mapping to add the intended attribute.
After you modify the service mapping, create a matrix class including the attributes, and then select the matrix class as
the entitlement type for a standard coverage.

1. On the Subscription Configuration page, click Dynamic Matrix Configuration > Manage Matrix Classes.

The Manage Matrix Classes page is displayed.

Note: If you're using Service Contracts, then you navigate to this page by clicking Navigator > Contract
Management > Contracts > Tasks > Manage Matrix Classes.

2. Duplicate the HR Service Request Subscription Entitlements or Internal Service Request Subscription
Entitlements (or Contracts Service Entitlements) matrix class. You can also edit a matrix class you created
before, or create a new matrix class.

3. On the Edit Matrix Class page for the selected matrix class, in the Condition Columns section, click Add Row to
add a new condition column for the mapping that you created in the previous service mapping procedure. This
condition column displays in the entitlement rules along with the default columns.

4. Enter the Name of the column and the Source Code Name.
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5. Inthe Compare to Attribute column, select the attribute that you created in the previous service mapping
procedure.

6. In the Domain column, click Edit Domain and select a domain value corresponding to the attribute you're
mapping.

7. To allow null values to be specified in the coverage for this column, select the Allow Null checkbox, and
optionally, select the Null is Wildcard checkbox.

Then select the appropriate value for the Null is Wildcard option, based on the intended behavior described in
the following table. The Severity condition column is used as an example in the following table.

Allow Null Selected? Null is Wildcard Add a Coverage Row Coverage Rows Applied Coverage Rows Applied
Selected? with Blank Value? on SR with Blank Value  on SR with Non Blank
Specified? Value Specified?
N N Not possible No rows applied When explicit match

between help desk
request and coverage
row.

Y Y Y Blank row applied o Ifthe help desk
request severity
isn't defined in
a row, the blank
coverage row is
applied.

o If the help desk
request severity
is defined in a
coverage row, an
error occurs and no
values are applied.
Both the blank row and
the matching row are
considered a match, but
coverages must be set
up so that only one row
from a specific coverage
can ever be matched. If
two rows match, it results
in an error condition and
no rows being applied.
For more information,
see the step 5b in the
topic "Create Standard
Coverages".

Y Y N No rows applied When explicit match
between help desk
request and coverage
row.
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Allow Null Selected? Null is Wildcard Add a Coverage Row Coverage Rows Applied Coverage Rows Applied
Selected? with Blank Value? on SR with Blank Value  on SR with Non Blank
Specified? Value Specified?
Y N Y Blank row applied When explicit match

between help desk
request and coverage
row.

Y N N No rows applied When explicit match
between help desk
request and coverage
row.

8. C(lick Save and Close.
The matrix class displays in the Entitlement Type drop-down list when you create a standard coverage.

How do | add the milestone to the Manage Service
Milestone Configuration Task in Help Desk?

Here's how you can add the milestone to the Manage Service Milestone Configuration task:

1. Inthe Setup and Maintenance work area, go to the following:
o Offering: Help Desk

o Functional Area: Service Entitlements

o Task: Manage Service Milestone Configuration for HR Help Desk or Manage Service Milestone
Configuration for Internal Help Desk Requests

The Manage Milestone Configuration page is displayed.
2. Click Create Milestone and specify the following milestone details:

o Milestone Label: Enter the name of the milestone that should be displayed on the help desk request.

o Milestone Code: Select the name of the milestone result column you added to the matrix class. These
names are defined in the matrix classes and can't be modified.

o Milestone Type: Select from the following types, which determine whether milestones are reopened or
repeated once complete.

- Can be reopened: A milestone that can be reopened is set back to In Progress status when the
complete criteria is no longer true, and continues the countdown to expiration when reopened. The
Resolution Metric milestone is of this type.

- Can be repeated: A milestone that can be repeated can't be reopened once closed, but another
one is created when the start criteria is valid. For example, suppose you configure a Next
Response Due milestone that should be repeated each time an employee update is posted to the
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help desk request. Once a response is sent, the milestone is complete, but upon receiving a new an
employee update, another Next Response Due milestone is created and tracked.

- Can't be repeated: A milestone of this type can't be reopened or repeated once it's marked
complete. The First Response Metric milestone is of this type.

o Threshold Code: Select the name of the threshold result column corresponding to the milestone, which
you added to the matrix class. This determines the threshold value that's applied to the milestone. The
names are defined in the matrix classes and can't be modified.

o Business Unit Name: Leave as the default business unit (BU) unless you're configuring milestones for
multiple business units. For more information, see the "Configure Milestones for Multiple Business Units"
in this guide.

o Allow Due Date Override: Select this check box to let agents modify a milestone's due date on the
Service Request Milestone Details page (in the Due Date field).

Note: If a customer wants to audit agent updates to the due date, the administrator must enable audit
on the Overridden Due Date attribute.

o Allow Agent Completion: Select this check box to let agents manually acknowledge that they have
completed a milestone and close it. On the Service Request Milestone Details page, if an agent selects
the Agent Completed check box and saves the milestone, the milestone status is updated to Complete.
Milestones that can be reopened are reopened if the start condition is met again.

The administrator can specify which milestones allow due date updates and which allow the update to
specify a milestone has been completed. These attributes are independent of each other, so that some
milestones can allow only moving the due date, others might allow the agent to mark it complete but not
move the due date, and still others may allow both types of updates.
3. Enter the milestone conditions. Each milestone (both prebuilt and administrator-defined) has conditions that
determine when the milestone starts, pauses, and completes. For each condition, you can define multiple
attribute and value pairs that determine when the condition is applied to the milestone.

o Each tab has a text box that enables you to provide a common description that's displayed in the help
desk request details when the milestone is applied to the help desk request. This description enables
an agent to understand when a milestone starts counting, when it pauses, and when it's considered
complete.

o Add conditions using the Create button in the tab. Use the Attribute column to indicate a field to
compare to a value using the operator. The Attribute column lists administrator-defined fields and a
subset of the service request fields that are available to use as conditions. Alternately, you can specify
a static condition that doesn't require an operator or value. You can also use object functions written in
Groovy, to express more complex start, pause, and stop criteria for milestones.

- For example, if you specify the field Problem Type Code, you must specify the operator (Is One
Of, Is Not One Of) and the values that make this criteria true.

- Alternately, if you specify a static condition such as Immediate, no operator or value is required. In
this case, the criteria is considered true as soon as the service request is evaluated.

- You can specify a logical condition in the form <attribute> <comparison> <operator values>.

For example, you can specify status Type (attribute) s one of (Operator) closed, Resolved (values)
as the completion criteria for Resolution Milestone. You can also specify a static predefined
condition such as user sends Response, Which evaluates to true as soon as any user sends a
response message.

When an object function is written on the help desk request object in Application Composer to

return a Boolean value, the function is available as start, pause, and completion criteria. Similar
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to the static conditions, when an administrator-defined object function is selected, the operator
and values aren't required. When the function returns true, the start, pause, or completion criteria
specifying that function is triggered.

o When multiple rows are added as conditions, the results are combined logically using the AND operator,
so all rows must evaluate to true for the criteria to be true.

What are some examples of inbound message filters?

Here are some examples of regular expressions for filter patterns of inbound message filters.

Note: Use the ".*" wildcard characters to match O or more occurrences of any character.

Filter Type Regular Expression Example

File attachment Attachments that are files with either .pdf, .txt, or .html file extensions:
pdf|.txt|.html

Header Emails with headers that contain the string Gentle Reminder:

- ~Gentle Reminder[A-Za-z0-9._%+-]*

. AGentle Reminder.*

Mime attachment Content Type header with values such as text/plain, text/html, image/jpeg, or application/octet-
stream:

text/plain|text/html|image/jpeg|application/octet-stream

Reply to Emails that are sent by the support team:
« support_[A-Za-z0-9._%+-1*@company\.com
- support_*@company\.com
Sender Emails that are sent by an Oracle employee:
- [A-Za-z0-9._%+-]*@oracle\.com
. *@oracle\.com

Subject Email subjects with string AutoReply:

- “Auto Reply: [A-Za-z0-9._%+-]*
- ~Auto Reply.*

70
ORACLE



Oracle Fusion Cloud Applications Chapter 1
Help Desk: Questions and Answers Questions and Answers

How do | enable subscription coverages for
entitlements?

Oracle recommends using subscription coverages. New customers are automatically opted-in to Subscription
Management instead of Service Contracts. Existing customers who are implementing service entitlements should
consider subscription coverages.

The Manage Service Entitlements Using Subscription Coverages feature is enabled by default for new instances. If
this feature is enabled, the application uses Oracle Subscription Management Cloud to define entitlement calendars,
coverages, and associated setup, and uses this setup at runtime to identify service request milestones.

Here's how you can enable this feature:

1. Inthe Setup and Maintenance work area, go to the following:
o Offering: Help Desk
2. Click Change Feature Opt In.

Select the Enable checkbox in the Service Entitlements row.
3. Click Done.

How do | use Groovy script to notify an agent that a
service request has been assigned?

Here's a sample groovy script that triggers a notification to be sent to the recipient specified in the Notification
Preferences page when a service request (SR) is assigned.

You can copy and paste this sample code in Application Composer > Objects > Standard Objects > Service Request >
Server Scripts.

/* DISCLAIMER: This trigger is provided only as a reference.

* TRIGGER TYPE: Before Update in Database

* OBJECT: Service Request

* Use Case: Send a notification when an existing SR is reassigned.

* Note: You can override the Notification Text and Recipients using the Notification Preferences page.

*/

if (isAttributeChanged('AssigneeResourceld')) {

try {

def recipientPartyld = AssigneeResourceld

def messageText = 'An SR notification (default message) .'

if (recipientPartyId) ({
//Call to send notification
adf.util.sendNotification(adf, messageText, recipientPartyId)

//Log a confirmation that the notification has been sent. Logs can be viewed in 'Runtime Messages'.
//println("Notification sent to " + recipientPartyId + " because the SR was assigned to them.")

} else {

println("No Assignee associated with this SR")
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}
} catch (e) {
//Log the failure in groovy logging. Logs can be viewed in 'Runtime Messages'.
println("Failure to trigger notification from Groovy Script " + e.getMessage()):;
// Throwing validation exception will show the message on the UI. This is not recommended for published
sandboxes.
// The following code is one of many to illustrate identifying an error in trigger from the UI.
// Replace <triggerName> with the trigger name you specified when creating this trigger.
// throw new oracle.jbo.ValidationException('Failure to trigger <triggerName> Notification from Groovy
Script: ' + e.getMessage())
}
}

How do | assign work to a queue?

Here are the various ways in which you can assign a help desk request to a queue:

- Open a request. From the Queue drop-down list, manually select the queue to which you want to assign the
request .

- Enable Omnichannel, which runs the queue assignment rules when the request is created or when the queue is
deleted from the request .

« Click Run Queue Assignment from the Actions menu, which runs the queue assignment rules.

- Enable the Assign Help Desk Request to Queue on Create profile option, which runs the queue assignment
rules when the request is created. The process is described below.

« Schedule the Queue Assignment job that runs the queue assignment periodically and processes all the open
requests that aren't assigned to a queue.

The preferred way of assigning a help desk request to a queue is by using Omnichannel assignment. Enabling
Omnichannel has the following advantages:

- Enabling Omnichannel provides more features than queue assignment. It also enables the automatic
assignment of agents. But if your business only requires queue assignment, you must carefully evaluate
whether you need to enable Omnichannel.

- Only if you enable Omnichannel, the request is assigned to the Default queue when the Assignment Manager
rules haven't been defined or when the selected request doesn't satisfy any active rule.

- When Omnichannel is enabled, automatic assignment of requests to agents is always enabled on the Default
queue.

Suppose you're assigning help desk requests to an automatic queue either manually or automatically by using
assignment rules or Groovy scripts. If you enable Omnichannel, Oracle recommends that you also assign active agents
for the automatic queue, so that requests can be assigned to the agents.

Note: If you don't assign agents for the automatic queues, requests assigned to those queues could grow
exponentially over time. And this causes the application to slow down.
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Enable the Assign Help Desk Request To Queue On Create Profile Option
to Assign a Request to a Queue

Here's how you enable the Assign Help Desk Request To Queue On Create profile option:

1. Signin to the application as an administrator.

2. Inthe Setup and Maintenance work area, click the Tasks hamburger icon.

3. Click the Search link.

4. Enter Manage Administrator Profile Value in the Search field and click Search.
5. Click the Manage Administrator Profile Value task link.

6. Enter SVC_ASSIGN_TO_QUEUE_ON_CREATE in the Profile Option Code field.
7. Click Search.

8. In the Profile Value drop-down list for the Site Profile Level, select Yes.

9. Click Save and Close.

Note: If Omnichannel is enabled, this profile option is ignored.

How can | be notified when someone replies to a
message?

Here's a sample code to trigger a notification to be sent to the recipient specified in the Notification Preferences page
when a customer replies to a message.

You can copy and paste this sample code in Application Composer > Objects > Standard Objects > Service Request >
Message > Server Scripts.

/* DISCLAIMER: This trigger is provided only as a reference.
* TRIGGER TYPE: Before Insert to Database
* OBJECT: Message (child of Service Request)
* Use Case: Send a notification to the assignee when a customer entry is created.
* Note: You can override the Notification Text and Recipients using the Notification Preferences page.
*/
if (MessageTypeCd == 'ORA_SVC_CUSTOMER ENTRY') ({
try {

// Note: The notation ServiceRequest?.SrNumber is used because ServiceRequest is the parent

// object of Messages. To access the other possible field names, expand the trigger box, click on fx,
// click on Fields, and select the drop-down list from Message. Click on Service Request to see the
// available fields. You must click Insert to correctly insert the appropriate field into your script.

def messageText = "A customer entry was received for " + ServiceRequest?.SrNumber

def recipientPartylId = ServiceRequest?.AssigneeResourceld

if (recipientPartyId) ({

// Call to send notification

adf.util.sendNotification(adf, messageText, recipientPartyId)

//Log a confirmation that the notification has been sent. Logs can be viewed in 'Runtime Messages'.
//println("Notification sent to " + recipientPartyId + " because a customer entry was received.")
} else {

println("No Assignee associated with this SR")

}

} catch (e) {

// Log the failure in groovy logging. Logs can be viewed in 'Runtime Messages'.
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println("Failure to trigger notification from Groovy Script " + e.getMessage()):;

// Throwing validation exception will show the message on the UI. This is not recommended for published
sandboxes.
// The following code is one of many to illustrate identifying an error in trigger from UI.
// Replace <triggerName> with the trigger name you specified when creating this trigger.
// throw new oracle.jbo.ValidationException('Failure to trigger <triggerName> Notification from Groovy
Script: ' + e.getMessage())
}
}

How do | create queues?

If you've enabled Omnichannel, there's a ready-to-use queue default queue. This topic discusses how to create queues
and how default queues work.

Oracle recommends that the Default queue Distribution field is set to Automatic when Omnichannel is enabled.
Available agents must also be associated with the Default queue.

Be aware that the Default queue contains work items that couldn't be assigned to any other queue because they don't
match any of the defined assignment rules. You can add agents and teams to the Default queue and also change the
gueue properties, but you can't disable or delete this queue.

Depending on your requirements, you might want to create specific queues to route chats to a group of skilled agents.
To do this, you can create more queues, staff them with agents, and create your routing rules to assign chats to that
gueue. Here are the steps for creating queues:

Navigate to Service > Queues.

Enter a name for the queue.

Check the Activation field.

Set Distribution to Automatic (Push).
Click Save and Continue.

Click the Resources tab.

Select agents to add to the queue.
Click Apply when finished.

Click OK.

VOO UEWNRA

Note:

- The ready-to-use Default queue acts as a catch-all queue for Help desk requests when assignment rules fail to
evaluate matching conditions.

Here's what Oracle recommends:

o If you enable chat, you must set the Default queue to Automatic and assign agents to the queue. When
the Default queue is automatic, all those chats that don't match any rules or they match a manual queue
are assigned to the Default queue. If you set the Default queue to manual, such chats aren't routed to any
agent, and no one would respond to those chats.
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Can | use surveys with Help Desk?

The survey integration framework lets you start survey requests based on any object.

You can send surveys from your preferred third-party supplier to your customers based on your chosen rules. You can
define who receives a survey, what survey should be sent, and when to send a survey.

The survey integration framework connects with your survey supplier using Oracle Integration Enterprise Edition.

The following graphic shows the set up steps you'll need to perform to integrate the survey framework.

Oracle Integration /~ Third-Party Survey Engine ™
| |
1. Download mapping package - B. Create survey /
2. Install mapping package *
B2B Service
3. Configure Integration
Con neitions 7. Enable Su;u'ey Feature

4. Configure Decision Model 8. Manage S*I,J rvey Objects

9. Manage Survey Products

5. Activate survey integration =
10. Manage Survey Configuration

12. Schedule jobs - 11. Manage Survey Templates

Can | manually close a Help Desk Request?

A help desk request is closed automatically when the Auto-Close HR Help Desk Service Requests or Auto-Close Internal
Help Desk Service Requests scheduled process runs as scheduled. Users can't manually close a help desk request.

The auto-close process closes help desk requests that were resolved a specified number of days ago. The number
of days for this scenario is set using the SVC_ISR_SR_IN_RESOLVED_DAYS and SVC_HRHD_SR_IN_RESOLVED_DAYS
profile options. These mentioned scheduled processes also resolve requests that have been in waiting status for
specified number of days. The number of days for this scenario is set using the SVC_ISR_IN_WAITING_DAYS and
SVC_HRHD_IN_WAITING_DAYS profile options.

Note: You can see a list of closed help desk requests by using advanced search, but you can't manually set the status
of a request to Closed. Also, after a help desk request is closed, you can't edit the request, add a message, or reopen
it.
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Related Topics

How do | enable the Help Desk offering and its features?

The Help Desk offering and features must be enabled in order to see them in Setup and Maintenance. Here's how:

VPOV AWNA

10.
1"
12.
13.

Sign in to Setup and Maintenance as an Application Implementation Consultant.

From the Actions drop-down list, select Go to Offerings.

Click the Help Desk offering.

Click Opt In Features .

In the Help Desk row, select the Enable check-box.

In the Help Desk row, click the Edit icon in the Features column.

In the Edit Features: Help Desk window, click the Edit icon in the Enable column.

In the Help Desk Usage, click the Edit icon in the Enable column.

Select the usage that you want to use for your implementation. Options are Internal Service Requests and HR
Service Requests.

Click Save and Close .

Click Done.

In the Opt In: Help Desk page, you can select to enable any other features you're using.
Click Done.

Note: Some setup tasks will only appear in the table of contents after you enable the associated feature. For example,
some of the email setup tasks don't appear in the task list unless the Email Communication Channel feature is
enabled.

How do | define email templates?

You can create email templates for the Forward, Response, and System Response messages of a help desk request.

You can create templates using HTML to send email notifications for help desk requests using Application Composer.

To define an email template:

-—

CORX®IC VA WNRA

Sign in to the application as an administrator.

Navigate to Application Composer.

In the Application field, select CRM Cloud from the drop-down list.

In the Common Setup region, click Email Templates.

On the Email Templates page, click the plus icon to create a new template.

In the Object field, select Help Desk Request from the drop-down list.

Specify a name for the template.

(Optional) Specify a description.

To add any attachments, click the plus icon, browse to the file location, and select the file.
A template is active by default. To disable the template, clear the Active option.
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11. Specify the email subject.

You can use help desk request field names in the subject. For example, the subject can be Resolved issue
[$Title$].

12. Edit the message HTML as required. Add the #MessageContent# tag anywhere in the HTML code. This tag is
replaced by the help desk request message content.

13. (Optional) To enable the display of the email thread, insert the #PastConversation# tag in the template.

Add this tag within the email body at the place where you want to insert the previous messages from the email
thread. When an agent replies to an employee from the Messages tab in help desk request, the email thread is
displayed.

14. In email templates that are meant for forwarding to internal users, you can include a link to the request within
the template. Include the link in the following format:

<Link to company's Fusion Service site>/service/faces/FuseOverview?
fndGlobalItemNodeId=itemNode service service_requestsé&pSrNumber=<SR Number>.

FOrExaﬂuﬂe,https://company123.mycompanydomain.com:10616/service/faces/FuseOverview?
fndGlobalItemNodeId=itemNode service_ service_requestsé&pSrNumber=SR0000029093.

15. Click Save and Close.

Note: When help desk request is created, it might be with or without a queue. So it's possible that an email
notification is sent before the request is assigned to a queue. To avoid a blank field value in the email notification, you
must not use the Queue Name field in your email template.

How's a help desk request closed?

A help desk request is closed automatically when the Auto-Close HR Help Desk Service Requests or Auto-Close Internal
Help Desk Service Requests scheduled process runs as scheduled. Users can't manually close a help desk request.

The auto-close process closes help desk requests that were resolved a specified number of days ago. The number
of days for this scenario is set using the SVC_ISR_SR_IN_RESOLVED_DAYS and SVC_HRHD_SR_IN_RESOLVED_DAYS
profile options. These mentioned scheduled processes also resolve requests that have been in waiting status for
specified number of days. The number of days for this scenario is set using the SVC_ISR_IN_WAITING_DAYS and
SVC_HRHD_IN_WAITING_DAYS profile options.

Note: You can see a list of closed help desk requests by using advanced search, but you can't manually set the status
of a request to Closed. Also, after a help desk request is closed, you can't edit the request, add a message, or reopen
it.

Related Topics

How do | enable the Help Desk offering and its features?

The Help Desk offering and features must be enabled in order to see them in Setup and Maintenance. Here's how:
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Sign in to Setup and Maintenance as an Application Implementation Consultant.

From the Actions drop-down list, select Go to Offerings.

Click the Help Desk offering.

Click Opt In Features .

In the Help Desk row, select the Enable check-box.

In the Help Desk row, click the Edit icon in the Features column.

In the Edit Features: Help Desk window, click the Edit icon in the Enable column.

In the Help Desk Usage, click the Edit icon in the Enable column.

Select the usage that you want to use for your implementation. Options are Internal Service Requests and HR
Service Requests.

Click Save and Close .

Click Done.

In the Opt In: Help Desk page, you can select to enable any other features you're using.
Click Done.

VIOV AWNA
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Note: Some setup tasks will only appear in the table of contents after you enable the associated feature. For example,
some of the email setup tasks don't appear in the task list unless the Email Communication Channel feature is
enabled.

What functional areas are supported by the Help Desk
offering?

To start implementing Help Desk, a user with the Application Implementation Consultant role must opt into the
offerings you want to use.

Help Desk Functional Areas

The following table shows the primary functional areas of the Help Desk offering.

CAUTION: Changes in tasks for that are shared with the Service offering will impact the setup for existing service
requests (used in CRM and the Classic HR Help Desk). If your company is using the CRM Service application or the
Classic HR Help Desk, be sure to coordinate any changes to shared tasks with the Service Administrator.

Functional Area Description

Help Desk Request Manage lookup values for requests, for example severity, status, or priority values. You can opt into
auditing of help desk requests, or change default action for areas such as assignment, auto-close, and
default values.

Assignment and Routing Manage the Help Desk request assignment objects and assignment rules. You can use attributes of the
request as well as the employee to create the rules.

Email Communication Channel Manage the channels you use to communicate with customers, configure each channel, and manage
the Omnichannel toolbar and assignment rules.
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Functional Area

Other Communication Channels

Service Catalog

Knowledge Management

Service Entitlements

Action Plans

Productivity Tools

Business Units

Application Extensions

Chapter 1
Questions and Answers

Description

Manage settings for the tools that make agents more productive, including global search,
collaboration, and standard text.

Manage the product hierarchy used for categorizing the product of a help desk request.

Enable knowledge management features, set up locales and users, and create and manage the
knowledge base for authors, agents, and external users.

Manage the configuration of milestones tracked for Help Desk requests.

Associate action plans with help desk requests to help facilitate a series of steps or a sequence of
events that may be required to resolve requests.

Manage settings for the tools that make agents more productive, including global search,
collaboration, and standard text.

Set profile options to enable the multi-BU functionality, define and add internal resource organizations,
create business units, and BUs associated with resource organizations.

Manage the common functions that help in maintaining the core application data, establishing
security, maintaining transactional and shared data, and setting the user general preferences.

How do | configure email for Help Desk?

Use the following tasks to configure email for Help Desk.

Configuring Outbound Email Profile Options

As one of the most common channels of communication, Help Desk Agents often use email to respond to employees
and to forward Help Desk requests to other authorized internal resources. In addition, Help Desk uses email to send
automatic system responses to employees for events such as the submission of a Help Desk request.

To configure the Help Desk email channel, several configuration activities are recommended.

1. In the Setup and Maintenance work area, use the following:

o Offering: Help Desk

o Functional Area: Email Communication Channel

o Task: Manage Outbound Email Profile Options for HR Help Desk Requests Templates

2. Configure the following profile option types with the appropriate System Response Email Templates.

The following list shows profile codes that end in '_HRD' and are used in HR Help Desk service requests. Non-
HR Help Desk service requests can also use similar profile codes, but without '_HRD' at the end.
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o SVC_SR_RESPONSE_TEMPLATE_NAME_HRD
o SVC_SR_FORWARD_TEMPLATE_NAME_HRD
o SVC_SR_SYSTEM_RESPONSE_TEMPLATE_NAME_HRD

Creating a Dedicated Help Desk Inbound Email Channel

To ensure the security of sensitive Help Desk communications, Help Desk includes a dedicated inbound email channel
that's separate from the email channel that serves all non-Help Desk requests. To ensure the security of Help Desk
communications with employees, the behavior of the Help Desk Inbound Email Channel is different from all other
Email Channels, which in turn, ensures the security of Help Desk Requests. All email addresses included in email
communications through the Help Desk Inbound Email Channel are added as contacts on an associate's Help Desk
Request (enabling communications about the request. No other permissions are granted to these associated contacts).

Now, you create a new email channel using the following procedure:

1. In the Setup and Maintenance work area, use the following:

o Offering: Help Desk
o Functional Area: Other Communication Channels
o Task: Manage Communication Channels

2. Click the Create Channel button.
3. Inthe Create Channel view, do the following:

a. Expand the Stripe Code menu, and select either HR Help Desk Request Stripe or Internal Service
Request Stripe.
Expand the Channel Type menu and choose the channel type you'd like to create, such as Email.

c. Inthe Account Name field, provide the email address for which the channel is intended. For example,
HRsupport@yourcompany.com.

d. Inthe Channel Code field, specify a code channel that indicates the communication channel.

e. Inthe Display Name field, enter the display name that you want for the channel. This is the value that
employee users see.

f. If multi BU is enabled, expand the Business Unit menu and choose the correct business unit.

g. Enable the record by checking the Active box.

h. Click Save and Close.

Setting Up Forwarding Rules for Email Channels

Now you create a new forwarding rule on your company email server to redirect emails addressed

to your organization's Help Desk email account to the Help Desk address that Oracle provided at the

time of provisioning. This rule and address are different from the rule and address used for all other

service requests. For example, all the support emails that are sent to HRsupport@yourcompany.com are

forwarded to pod_name.fa.intservice.incoming@workflow.mail.em2.cloud.oracle.com for processing. The
SVC_INBOUND_EMAIL_ADDRESSES profile option indicates the Oracle email ID to which the support mails must be
forwarded. Here's how you set this profile option:

1. In the Setup and Maintenance work area, use the following:

o Offering: Help Desk
o Functional Area: Email Communication Channels
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o Task: Manage Inbound Email Profile Options
2. Click the SVC_INBOUND_EMAIL_ADDRESSES link, and do the following:

a. Inthe Profile Values area select New from the Actions drop-down list.

b. Click the Profile Level drop-down list, and select Site.

c. Inthe Profile Value field, enter the Oracle email ID where support email will be forwarded.
d. Click Save and Close.

It's recommended that you then schedule a reoccurring job to process SR and SR message records.

How do | synchronize worker data loaded through HDL
in Help Desk?

After loading the worker data using HCM Data Loader, Oracle recommends running the "Synchronize Person Records”
ESS job to synchronize worker data in Help Desk.

The Synchronize Person Records job is used to create or update corresponding TCA person party records for HCM
workers.

To Ensure Workers are Properly Synchronized

To ensure workers are properly synchronized, set the following parameters for the Synchronize Person Records job:

From Date: Enter the load start date
- To Date: Enter the load end date
- After Batch Load: Yes

Note: In the case where the worker data is loaded for more than seven days, you must repeat the process
multiple times. In other words, if you have more than seven days, repeat the process (with a maximum date
range of seven days) until you're done.

Here are the steps to run the ESS job.

From the Navigator, navigate to Tools > Scheduled Processes.

Click the Schedule New Process button.

Search for and select "Synchronize Person Records" in the Name field of the Schedule New Process window.
Click OK.

Enter the From Date .

Enter To Date.

Select Yes from the After Batch Load drop-down list.

Click Submit.

You can confirm the synchronization when you see the worker is available in the Primary Point of Contact attribute
picker.

PN AUWNA

Note: The Human Resource Help Desk Administrator job role is required to view all worker data in the picker.
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Maintain Party and Location Current Record Information

In order to support additional user types like pending workers and nonworkers, Maintain Party and Location Current
Record Information creates or updates person party records with the party usage. This is required for these additional
worker types to display in the contact pickers.

For more details about this job and corresponding profile options, see Maintain Party and Location Current Record
Information.

How do | manage assignment objects and assignment
rules for Help Desk?

You can use assignment rules to automatically assign Help Desk requests to queues when the requests are created or
updated. You can schedule these rules to run automatically.

Help Desk requests and employee objects are treated as work objects and queues are treated as candidate objects. You
can define rules to select the best queue for each request. To create the work objects and corresponding rules use the
following setup tasks: Manage Service Assignment Objects and Manage Service Assignment Rules.

Defining Help Desk request assignment rules requires some forethought. Before beginning this procedure, you must
consider the following:

- The breakout of queues and agent assignment to the queues.
- The attributes of help desk requests you want to use as criteria for your rule assignments.
- The attributes of the employee records that you want to use as criteria for your rule assignments. The available
attributes include:
o Legal Employer or Entity
o Country
o Business Unit
o Department
o Job
o Location
o Bargaining Unit
o Collective Agreement
« The rule sets you create.

- The rules to include in each role set.

Note: The queues must be created prior to following this procedure.
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Manage Help Desk Assignment Objects

In this procedure, you select attributes from the Help Desk request assignment object that you want to make available in
your rules. This procedure however, isn't mandatory, as ready-to-use fields are provided for all the objects.

To manage assignment objects:

1. In the Setup and Maintenance work area, go to the following:

o Offering: Help Desk

o Functional Area: Assignment and Routing

o Task: Manage Service Assignment Objects

The Manage Service Assignment Objects page appears.

2. Add the queue attributes you want to be available when setting up your rules:

a.
b.
C.

d.

Click HR Help Desk Request Queue or Internal Service Queue.

In the Details region, click the Attributes subtab.

Add attributes to the list by clicking the Add icon, and select View Object Attribute from the drop-down
list.

Click Save.

3. Add the help desk request attributes you want to be available when setting up your rules:

a.
b.
C.

d.

Click HR Help Desk Request or Internal Service Request.

In the Details region, click the Attributes subtab.

Add attributes to the list by clicking the Add icon, and select View Object Attribute from the drop-down
list.

Click Save.

Manage Help Desk Assignment Rules

In this procedure you define the rules for assignment.

When assigning work items to queues, follow these guidelines when defining your matching rules:

- The rule set must be defined with Number of Candidates = 1. The application allows only one queue to be
assigned to a help desk request.

- You have the option to select or deselect the Use Score option on a rule set. If you select Use Score, then for
every rule in the rule set, you must indicate the amount to increase the score when the rule is true. You must
then associate the rule set to queues that receive that score. All of the rules in a rule set are executed, and the
queue with the highest total score is selected.

If the rule set has multiple rules and you didn't select the Use Score option, you must define the criteria
for each rule to be mutually exclusive from other rules in the rule set. This ensures that the resulting queue
assigned by the application is predictable in all situations.

To manage Help Desk request assignment rules:

1. Inthe Setup and Maintenance work area, go to the following:

o Offering: Help Desk

o Functional Area: Assignment and Routing
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10.

o Task: Manage Service Assignment Rules

On the Manage Service Assignment Rules page, select the category HR Help Desk Request Queuing Rules
or Internal Service Request Queuing Rules.

Create a new rule set by clicking the Add icon in the Rule Sets work area, and then enter the required
information.

Create rules for the rule set by clicking the Add icon in the Rules work area.

The Create Rule screen appears.

Enter a name for the rule in the Name field.

From the Rule Applies If drop-down list, select Any conditions met.

Add a condition by clicking the Add icon in the Conditions work area, and then define the required attribute.

For HR Help Desk:

o Select either the HR Help Desk Queue, HR Help Desk Request, or HR Help Desk Request Primary
Employee Contact object and the available employee attributes are displayed in the attribute drop-down
list.

For Internal Help Desk:

o Select either the Internal Service Queue, Internal Service Request or Internal Service Request
Primary Employee Contact.

If an attribute is hierarchical, such as Category Name and Product Group, Not In Including Children and In
Including Children operators are displayed as choices. They indicate the following.

o Not In Including Children: Indicates that the rule applies if the specified attribute value matches the
top level of the attribute. This option doesn't include the attribute values of the children of the current
attribute. For example, if the condition is set for the Category Name attribute with value Benefit
Enrollment, the rule applies only if the value of the top-level attribute matches Benefit Enrollment.

o InIncluding Children: Indicates that the rule applies if an attribute value matches with any of the
attributes in the parent-child hierarchy of the current attribute. For example, if the condition is set for the
Category Name attribute with value Benefit Enrollment, the rule applies even if the value of any of the
child attributes matches Benefit Enroliment.

Optionally, add more conditions.

Select a queue to which the requests meeting the conditions must be assigned by clicking the Add icon in the
Action Assign Queue work area.

Click Save and Publish.

The request assignment is now defined.

Note: Republish the assignment rules each time the rule is changed. You also must republish the rules each
time the associated queue is deleted, enabled, or disabled.

How do | manage help desk request categories and
product usage groups?

Help Desk request categories can help identify the nature of issues reported in help desk requests.

84

ORACLE



Oracle Fusion Cloud Applications Chapter 1
Help Desk: Questions and Answers Questions and Answers

For example, categories can help group requests related to General HR in one category, and requests related to Benefits
in another category. Further, categories and child categories can be created to narrow the type of request within one of
the ordered groupings.

Administrators can create categories and category hierarchies to group and organize requests depending on their
organizational needs. Before creating categories, do the following:

- Create a list of your top-level categories.
For each top-level category, create a list of child categories.

To create help desk request categories, follow these steps in Setup and Maintenance:

- Offering: Help Desk
Functional Area: Help Desk Request
- Task: Manage Categories for Internal Help Desk Requests or Manage Categories for HR Help Desk Requests

Create a top-level category:

1. Inthe Create Category list, select Create Top-Level Category.

2. Enter a name in the Category Name field.

3. Specify if the category must be active, by selecting a value in the Active drop-down list.
4. Enter a unique Category Code for the category.

Note: Category code must be unique across all Business Units and Application stripe.

5. Create additional top-level categories, as needed.
Create child categories:

1. Inthe Categories list, select the top-level category for which you want to create child categories.
2. Inthe Create Category list, select Create Child Category.
3. Enter a name in the Category Name field.
4. Enter a unique Category Code. It must be unique across all business units and application stripes.
5. Specify if the category must be active, by selecting a value from the Active list.

The Business Unit Name column displays the BU associated with the top-level category.
6. Create additional child categories, as needed.

The child categories appear indented under the top-level category.

Note: You can set the BU only for the top-level category. The BU on the child categories is automatically set
based on the BU of the root category.

Product Usage Groups

Similar to categories, products can also help narrow down service request issues in Help Desk. For example, products
can be Payroll Application or Benefits Application. To set up products, use the Manage Product Group Usage setup task
in the Setup and Maintenance work area and add products for the Help Desk category.

How do | set up a role with read-only access?

Here's how you set up a role with read-only access to the help desk request header alone, or both the help desk request
header and messages:
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Note: These steps use the HR Service Request Management duty role and Next Gen Human Resource Help Desk
Agent job role as examples. You can copy any of the Help Desk job and duty role combinations to create a read-only
version of that role. For example, Internal Service Request Management duty role and Internal Help Desk Agent
job role

-—
.

Sign into the application as an administrator.
Navigate to Security Console.
3. Copy a Help Desk duty role, such as HR Service Request Management .

When copying the role, select the Copy Top Role option.
Remove the Edit HR Service Request privilege or Edit Internal Service Request privilege.
Copy a Help Desk job role, such as Next Gen Human Resource Help Desk Agent.

When copying the role, select the Copy Top Role option.

Delete the HR Service Request Management child role from the copied job role.

Associate the copied job role with the users who need read-only access to the header alone, or both the header
and messages. Ensure that the users don't have other roles that assign them the Edit HR Service Request or
Edit Internal Service Request privilege.

v oA N

N©o

What happens when a customer sends an HR Help Desk
email?

If an employee sends an email, then the email ID in the From field is validated against the employee record in the
database.

If a match is found, and the email is for a new request, then a new HR Help Desk request is created. If the email is
regarding an existing HR Help Desk request, then the email content is added as a message to the relevant request.

If a match to the email ID isn't found in the database, then the following applies:

« The value for the SVC_EMAIL_PROCESS_UNKNOWN_CUST profile option is selected. This option specifies how
to process an incoming email from unknown customers.

If the SVC_EMAIL_PROCESS_UNKNOWN_CUST profile option is set to Y, a new HR Help Desk request is
created. However, a message is sent to customers indicating that they can't be identified and must provide valid
information for further processing of the request.

If the SVC_EMAIL_PROCESS_UNKNOWN_CUST profile option is set to N, no HR Help Desk request is created.

Note: All the recipients of the incoming email, including the unknown contacts are listed in the Messages tab.

How do | enable the ability to add all contacts and team
members or add additional email recipients?

Sometimes while composing an email, an employee might want to add extra email recipients who aren't contacts or
resources.
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For these options to be available to them, you must enable the SVC_ENABLE_ADDITIONAL_EMAIL_RECIPIENTS profile
option. The default value of this profile option is No.

To enable the SVC_ENABLE_ADDITIONAL_EMAIL_RECIPIENTS profile option:

®

NOURAWNA

Sign in as a setup user or administrator.

Navigate to the Setup and Maintenance work area.

Open the Tasks panel tab and click Search.

Search for and select the Manage Administrator Profile Values task.

On the Manage Administrator Profile Values page, navigate to the Search region.

In the Profile Option Code field, type svc_ENABLE ADDITIONAL EMAIL RECIPIENTS.

Click Search.

The SVC_ENABLE_ADDITIONAL_EMAIL_RECIPIENTS profile option is displayed in the Search Results: Profile
Options region.

In the Profile Option Levels region, set the Profile Value for the Site Profile Level as Yes.
Click Save.

How do | set up a Slack channel?

You can integrate your application with Slack in two ways. Depending on your company's requirement, you must follow
the steps listed in one of the following sections:

- Set Up a Slack Channel: Method 1: If you plan to use only the predefined slash commands and you don't plan to

change existing commands or create your own commands in Slack.

- Set Up a Slack Channel: Method 2: If you plan to create your own slash commands in Slack.

o See: How do I set up a Slack channel: Method 2?

How do | make a field read only or required?

This task shows you how to set properties on a dynamic form to make its fields read only or conditional. For this
example, we'll use the Create Help Desk Request layout.

Note: Required and Read Only are only available if a field in a layout isn't associated with a template.

First duplicate the default form if necessary, or choose your own layout, and then do the following:

1.

A WN

Select the layout.

The layout is displayed with the fields shown.

Note the Read Only and the Required check boxes in the Form properties area.
To make the field read only, simply click the Read Only checkbox.

To make the field required, just click the Required checkbox.

To make a field conditionally required, do the following:
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a. Hover over, and then click the Expression Editor.
b. Select a variable from the drop-down list.
c. To edit the conditions of the variable, hover over then, select the Expression Editor.
d. Inthe Expression Editor, expand the fields variable list.
e. Expand the SeverityCd variable and drag value on to the editor workspace as shown in the following

example:

Expression Editor

f. Add the following value to the expression: === 'ora_svc_sevi' .
g. Click Save.

Now the field only displays when is reached

What are the profile options for Help Desk?

Administrators and setup users manage help desk profile options and schedule job processes from the Setup and
Maintenance work area.

Some of the profile options must be used along with job processes to achieve the results you want. For example, after
setting the profile value for closing a resolved request after N number of days, schedule a job process that closes
requests.

To enable the profile options, follow these steps in Setup and Maintenance:

- Offering: Help Desk
Functional Area: Help Desk Request

- Task: Manage Profile Options for Internal Help Desk Requests or Manage Profile Options for HR Help Desk
Requests

The following table describes the various profile options for internal help desk requests:
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Internal Help Desk Profile Option

SVC_ISR_IN_RESOLVED_DAYS

SVC_ISR_IN_WAITING_DAYS

SVC__ISR_AUTO_CLOSED_STATUS_CD

SVC_ISR_AUTO_RESOLVED_STATUS_CD

SVC_ISR_DEFAULT_SEVERITY_CD

SVC_ISR_DEFAULT_STATUS_CD

SVC_ISR_IN_DELETED_DAYS

SVC_ISR_PROD_CATALOG_USAGE

ORA_SVC_DELETE_CLOSED_ISR_
ENABLED

ORA_SVC_CLOSED_ISR_RETENTION_
DAYS

ORACLE
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Description

Defines the number of days after which any resolved request is automatically closed. This profile
option must be used along with the Auto-Close Help Desk Requests job process.

Make sure the following two conditions are met:

- The SVC_ISR_IN_RESOLVED_DAYS profile value must be set to 1 or greater for the Auto-Close
Internal Help Desk Service Request job to run.

« The SVC_ISR_IN_RESOLVED_DAYS profile value must be set to O to disable the Auto-Close
Internal Help Desk Service Request job.

Defines number of days for which a help desk request must be in Waiting status before the request is
auto resolved. This profile option must be used along with the Auto-Close Internal Help Desk Service
Request job process. For more information, see Scheduled Processes for SR Management.

Make sure the following two conditions are met:

- The SVC_ISR_IN_WAITING_DAYS profile value must be set to 1 or greater for the Auto-Close
Internal Help Desk Service Request job to run.

- The SVC_ISR_IN_WAITING_DAYS profile value must be set to O to disable the Auto-Close Internal
Help Desk Service Request job.

Defines the status code to use for auto-closing requests that have been in Resolved status for at least
the number of days specified by SVC_ISR_IN_RESOLVED_DAYS. This profile option must be used along
with the Auto-Close Internal Help Desk Service Requests job process.

Defines the status code to use for auto-resolving requests that have been in Waiting status for at least
the number of days specified by SVC_ISR_IN_WAITING_DAYS. This profile option must be used along
with the Auto-Close Internal Help Desk Service Request job process.

Sets the default Severity value for a new request.

Sets the default Status code for a new request.

Defines the number of days after which a deleted request is purged. Although a soft deleted request is
in the database, it can't be retrieved or updated from the Ul or REST APIs. Once purged, requests are
completely removed from the database. This profile option must be used along with the Purge Deleted
Internal Help Desk Service Requests job process to purge requests.

When a soft-deleted request created from an inbound email is purged, all data associated with that
request is also purged from the inbound message tables.

Internal Help Desk Request Product catalog usage.

Set value to INTERNALSERVICE.

Enables automatic deletion of a request that has been closed for at least the number of days specified
by the ORA_SVC_CLOSED_ISR_RETENTION_DAYS profile option. This profile option must be used
along with the Delete Closed Help Desk Requests job process.

Defines the number of days for which a request must remain closed before it's deleted. Deletion can be
undone. This action is applicable only when the Delete Closed Service Requests Enabled profile option
is set to Yes. This profile option must be used along with the Delete Closed Help Desk Requests job
process.
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Description

The following table describes the various profile options for HR help desk requests:

HR Help Desk Profile Option

SVC_HRHD_IN_RESOLVED_DAYS

SVC_HRHD_IN_WAITING_DAYS

SVC_HRHD_AUTO_CLOSED_STATUS_CD

SVC_HRHD_AUTO_RESOLVED_STATUS_
CD

SVC_HRHD_DEFAULT_SEVERITY_CD

SVC_HRHD_DEFAULT_STATUS_CD

SVC_HRHD_IN_DELETED_DAYS

ORA_SVC_DELETE_CLOSED_HRHD_
ENABLED

ORACLE

Description

Defines the number of days after which any resolved request is automatically closed. This profile
option must be used along with the Auto-Close HR Help Desk Service Requests job process.

Make sure the following two conditions are met:

- The SVC_HRHD_IN_RESOLVED_DAYS profile value must be set to 1 or greater for the Auto-Close
HR Help Desk Service Requests job to run.

- The SVC_ISR_IN_RESOLVED_DAYS profile value must be set to O to disable the Auto-Close HR
Help Desk Service Requests job.

Defines number of days for which a HR Help Desk request must be in Waiting status before the request
is auto resolved. This profile option must be used along with the Auto-Close HR Help Desk Service
Requests job process.

Make sure the following two conditions are met:

« The SVC_HRHD_IN_WAITING_DAYS profile value must be set to 1 or greater for the Auto-Close HR
Help Desk Service Requests job to run.

- The SVC_HRHD_IN_WAITING_DAYS profile value must be set to O to disable the HR Help Desk
Auto-Close Service Requests job.

Defines the status code to use for auto-closing requests that have been in Resolved status for at least
the number of days specified by SVC_HRHD_IN_RESOLVED_DAYS. This profile option must be used
along with the Auto-Close HR Help Desk Service Requests job process.

Defines the status code to use for auto-resolving requests that have been in Waiting status for at least
the number of days specified by SVC_HRHD_IN_WAITING_DAYS. This profile option must be used
along with the Auto-Close HR Help Desk Service Requests job process.

Sets the default Severity value for a new request.

Sets the default Status code for a new request.

Defines the number of days after which a deleted request is purged. Although a soft deleted request is
in the database, it can't be retrieved or updated from the Ul or REST APIs. Once purged, requests are
completely removed from the database. This profile option must be used along with the Purge Deleted
HR Help Desk Service Requests job process.

When a soft-deleted request created from an inbound email is purged, all data associated with that

request is also purged from the inbound message tables.

Enables automatic deletion of a request that has been closed for at least the number of days specified
by the ORA_SVC_CLOSED_HRHD_RETENTION_DAYS profile option. This profile option must be used
along with the Delete Closed Help Desk Requests job process.
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ORA_SVC_CLOSED_HRHD_RETENTION_
DAYS
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Description

Defines the number of days for which a request must remain closed before it's deleted. Deletion can be
undone. This action is applicable only when the Delete Closed Service Requests Enabled profile option
is set to Yes. This profile option must be used along with the Delete Closed Help Desk Requests job
process.

The following table describes the various profile options that are shared between Help Desk and B2B Service:

Profile Options Shared with B2B Service

SVC_ENABLE_AUDIT_IN_SR

SVC_ASSIGN_TO_QUEUE_ON_CREATE

SVC_PUID_FORMAT

SVC_INBOUND_ENABLE_FAILED_
MESSAGE_PURGE

SVC_ATTACHMENT_UI

SVC_EVENT_HISTORY_DAYS_TO_KEEP

SVC_INBOUND_MSG_RETENTION_DAYS

ORACLE

Description

Enables or disables auditing of field value changes.

Assigns a Help Desk request to a queue automatically when the request is created.

Note:
The preferred way of assigning to a queue is by using Omnichannel assignment. If Omnichannel is
enabled, this profile option is ignored.

Defines the format for the unique reference number on each Help Desk request.

For example, every Help Desk request number consists of a prefix and radix. Let's say that you select
HRHD _ as the prefix and No alphanumeric conversion as the radix. Without this formatting profile
option, the Help Desk request numbers are generated as HRHD_1, HRHD_2, and so on. Now suppose
you use this formatting profile option and the value is 000000. Then the Help Desk request numbers
are generated as HRHD_000001, HRHD_000002, and so on.

For more information about configuring the prefix and radix, see "Configure the Prefix and Radix for
Help Desk Requests."

Enables or disables purging of inbound messages that fail or aren't processed successfully. When
the value is set to Yes, the purge job deletes the records corresponding to such messages from the
inbound message tables.

Defines the attachment view for a Help Desk request. There are thee types of attachment options you
can provide:

- Classic: Enables users to select the type of attachment, category, and enter the name and
description for each attachment.

- Basic: Enables users to only select file type, browse and upload attachments to the Help Desk
request.

- Advanced: Enables users to select the type of attachment, category, and enter the name and
description for each attachment. You can also upload files with the drag-and-drop feature, or
extract all files after they're uploaded.

Specifies the number of days for which the Help Desk request event history details such as update and
create must be retained. The data beyond this value is purged.

Specifies the number of retention days for successfully processed inbound messages. After the
specified number of retention days, the successfully processed inbound messages are deleted from
the inbound message tables.
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SVC_ENABLE_MESSAGE_CORRECTION

SVC_ENABLE_RESOLVE_SR

ORA_SVC_DELETE_CLOSED_SR_
ENABLED

ORA_SVC_CLOSED_SR_RETENTION_DAYS

Chapter 1
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Description

Enables you to edit the text of the Internal Note and Employee Entry Help Desk request messages that
you have previously created and posted.

Enables the ready-to-use workflow for resolving a request. This profile option is disabled by default.
When enabled, the Resolve Help Desk Request action on the Action Bar opens a dialog box that
captures the outcome and resolution, and enables you to enter resolution notes.

Note:
If this profile option isn't enabled, you can still manually set the Help Desk request status to
Resolved.

Enables automatic deletion of a request that has been closed for at least the number of days specified
by the ORA_SVC_CLOSED_ISR_RETENTION_DAYS profile option. This profile option must be used
along with the Delete Closed Help Desk Requests job process.

Defines the number of days for which a request must remain closed before it's deleted. Deletion can be
undone. This action is applicable only when the Delete Closed Service Requests Enabled profile option
is set to Yes. This profile option must be used along with the Delete Closed Help Desk Requests job
process.

How do | manage scheduled processes for help desk

requests?

You can set various profile options and schedule job processes for help desk request management.

You must use some of the profile options along with the job processes to achieve the results you want. For example,
when you set the profile value for closing a resolved request after N number of days, you should also schedule a job
process that closes requests. Run scheduled processes to manipulate a set of records for a specific business need, or to
get printable output with information about certain records. Some processes do both. For example, to import records

and provide a report about them.

Here's a table that describes the job processes you can schedule to manage help desk requests.

Job Process Name

Auto-Close Internal Help Desk Service
Requests

Auto-Close HR Help Desk Service
Requests

ORACLE

Description

Closes requests that were resolved a certain number of days ago, and resolves requests that have been
in waiting status for a certain number of days. The number of days for both the scenarios is set using
the SVC_ISR_IN_RESOLVED_DAYS, SVC_ISR_IN_WAITING_DAYS profile options respectively.

Closes requests that were resolved a certain number of days ago, and resolves requests that have been
in waiting status for a certain number of days. The number of days for both the scenarios is set using
the SVC_HRHD_IN_RESOLVED_DAYS, SVC_HRHD_IN_WAITING_DAYS profile options respectively.
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Job Process Name

Delete Closed HR Help Desk Requests

Delete Closed Internal Service Requests

Purge Deleted Internal Help Desk Service

Requests

Purge Deleted HR Help Desk Service
Requests

Purge Inbound Messages

Load and Update Cloud Metrics for Service

Service Request Queue Assignment

ORACLE

Chapter 1

Questions and Answers

Description

Deletes closed HR Help Desk Requests which have been closed for at least a number of days specified

by the ORA_SVC_CLOSED_HRHD_RETENTION_DAYS profile option.

Deletes closed Internal Service Requests which have been closed for at least a number of days
specified by the ORA_SVC_CLOSED_ISR_RETENTION_DAYS profile option.

Purges requests and their child records that were deleted a certain number of days ago. The number of

days is set using the SVC_ISR_IN_DELETED_DAYS profile option.

Purges requests and their child records that were deleted a certain number of days ago. The number of

days is set using the SVC_HRHD_IN_DELETED_DAYS profile option.

Purges the successfully processed messages from the inbound message database tables, based on the

retention days specified in the SVC_INBOUND_MSG_RETENTION_DAYS profile option.

If the SVC_INBOUND_ENABLE_FAILED_MESSAGE_PURGE profile option to set to Yes, this job also

purges inbound messages that failed or weren't processed successfully.

This job and the corresponding profile options are shared with Fusion Service.

Performs incremental loading and updating of usage and business metrics that are targeted to cloud

usage patterns.

Assigns queues to requests. This job takes the following parameters:

Work Object Code: Indicates business objects that get assigned to agents, such as, help desk
requests.

Expected Value: ORA_HRHD_Service_Request_Work_Object or ORA_ISR_Service_Request_Work_
Object

Candidate Object Code: Indicates objects that are the possible pool of assignment candidates,
such as queues.

Expected Value: ORA_HRHD_Queue_Candidate_Object or ORA_ISR_Queue_Candidate_Object

Assignment Mode (List of Values: Classification, Matching, Scoring, Territory): Indicates the type
of assignment processing. Matching is the only mode that's supported.

View Criteria Name: Indicates the view criteria used to identify the requests to be assigned.

Expected Value: OpenSRsUnassignedToQueueHRHD

Bind Variable: Indicates the bind variables required for the view criteria.

Expected Value: bindStripeCd=ORA SVC_HRHD Or bindStripeCd=ORA_SVC_ISR

Metrics Logging Interval (default value is 100): Indicates the number of work objects in a
subprocess before logging assignment metrics, such as update metrics after processing 100
requests. This is used if your object support Enterprise logging for assignment.

Diagnostic Mode (check box): Indicates if the process must be run in diagnostic mode to view the
details of assignment processing in an output log.
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Job Process Name

Service Configuration Setup

Aggregate Service Requests

Monitor Service Request Milestones

Purge Service Event History

Monitor Action Plan Actions

Execute Incremental Load of Cross-
Channel Interaction Data for Reporting

Execute Full Load of Cross-Channel
Interaction Data for Reporting

Refresh Service Categories for Reporting

ORACLE
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Description

Note:
This job is shared with Fusion Service but should be set up with a separate parameter for Help Desk.

If OMNI is enabled, there isn't a need to run a batch Assignment job. You can add rule condition and
assign that rule to Queue Assignment.

Schedules service setup jobs, such as metrics. This job must be run once during implementation.
Ensure that you run this job before you create requests.

Enables querying request data for reporting, using the CRM - CRM Service Request Summary subject
area. The recommended frequency for running this job is one hour.

Note:
If you need faster data refreshes, increase the frequency. However, this impacts the performance of
the transaction system.

This job is shared with Fusion Service.

Ensures that the request and milestone status are up-to-date and sends an email notification if
compliance issues or warning flags are found.

This job is shared with Fusion Service.

Evaluates the processed records and retains the data for the days specified in the profile option SVC_
EVENT_HISTORY_DAYS_TO_KEEP, while it purges the rest. The recommended frequency for running
this job is daily.

This job is shared with Fusion Service.

Evaluates the status of an action plan.

This job is shared with Fusion Service.

Incrementally loads cross-channel interaction data, for reporting using the CRM - CRM Interaction
Aggregate subject area. You must run this job daily to load and update the new data everyday.

This job is shared with Fusion Service.

Fully loads cross-channel interaction data, or refreshes the data based on a particular date, for
reporting using the CRM - CRM Interaction Aggregate subject area. This is an on-demand job. You
must run this job in the following scenarios:

- The first time data is loaded.

- Any time the data needs to be refreshed from a specific date.

This job is shared with Fusion Service.

Generates the service category hierarchy and stores it in the SVC_CATEGORIES_CF table in a flattened
form for ease of reporting. Service category attributes in all service request subject areas obtain

data from this table. This process needs to be scheduled to pick up changes to the service category
hierarchies to ensure accurate reporting. The recommended frequency for running this job is 1 hour.
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Job Process Name Description
This job is shared with Fusion Service.

Migrate Service Business Unit Data Migrates the following business objects from one business unit (BU) to another:

- Category
« Channel
- Milestone Configuration

- Service Request
This job is shared with Fusion Service.

Execute Incremental Load of SR Audit Data Incrementally loads request audit data added since the previous run of the process. Use this job to
for Reporting create business intelligence reports using the Service - CRM Service Request Lifecycle subject area.
The recommended frequency for running this job is hourly.

This job is shared with Fusion Service.
Unlock Scheduled Process that Removes the process lock created by the Execute Incremental Load of SR Audit Data for Reporting
Incrementally Loads SR Audit data scheduled process, when that process fails to remove its lock automatically.

This process should be run only if the Execute Incremental Load of SR Audit Data for Reporting
scheduled process is unable to start, and no other instance of that process is currently running.

This job is shared with Fusion Service.

What happens when an employee sends a help desk
email?

If an employee sends an email, then the email ID in the From field is validated against the employee record in the
database. If a match is found, and the email is for a new help desk request, then a new request is created.

If a match to the email ID isn't found in the database, then the following applies:

- The value for the SVC_EMAIL_PROCESS_UNKNOWN_CUST profile option is selected. This option specifies how
to process an incoming email from unknown employees.

- If the SVC_EMAIL_PROCESS_UNKNOWN_CUST profile option is set to Y, a new request is created. However, a
message is sent to the employee indicating that they can't be identified and must provide valid information for
further processing of the request.

- If the SVC_EMAIL_PROCESS_UNKNOWN_CUST profile option is set to N, no request is created.

Note: All the recipients of the incoming email, including the unknown contacts are listed in the Messages tab.
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What are the job and duty roles for Help Desk?

Many security roles are predefined in the Help Desk and HR Help Desk offerings. Here's a list of the job and duty roles
for Internal Help Desk and HR Help Desk with descriptions.

The following table lists the Internal Help Desk and HR Help Desk job roles.

Job Role

Internal Help Desk Administrator

Next Gen Human Resources Help Desk
Administrator

Internal Help Desk Agent

Next Gen Human Resources Help Desk
Agent

Internal Help Desk Manager

Next Gen Human Resources Help Desk
Manager

Internal Help Desk User

Next Gen Human Resources Help Desk
User

Description

Manages setup and configuration.

Creates requests on behalf of employees and manages requests.

Manages a group of Agents (as defined in the Resource Hierarchy) or is responsible for reviewing and

analyzing help desk metrics.

Requests support to resolve their questions and issues.

The following table lists the duty roles specific to the Help Desk offering.

Duty Role

Internal Service Request Administration

HR Service Request Administration

Internal Service Request Analysis

HR Help Desk Analysis

Internal Service Request Creation

HR Service Request Creation

Internal Service Request Management

HR Service Request Management

ORACLE

Description

Manage all aspects of help desk requests. In addition, can manage queues and administer the help
desk service application, including setup.

Manages group of agents. Can view requests, activities, and attachments. Monitors metrics and overall
resource balancing, critical requests, SLAs.

Requests support to resolve their related questions and issues.

Manages all aspects of the request object.
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Duty Role Description

What roles does the Help Desk product support?

Help Desk supports questions and requests for internal employees, contingent workers, and nonworkers. It can be used
for any type of support, such as Human Resources, Maintenance Requests, ERP, Sales, or Facilities.

Note: Pending workers are not able to open help desk requests.

There are two stripe codes associated with Help Desk in the Redwood experience. Human Resources requests have their
own stripe code, HRHD, to provide an added layer of security and separate sensitive Human Resources data from other
types of requests. All other types of requests use the stripe code ISR for Internal Service Requests, which is used for any
support for employees other than Human Resources.

Think of Internal Requests as any type of support for your employees, other than Human Resources.

Help Desk is a separate offering in Setup and Maintenance and has employee and agent flows that you can configure by
the type of support you're implementing. After enabling the offering, most HR Help Desk and Internal Service Requests
features are enabled and setup separately.

Help Desk has built-in capabilities for a self-service employee's My Help page to search knowledge, view existing help
desk requests, or create new requests. In addition, agents working on requests manage their work through a request
list page that includes assignment and routing, milestones, action plans, knowledge search, messaging with the request
owners, and collaboration across the enterprise.

How do | create a saved search?

All users can create their own personal saved searches. Service administrators can also share these saved searches with
the rest of the organization or with certain roles.

Here's how you create a saved search:

1. Navigate to a list page and select a saved search as your starting point. Remember that existing saved searches
might already include filters.

2. Inthe Search bar, add your filters. See the topic "Filter Your List" for details.

3. Add or change the columns displayed in the search results and the default search order by clicking theActions
icon.

4. Click Actions > Save.

5. Enter a name for your saved search in the Save dialog box. Saved searches are listed in alphabetic order.

6. Click Save.

Your new saved search is now listed in the Manage Saved Searches page.
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How do | make my saved search the default search?

Here's how you can manage the saved searches you created including making your saved search the default search.

Note:

- You can't edit or delete the saved searches provided by Oracle or your administrator.

- The results of all saved searches are displayed as a list.

- The star icon indicates the default saved search which can be changed to another saved search using Actions.

owm

Click in the Search bar and select Manage Saved Searches.

If Manage Saved Searches isn't in your list, you can start typing in the command "Manage" and it will appear for
you to select.

My Open HR Help Desk Requests
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The Manage Saved Searches page is displayed. The lists are displayed in alphabetic order.

(Administrators only) Use the Visible To drop-down list to filter the list of saved searches displayed on the
page.
Click Actions > Edit to change any of the saved searches you created. You can:

o Rename the saved search.
o Choose to share this saved search with only yourself, everyone, and (if you've the required permissions)
you can share it with specific roles.
Click the drop-down list and select Delete to delete any of the saved searches you created.

To exit the Manage Saved Searches page, click the back button on your browser.

Click Save after your changes are done.

Click Actions > Set as Default to set the saved search as the default saved search.

Click Actions > Hide from List to hide the saved search from being displayed on the list page.

To bring it back, go to the Manage Saved Searches page, click Actions > Show in List .
Click Actions > Delete to delete any of the saved searches you created.
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9. Click Done.

What are the roles for Help Desk?

Provision the roles to enable access to Help Desk. These roles include:

Internal Help Desk

Internal Help Desk Administrator
Internal Help Desk Agent
Internal Help Desk Manager
Internal Help Desk User
HR Help Desk
Next Gen Human Resources Help Desk Administrator
Next Gen Human Resources Help Desk Agent
Next Gen Human Resources Help Desk Manager
Next Gen Human Resources Help Desk User

Both HR Help Desk and Internal Help Desk

Knowledge Analyst
Knowledge Manager

Employee

Note: Help Desk Users that own help desk requests (for example, agents and managers) must be set up as
Resources. The happens during the creation of an Employee record in the New Person Ul. Once you save the new
employee record with a selected Resource Role, a TCA party is created for the resource. A new resource then shows
up in the Resource Directory, which may or may not be associated with a Resource Organization. From the Resource
Directory, you can put the resource into the correct Resource Organization at the correct level. This resource hierarchy
setup is required for team reporting to roll up to a manager. Also, for manager visibility of Help Desk requests that the
agents on their team are working on. If a person is an administrator for both Internal Help Desk and Next Gen Human
Resources Help Desk, two different accounts should be used for these.

How do | resolve a request?

Here's how you can resolve a help desk request.

You can use rich-text to create SmartText entries in request message fields by enabling HTML. Other fields, such as
Problem Description and Solution Description only support plain text.

1. Open the Help Desk Request Overview page for the service request you want to resolve.
2. Inthe Action Bar, enter Resolve.

You can also enter synonyms such as Close or Complete.
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3. Select Resolve Service Request from the list of suggested actions.
The Resolve Service Request panel is displayed.

Note: The values in the drop-down lists in the Resolve Service Request panel are configured by your
administrator. The following steps are an example of the resolve flow based on the ready-to-use data
provided in the application. You need to select the appropriate values for the service request.

From the Status drop-down list, select Resolved.

Select an Outcome.

Select a Resolution.

In the Solution Description field, enter the details explaining about the solution of the problem.

NOo uh

You can insert SmartText by typing # to display a list of plain SmartText entries, and type-ahead to
progressively search and filter this list.
8. C(lick Resolve.

What are the analytics roles in Help Desk?

The Help Desk analyses are visible for the Next Gen Human Resource Help Desk Agent, Next Gen Human Resource Help
Desk Manager, Next Gen Human Resource Help Desk Agent, Internal Help Desk Agent, Internal Help Desk Manager, and
Internal Help Desk Administrator job roles.

Analyses and the underlying data is secured through a set of delivered OTBI transaction analysis duty roles. These duty
roles are assigned to the help desk agents, managers, and administrators and determine what analyses can be accessed
by each. These OTBI transaction analysis duty roles control the subject areas and analyses a user can access. These
roles also control the data that the signed in user can see in the analyses. This aligns with the data security privileges for
the user in the transaction system.

The administrator defines which users, application roles, and catalog groups have the following privileges:

- Receive the delivery content of an agent.

- Have permission to access a section or alert section in a dashboard.
- Have permission to use a saved modification.

- Have permission to add or edit an existing catalog group.

- Assign permissions to a catalog object.

Here's a table that shows the job and duty role mapping required for a user to access the Service analyses:

Infolet Name Job Role Bl Duty Role

Help Desk Requests Pending My Actions - Internal Help Desk Agent « Internal Help Desk Agent Transaction

Analysis Dut
Internal Help Desk Administrator nalysis Duty

Internal Help Desk Administrator

Next Gen Human Resource Help Desk Transaction Analysis Duty

Administrator
Next Gen HR Help Desk Administrator

Next Gen Human Resource Help Desk Transaction Analysis Duty

Agent
Next Gen HR Help Desk Agent Transaction
Analysis Duty
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Infolet Name

Help Desk Requests Pending Worker Action

My Resolve Time

Critical Help Desk Requests

Unassigned Help Desk Requests by Queue

My Team Average Time to Resolve Closed SRs

ORACLE

Job Role

- Internal Help Desk Agent
- Internal Help Desk Administrator

« Next Gen Human Resource Help Desk
Administrator

- Next Gen Human Resource Help Desk
Agent

- Internal Help Desk Agent
- Internal Help Desk Administrator

» Next Gen Human Resource Help Desk
Administrator

- Next Gen Human Resource Help Desk
Agent

- Internal Help Desk Manager
- Internal Help Desk Administrator

» Next Gen Human Resource Help Desk
Manager

- Next Gen Human Resource Help Desk
Administrator

- Internal Help Desk Manager
- Internal Help Desk Administrator

« Next Gen Human Resource Help Desk
Manager

- Next Gen Human Resource Help Desk
Administrator

- Internal Help Desk Manager
- Internal Help Desk Administrator

« Next Gen Human Resource Help Desk
Manager

- Next Gen Human Resource Help Desk
Administrator
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Questions and Answers

Bl Duty Role

Internal Help Desk Agent Transaction
Analysis Duty

Internal Help Desk Administrator
Transaction Analysis Duty

Next Gen HR Help Desk Administrator
Transaction Analysis Duty

Next Gen HR Help Desk Agent Transaction
Analysis Duty

Internal Help Desk Agent Transaction
Analysis Duty

Internal Help Desk Administrator
Transaction Analysis Duty

Next Gen HR Help Desk Administrator
Transaction Analysis Duty

Next Gen HR Help Desk Agent Transaction
Analysis Duty

Internal Help Desk Manager Transaction
Analysis Duty

Internal Help Desk Administrator
Transaction Analysis Duty

Next Gen HR Help Desk Manager
Transaction Analysis Duty

Next Gen HR Help Desk Administrator
Transaction Analysis Duty

Internal Help Desk Manager Transaction
Analysis Duty

Internal Help Desk Administrator
Transaction Analysis Duty

Next Gen HR Help Desk Manager
Transaction Analysis Duty

Next Gen HR Help Desk Administrator
Transaction Analysis Duty

Internal Help Desk Manager Transaction
Analysis Duty

Internal Help Desk Administrator
Transaction Analysis Duty

Next Gen HR Help Desk Manager
Transaction Analysis Duty

Next Gen HR Help Desk Administrator
Transaction Analysis Duty
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Related Topics

What subject areas are available in Help Desk Analytics?

Creating analyses begins with subject areas. A subject area is a functional grouping of the contextual entities (also
called dimensions) by which the metrics (also called facts) can be analyzed. Subject areas are the building blocks of
analytic content in OTBI.

For example, the columns in a tabular report showing the number of open SRs (metric or fact) by Agent Name (context
or dimension) are sourced from one of the subject areas. Multiple subject areas can be joined to produce reports, when
cross functional analysis is needed.

The Help Desk application comes with various standard subject areas for you to select from when you're building or
editing your analytics.

HR Help Desk Subject Areas
Help Desk - HR Service Requests Real Time
Help Desk - HR Service Request Messages Real Time
Help Desk - HR Service Request Lifecycle
. CRM/Help Desk - Omnichannel Events Real Time
- CRM/Help Desk - Inbound Messages Real Time

Internal Help Desk Subject Areas
Help Desk - Internal Service Requests Real Time
Help Desk - Internal Service Request Messages Real Time
Help Desk - Internal Service Request Lifecycle
Help Desk - Internal Help Desk Request Milestones Real Time
- CRM/Help Desk - Omnichannel Events Real Time
« CRM/Help Desk - Inbound Messages Real Time

For more Help Desk analytics resources, see: Where do | find more information about and resources for Help Desk
analytics?

How do | associate assets and work orders to Help Desk
work requests?

Help Desk Requests can be used as work requests to report facility and asset-related maintenance issues. The requests
can be associated with an asset and ultimately a work order for resolution.

The requests contain information about the nature of the discrepancy, asset (if known), and a description of the
problem. Work Requests are sorted and then assigned for resolution using maintenance work orders.
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Create the Enable Work Request Profile Option

Before you enable work requests, you must create the work request profile option.

In Setup and Maintenance go to the following:

NOoOUuhAWNA

8.
9.
10.

Click the Tasks icon.

Click the Search link.

Enter Manage Profile Options in the Search field.

Click the Search icon.

Click the Manage Profile Options link.

On the Manage Profile Options page, in the Search Results region click the Add icon.
On the Create Profile Option page, enter the following:

o Profile Option Code: SVC_NG_ENABLE_MAINTENANCE_HELPDESK
o Profile Display Name: SVC_NG_ENABLE_MAINTENANCE_HELPDESK
o Application: Service

o Module: Service

o Description: Add a description

o Start Date: Add a Start Date

o End Date: Add an End Date if applicable.

Click Save and Close.
Click Save and Close on the Manage Profile Options page.
Click Done.

Setup and Enable the Work Request Profile Option

To enable this functionality you must license and enable the Help Desk offering for Internal Service Requests.
Additionally, you must set the profile option you just created to expose Asset and Work Order details in the pages.

ooV hWUNRA
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10.

Click the Tasks icon.

Click the Search link.

Enter Manage Administrator Profile Values in the Search field.
Click the Search icon.

Click the Manage Profile Options link.

On the Manage Administrator Profile Values page, enter the Profile Option Code:
SVC_NG_ENABLE_MAINTENANCE_HELPDESK

Click Search.

In the Profile Values region, set the Profile Value for Site to Y.
Click Save and Close.

Click Done.
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What's a sample groovy script for a notification for when
a help desk request is assigned?

Here's a sample code to trigger a notification to be sent to the recipient specified in the Notification Preferences page
when the help desk request is assigned:

Note: This sample script uses the object HR Help Desk Request. Change the object to Internal Service Request if
you're using this script for Internal Service Requests.

/* DISCLAIMER: This trigger is provided only as a reference.

* TRIGGER TYPE: Before Update in Database

* OBJECT: HR Help Desk Request

* Use Case: Send a notification when an existing SR is reassigned.

* Note: You can override the Notification Text and Recipients using the Notification Preferences page.

*/

if (isAttributeChanged('AssigneeResourcelId')) {

try {

def recipientPartyId = AssigneeResourceld

def messageText = 'An SR notification (default message).'

if (recipientPartyId) {
//Call to send notification
adf.util.sendNotification (adf, messageText, recipientPartyId)

//Log a confirmation that the notification has been sent. Logs can be viewed in 'Runtime Messages'.
//println("Notification sent to " + recipientPartyId + " because the SR was assigned to them.")

} else {

println("No Assignee associated with this SR")

}

} catch (e) {

//Log the failure in groovy logging. Logs can be viewed in 'Runtime Messages'.

println("Failure to trigger notification from Groovy Script " + e.getMessage()):;
// Throwing validation exception will show the message on the UI. This is not recommended for published
sandboxes.
// The following code is one of many to illustrate identifying an error in trigger from the UI.
// Replace <triggerName> with the trigger name you specified when creating this trigger.
// throw new oracle.jbo.ValidationException('Failure to trigger <triggerName> Notification from Groovy
Script: ' + e.getMessage())

}
}

How can | add fields to the Help Desk request UI?

Your application is built using Oracle Visual Builder Studio and Oracle JET components. Visual Builder Studio is a single
place where organizations can manage projects, environment and repositories; a Visual Builder Designer is where you
can extend your application. From VB Studio, you can open many different designers.

Visual Builder Studio is the browser-based tool that your organization can use to make modifications and extensions
to the Redwood user interface. Using the extension framework, you can change the user interface such as displaying
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custom fields on forms, creating dynamic layouts for a form, or embedding custom content in a dynamic container in a
page.
Your VB Studio instance is paired with your Test instance of Fusion Applications. This means that your design time

experience will be based on data in the Test instance database and a sandbox in the Test instance (if you're working
within a sandbox).

The changes you make using VB Studio are stored in an artifact called an application extension. An application
extension can be something as simple as a field added to a cloned, custom, or new form, or a new container of forms.
You can create extensions, then preview them to see how they look in your Ul. To create a extension that impacts the
data model, you must use a sandbox within Application Composer, then use the Edit Pages in Visual Builder option to
expose your changes in the UL

You navigate to the VB Studio Designer directly from within the Redwood application. VB Studio is a design at runtime
tool, which allows you make Ul changes and then immediately preview the results before publishing the changes to
other users.

VB Studio is just one tool that administrators can use to make application changes. As mentioned before, you extend
the underlying object model used by the Redwood application with Application Composer. The model changes you
make in Application Composer are reflected in the RESTful API for those objects, and thereby become available to the
VB Studio Designer for use in Ul extensions.

What high-level steps do | need to do for creating Help
Desk users?

At a high level, here are the steps you need to follow to create users and resources for Help Desk:

Define and Create Setup Users

Create Help Desk Users with Next Gen Human Resource Help Desk User or Internal Help Desk user roles
Set up Resource Users for Agents and Managers

Set up Resource Team and Resource Hierarchy

Synchronize Worker Data

i UWN

What's Case Management?

Case Management provides the ability to manage long running processes to meet an organization's needs managing
escalations, investigations, problems, applications, and other complex issues.

For example, a case can be created when a help desk complaint requires a formal grievance or disciplinary action
process. In this way cases allow an organization to address issues that stretch over a long periods of time, require
complex business processes for successful completion, or have outcomes that can be difficult to predict or measure.

For a detailed video presentations, see Case Management for Employee Relations and Investigations (HR Help Desk) on
Cloud Customer Connect. (Sign in is required)
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How do | manage Digital Assistant for Help Desk?

You can configure Next Generation Help Desk as a skill in Digital Assistant, which makes it available to Help Desk users
in multiple supported channels such as SMS, Slack, and messenger applications.

End users benefit from Digital Assistant's artificial intelligence-driven conversational engagement while creating,
searching, and updating Help Desk requests.

The Help Desk delivered skill is 'Helpdesk' and it includes three intents; Create Request, Get Request and Search
Knowledge. The Create Request intent prompts users for information such as request description, category, attachment
and asset (for non-HR help desk requests). The Get Request intent includes both searching for and updating a help
desk request. When a user enters a phrase, digital assistant checks whether that phrase matches a Help Desk intent. For
example, these user phrases match the create help desk request:

- Create ticket
- Create a help desk request
- Create request

Note: If a user gives an intent of Create Request and has privileges for both HR Help Desk and Internal Help Desk, the
user will be prompted to decide which type of request should be created.

Help Desk skills are integrated with Knowledge skills. Starting a flow with a knowledge search can move into the create
service request skill and then will pass the category from the last reviewed knowledge article.

Digital assistant uses its training data to extend matching to similar phrases over time. You can also extend digital
assistant skills to meet specific business requirements. Learn more about skills and extending skills in the Digital
Assistant guide.

Related Topics
 Oracle Fusion Cloud Applications Getting Started with Oracle Digital Assistant for Fusion Applications

How do | configure Visual Builder Studio for Help Desk?

This topic explains the Next Generation Help Desk delivered page layouts for configuration with Visual Builder Studio.

Note: Oracle recommends having only one active extension at a time, and that extension should contain all the
changes you've made. Independent extensions aren't synced, so having two actively deployed extensions can result in
one overriding changes in the other. Having one extension also gives you a complete view of all the changes that have
been made to date.
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My Help

My Help is a landing page that contains one dynamic container with three sections:

Popular Articles
Help Desk Request List
-+ Quick Links (hidden section for adding quick links for commonly asked questions)

Help Desk Request Create Page

The Help Desk Request Create page contains one dynamic container with two sections:

Help Desk Request header (dynamic form to add, remove, reformat, and conditionally render format)
- Attachments

Help Desk Request Summary

The Help Desk Request Summary contains one dynamic container:

Left Hand Panel Spotlight (dynamic form to add, remove, reformat, and conditionally render format)

Help Desk Request Full Edit Page

The Help Desk Request Full Edit page has one dynamic container with multiple sections:

Help Desk Request header (dynamic form to add, remove, reformat and conditionally render format).
- Contacts, Teams, and Maintenance Work Orders (dynamic tables to add and remove fields)
- The dynamic container is extendable and can be used to do two things.
o Rearrange the existing content.
o Add your own components to the display, as long as certain conditions are met at runtime.

For more information, see the Extending Oracle Cloud Applications with Visual Builder Studio guide link at the
end of this topic.

Action Plan

Action Plan is a dynamic form on the Help Desk Request Summary page.

Related Topics

How do | use Adaptive Search for Help Desk?

Adaptive Search is a high-performance search engine that provides keyword searching and enhanced filtering
capabilities. Adaptive search is used on the Help Desk Request List pages. To enable Adaptive Search for Help Desk,
complete the following procedure:
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1. Inthe Setup and Maintenance work area, open the Configure Adaptive Search task:
o Offering: Sales

o Functional Area: Sales Foundation
o Task: Configure Adaptive Search

2. Onthe Configure Adaptive Search page, click the Setup tab.
3. On the Setup tab, Quick subtab, select the objects you want to enable for Adaptive Search:
o HR Help Desk Request

o Internal Service Request
o Help Desk Contact

4. C(lick Publish.
Your action runs an indexing process and an hourly index refresh for the objects you selected. You can monitor
the progress of the indexing process on the Monitor tab. The process can take several minutes to complete,
depending on your data volume.

5. Click the Monitor tab and Publish subtab to monitor the process. If the process completes with errors, contact
your help desk.

What's a sample Groovy script for when a Help Desk
request is resolved?

Here's a sample code to trigger a notification to be sent to the recipient specified in the Notification Preferences page
when the Help Desk request is resolved:

Note: You must set the SVC_ENABLE_RESOLVE_SR profile option for the request resolved Groovy script to work
correctly. This sample script uses the object HR Help Desk Request. Change the object to Internal Service Request if
you're using this script for Internal Service Requests.

/* DISCLAIMER: This trigger is provided only as a reference.

* TRIGGER TYPE: Before Update in Database

* OBJECT: HR Help Desk Request

* Use Case: Send a notification to the primary contact when an SR has been resolved.

* Note: You can override the Notification Text and Recipients using the Notification Preferences page.

if (isAttributeChanged('StatusCd')&& StatusCd == 'ORA_SVC_HRHD RESOLVED') {
try {

def recipientPartylId = PrimaryContactPartyId

def messageText = 'An SR notification (default message).'

if (recipientPartyId) {
//Call to send notification
adf.util.sendNotification(adf, messageText, recipientPartyId)

//Log a confirmation that the notification has been sent. Logs can be viewed in 'Runtime Messages'.
//println("Notification sent to " + recipientPartyId + " because the SR was resolved.")

} else {

println("No Assignee associated with this SR")

}

} catch (e) {
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//Log the failure in groovy logging. Logs can be viewed in 'Runtime Messages'.
println("Failure to trigger notification from Groovy Script " + e.getMessage()):;

// Throwing validation exception will show the message on the UI. This is not recommended for published

sandboxes.

// The following code is one of many to illustrate identifying an error in trigger from the UI.
// Replace <triggerName> with the trigger name you specified when creating this trigger.

// throw new oracle.jbo.ValidationException('Failure to trigger <triggerName> Notification from Groovy

Script: ' + e.getMessage())

}
}

What dynamic forms can | extend in Help Desk?

The Help Desk Ul is highly extensible. This topic gives you an overview of what layouts in the Help Desk Ul then you can

extend using Visual Builder Studio.

The following two tables list many of the dynamic forms that you can configure, and many of the dynamic tables, used
for help desk requests, that you can extend.

HR Help Desk Requests Dynamic Forms

Dynamic Form

Copy HRHD Agent Flow
Copy HRHD Employee Flow
Create HRHD Agent Flow
Create HRHD Emp Flow
Edit HRHD Agent Flow
Edit HRHD Emp Flow
HRHD Detail Agent Flow
HRHD Detail Emp Flow
Milestone Edit

SR Resolve Form

Description

Copy HR Request Form - Agent flow

Copy HR Request Form - Employee flow

Create HR Request Form - Agent flow

Create HR Request Form - Employee flow

Edit HR Request Form - Agent flow

Edit HR Request Form - Employee flow

HR Request Overview - Agent flow (Left hand panel / Spot light region)

HR Request Overview - Employee flow (Left hand panel / Spot light region)
Milestone Edit Form

SR Resolve Form - Agent

HR Help Desk Request Dynamic Tables

Dynamic Table

Copy Contacts

HRHD Contacts EditMode Layout

Copy Team Member

ORACLE

Description

Used in Copy Request
Used in HR Request Edit Page

Used in Copy Request
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Dynamic Table Description
HRHD Team EditMode Layout Used in HR Request Edit Page
Display Milestones Used in HR Request Edit Page
Display Milestones RHP Used in HR Request Overview Page

Internal Service Requests Dynamic Forms

Dynamic Form Description

Copy ISR Agent Flow Copy Internal Request Form - Agent flow

Copy ISR Employee Flow Copy Internal Request Form - Employee flow

Create ISR Agent Flow Create Internal Request Form - Agent flow

Create ISR Employee Flow Create Internal Request Form - Employee flow

Edit ISR Agent Flow Edit Internal Request Form - Agent flow

Edit ISR Employee Flow Edit Internal Request Form - Employee flow

SR Detail Agent Flow Internal Request Overview - Agent flow (Left hand panel / Spot light region)
SR Detail Employee Flow Internal Request Overview - Employee flow (Left hand panel / Spot light region)
Milestone Edit Milestone Edit Form

SR Resolve Form SR Resolve Form - Agent

WorkOrder Work Order Create Form

Internal Service Request Dynamic Tables

Dynamic Table Description

Contacts Edit ModeLayout Used in Copy Request

Copy Contact Used in HR Request Edit Page
Copy Team Members Used in Copy Request

Team EditMode Layout Used in HR Request Edit Page
Display Milestones Used in HR Request Edit Page
Display Milestones RHP Used in HR Request Overview Page
Work Order List Used in HR Request Edit Page

Let's first look at the New Help Desk Request layout:
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New Help Desk Request

A, - - .. WY N - -7 7 T B, . "

Subject
Primary Point of Contact
- o
Matt Hooper ‘ ‘ . Queue
Assigned To - Category
Critical
Channel Type -

Detailed Description

Category
Miscellaneous

Drag and Drop

Select or drop files here.
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Now lets look at the different extensible layouts from the Help Desk page.

¢ My Open HR Help Desk Requests

New Request

Request Mumber

HRHDOOO0006058

Primary Point of Contact

M Matt Hooper
sendmail-test-discardi@oracle.com

Status
New

Severity
Low

Queue

AutoQueusHRHD

Contacts (1)

M Matt Hooper
sendmail-test-discard@oracle.com

[F] Messages(0) [E] Conversations

Channel Web
Subject
Font - | Size - A- Q-

Now, to view Help Desk Request details layouts, you click the Edit button in the Summary field as shown in the following

graphic:

ORACLE
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New Request

Reqguest Mumber

HRHDOOQO006058
Prirnary Point of Contact
M Matt Hooper
sendmail-test-discardi@oracle.com
Status
Mew

Severity
Low

Queue

AutoQueueHRHD

Contacts (1)

M Matt Hooper
sendmail-test-discard@oracle.com
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Jenbe 1 New Request
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Summary

Attachments

Category
Miscellaneous

Drag and Drop

Select or drop files here.

Contacts

Primary Name ¢ Job Title ¢ Phone 2 En
® Matt Hooper se

Team

Assigned To Name < Email <

Mo data to display.

Milestones
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How do | control the display of channels used only for
internal conversations?

You can disable the channels that you don't want to be displayed in the application when an agent composes a response
message or captures a customer message.

P UWNa

Sign in to Service Center as a setup user or administrator.

In the Setup and Maintenance work area, go to the Tasks panel tab.

Search for and click the Manage Service Request Channel Type Visibility task.

On the Manage Service Request Channel Type Visibility page, if you don't see the channels you want to disable,
click Sync on the toolbar of the table.

For any channel that you select, you see two rows with different values for Property Name:

o Enabled for Collaboration: To enable the selected channel to collaborate with internal users to resolve
customer issues, set the Property Value for this property name to Yes.

o Enabled for Customer Interaction: To enable using the selected channel for interaction of your service
agents with your customers, set the Property Value for this property name to Yes.

Note: You can also use the drop-down list in the toolbar for the Property Name field to filter the list by each
property name.

6. Setthe Property Value to No to disable the selected channel.

Note:
o For messages of type Customer Entry and Response:

- SMS and Slack channels are disabled by default because they aren't supported for
customer communications. You can enable or disable the other channels.

o Forinternal conversations, only the Email, Microsoft Teams, Slack, Web, and custom channel
types that you created are supported. You have the option to disable the channel types that you
want to hide when starting an internal conversation. For example, if you don't use Slack in your
organization, you can disable Slack for collaboration.

7. Click Save and Close.

The disabled channels aren't displayed when an agent composes a message.
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How do | define system-access-group-based data
security policies?

Let's say you're an HR Help Desk Administrator, Internal Help Desk Administrator or IT Security Manager. Then you can
use system access groups and predefined rules to support help desk request data security for your users.

Every standard job role provided by Oracle has a corresponding system access group. The predefined object-sharing
rules assigned to each system access group provide the same access to help desk request data as provided by the
standard job roles.

Note: System access groups provide you an alternative way to manage a user's access to help desk request data. You
can also create access extension rules to extend the access provided by the predefined rules to related objects.

System access groups are active by default. But the predefined object-sharing rules associated with each system access
group are inactive by default. So you must activate these rules before you can use them. The association between
system groups and predefined rules is also disabled by default. So for each system group, you must also enable the
predefined rules you want to apply to the group.

The following table lists the predefined object-sharing rules for system access groups along with their descriptions.

S. no. Predefined rule name This rule provides access to:

1 All Service Requests All service requests.

2 All CRM Service Requests Access to all CRM service requests.

3 CRM Business Unit Service Requests All CRM service requests associated with the

user's business units.

4 CRM Partner Service Requests All CRM partner service requests.

5 CRM Business Unit Partner Service Requests CRM partner service requests associated with
the user's business units.

6 CRM Service Request Queue Member All CRM service requests assigned to queues
that the user is a member.

7 CRM Service Request Queue Member Hierarchy All CRM service requests assigned to queues
that the user's subordinates are a member.

8 CRM Service Request Team All CRM service requests where the user is on
the SR team.
9 CRM Service Request Team Hierarchy All CRM service requests where the user's

subordinates are on the SR team.
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S. no.

10

n

12

13

14

15

16

17

18

19

20

21

22

23

24

25
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Predefined rule name

CRM Service Request Assignee

CRM Service Request Assignee Hierarchy

CRM Service Request Creator

CRM Service Request Creator Hierarchy

CRM Service Request Partner Account

CRM Service Request Contact

All HR Service Requests

HR Business Unit Service Requests

HR Service Request Queue Member

HR Service Request Queue Member Hierarchy

HR Service Request Team

HR Service Request Team Hierarchy

HR Service Request Creator

HR Service Request Primary Contact

HR Service Request Assignee

HR Service Request Assignee Hierarchy

Chapter 1
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This rule provides access to:

All CRM service requests where the user is the
assignee.

All CRM service requests where the user's
subordinates are the assignee.

All CRM service requests where the user
created the SRs.

All CRM service requests where the user's
subordinates created the SRs.

All service requests where the SR is associated
with the user's partner account.

All CRM service requests where the user is an
SR contact.

All HR service requests.

All HR service requests associated with the
user's business units.

All HR service requests assigned to queues that
the user is a member of.

All HR service requests assigned to queues that
the user's subordinates are a member of.

All HR service requests where the user is on the
SR team.

All HR service requests where the user's
subordinates are on the SR team.

All HR service requests where the user created
the SRs.

All HR service requests where the user is the SR
primary contact.

All HR service requests where the user is the
assignee.

All HR service requests where the user's
subordinates are the assignee.
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S. no. Predefined rule name This rule provides access to:

How do | define access group-based data security
policies?

As a Customer Relationship Management Application Administrator you can define access group-based data security
policies on help desk requests . Though predefined data security policies are available, you've the option to define more
data security policies based on access groups.

As compared to SQL-based data security policies, access groups are another way of granting data permissions to
users. Instead of creating security policies using SQL, you can use object-sharing rules in the sales and service access
management Ul to define your visibility criteria.

For more information about creating data security policies, see the Access Groups chapter in the Oracle Fusion:
Securing Sales and Service guide.

If you're replacing existing SQL-based data security policies with policies based on access groups, then remember to set
an end date for those policies.

How do | Set Up a Microsoft Teams Channel?

Using Microsoft Teams, your agents can collaborate with subject matter experts to resolve employee questions and
issues faster. Here's the sequence of steps that you must complete to set up the integration of your service application
with Microsoft Teams:

Note: Each of these steps is described in a separate topic, and you must complete them in the given order.

Step no. Name of topic

1 Create a Microsoft Teams App for Help Desk

2 Set Up a Bot User for Your Microsoft Teams App

3 Register Your Microsoft Teams App in the Azure Portal

4 Enable Collaboration With Microsoft Teams in FSM

5 Update FSM with Credentials of Your Microsoft Teams App
6 Create a Microsoft Teams Channel in Help Desk
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Name of topic

Enable Notifications to Microsoft Teams

Create a Collaboration Action

Create a Child Action for a Collaboration Action

Create a Child Action for the Reply to Help Desk Request Child Action

Configure the FND_IDP_PROXY_USER_WHITELIST Profile Option

Upload Your Microsoft Teams App

Install Your Microsoft Teams App and Add It to Your Team

How do | install the Microsoft Teams app and add it to

my team?

After you upload your Microsoft Teams app, you must install the app and add it to your team in Microsoft Teams. Here's

how:

1. In Microsoft Teams, go to the Apps tab and click More apps.

In the Built by your org region of the Apps page, you can see the Microsoft Teams app that you created for

Oracle Help Desk.

Note: If you've created multiple apps, you can see all them here.

2. Click the app that you want to install.
3. From the Open drop-down list, click Add to a team.

In the Type a team or channel name region, your channel is selected by default.
4. If you've created multiple apps, you can select the app of your choice by clicking the cross mark.

5. Click Set up a bot.

Your Microsoft Teams app is now installed for the team associated with the channel selected in step 3.
6. Navigate to Teams in the navigation bar.
7. Click the ellipsis next to your app name.

8. C(Click Manage teams.

A page with your team name is displayed.

9. Click the Apps tab.

ORACLE
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Your Microsoft Teams app is now displayed in the list of apps.

How do | collaborate with Slack?

Using Slack, your help desk agents can securely collaborate with subject matter experts to quickly resolve employee
questions and issues.

You can integrate your help desk application with Slack using two different methods. These methods are described in
detail in the Slack Channels chapter of the Oracle Fusion Service Implementing Service guide.

Note: The Send Additional SR Fields to Slack section isn't applicable for Help Desk. So you can ignore the following
topic in that section: Send Additional Fields When an SR Is Forwarded to Slack.

Related Topics
« Overview of Setting Up a Slack Channel for your Fusion Application

« How You Set Up a Slack Channel for Your Fusion Application: Method 2

How do | create an email channel for collaboration or
internal conversations?

Agents can have internal conversations on requests when you've set up a separate email channel for internal messages.
When the agent wants to start an internal message, they select the internal channel.
To create a separate email channel, create a new channel and set the Purpose field for the channel to Collaboration.

When starting the internal conversation, the agent must select the internal channel. For example
internal@mycompanydomain.com Replies appear in the conversation.

For external communications, agents still use the channel you created for the requests. For example
support@mycompanydomain.com Replies are captured as messages on the request.

Also see the topic: How do | configure email for Help Desk?

Where do | find more information about and resources
for Help Desk analytics?

Here's where you can find additional information on Fusion Sales, Service, and Help Desk analytics:

- Prebuilt Fusion Service analytics spreadsheet.

« Creating and Administering Analytics guide.
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- Subject Areas for Transactional Business Intelligence in Fusion Sales and Fusion Service guide.

« Security for Sales Analytics and Reports guide.

« Securing Sales and Fusion Service guide.

Oracle Transactional Business Intelligence guides.

- Fusion Service Report Sharing Center cloud customer connect.

- Analytics and Reporting Best Practices support resource center.

« R13.x CX OTBI Subject Area to Database Lineage Mapping Spreadsheet

- About Creating Your Own Subject Areas

What job roles do | grant to users for Help Desk?

Here's a list of job roles for employees and agents for Help Desk. When you've successfully enabled the interface for the
Redwood experience and granted access to users, the new icons for Help Desk appear on the Home Page.

HR Help Desk
Employee:

Next Gen Human Resources Help Desk User

Agent:
- Next Gen Human Resource Help Desk Agent

Next Gen Human Resource Help Desk Manager

Administrator:

Next Gen Human Resource Help Desk Administrator

Internal Help Desk
Employee:

Internal Help Desk User (Internal — non-HCM SRs)

Agent:
Internal Help Desk Agent

Internal Help Desk Manager

Administrator:

- Internal Help Desk Administrator

Once the access is granted and you've enabled the interface for the Redwood experience, new icons for Help Desk
appear on the Home Page.
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Good afternoon, Robert Jackman!

Related Topics
« What's a resource team?

- How do | manage resource teams?
» How do | synchronize worker data loaded through HDL in Help Desk?

Can | have the product and category auto-populate when
a help desk request is created from an inbound email?

Service Request (SR) Similarity enables an agent to troubleshoot issues accurately and efficiently, by finding similar SRs
that may have been previously resolved.

SR Similarity uses adaptive intelligence (Al) for similarity computation, by considering the key standard or custom fields
of an SR. The feature is seamlessly integrated within the SR review and edit workflow on the agent-facing user interface
(un.

The feature is currently applicable for English language implementations only.

Before deploying the feature, administrators and power users can test and evaluate similarity computation using the
Administrator Ul provided specifically for this purpose.

How do | restrict contact search results?

You can restrict the user's visibility of contacts in the contact picker based on HCM data security visibility.

By default, all contacts are displayed in the contact picker for the Human Resource Analyst. To restrict their visibility, use
the ORA_HELPDESK_CONTACT_DATASECURITY profile option. Here's how to enable that profile option:

1. Navigate to Setup and Maintenance.
2. C(lick the Tasks icon.
3. Click the Search link.
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4. Enter Manage Administrator Profile Values in the Search field.
5. Click Search.
6. Click the Manage Administrator Profile Values link.
7. Enter the Profile Option Code ORA_HELPDESK_CONTACT_DATASECURITY.
8. C(lick Search.
9. In the Profile Values section, change the default PublicPerson to Person. This limits results by HCM data
security. The default "PublicPerson" displays all contacts.
10. Click Save and Close.
11. Click Done.

How do | enable Elastic Search for the Help Desk object?

Elastic search is used for the Next Gen Help Desk request list and is enabled in the Sales Offering.

Enable Elastic Search

10.
1n
12
13.
14.
15.

16.
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Navigate to Setup and Maintenance.

Click the Tasks icon.

Click Search.

Enter the task name Configure Adaptive Search.

Click Search.

Click the Configure Adaptive Search task link.

On the Configure Adaptive Search page, select the Setup tab.

In the Service section, click the checkbox to enable either the HR Help Desk Request object, or the Internal
Service Request object.

From the Actions menu, select Publish.

Click both HR Help Desk Request and Case.

Click Proceed with Publish.

Click Publish.

Click OK on the warning message.

Select the Monitor tab.

Click Start Process to start the Elastic Search indexing.

Note: This job will continue to run in the background. It's initially very common for there to be errors. Start
the process again until you see a Wait status. As long as the job is running, you won't see REST API errors
from this search in Help Desk.

Verify that you see the job in WAIT status.

Enable Group By (Optional)

While you're in the Configure Adaptive Search task you might want to consider enabling Group By so your agents can
view requests by groupings on the List page. For example group by New requests. To enable Group By do the following:

1.
2,

If you're not already in the Configure Adaptive Search task from the previous procedure:
Navigate to Setup and Maintenance.

123

ORACLE



Oracle Fusion Cloud Applications Chapter 1
Help Desk: Questions and Answers Questions and Answers

Click the Tasks icon.
Click Search.
Enter the task name Configure Adaptive Search.
Click Search.
Click the Configure Adaptive Search task link.
On the Configure Adaptive Search page, select the Configure Ultab.
Enter either HR Help Desk Request or Internal Service Request in the Find Objectsfield.
10. Click the Search icon.
11. In the Enable for Group By column, select the fields you want to enable for grouping.
12. Click Save and Close.
13. Navigate to the Configure Adaptive Search task.
14. Click the Parameters tab.
15. If the Enable Group By parameter Current Value is N, then click Edit and changeitto Y.
16. If you've made a change, click Save then navigate back to the Configure Adaptive Search task.
17. Click the Setup tab.
18. From the Actions menu, select Full Publish.
19. Click Publish on the message.
20. Select the Monitor tab.
21. Click Start Process to start the Elastic Search indexing.

O w0V Oygoubhuw

Note: This job will continue to run in the background. It's initially very common for there to be errors. Start
the process again until you see a Wait status. As long as the job is running, you won't see REST API errors
from this search in Help Desk.

22. Verify that you see the job in WAIT status.

How do | set global locale for knowledge?

If you're using a single Global Knowledge Locale, you can set it globally so each user doesn't need to set it for
themselves.

To set the global language preference:

1. In Setup and Maintenance, go to:
o Offering: Help Desk

o Functional Area: Knowledge Management

o Task: Manage Knowledge Locales
2. Onthe Manage Locales page, select a locale from the Default Preferred Knowledge Locale drop-down list.
3. Set the Default Preferred Knowledge Locale.

The checked box indicates that the English-US locale is active, which means an author can create knowledge in
that locale.

Note: Use an account that's tied to an employee record in Core HR, as a Resource party-ID must be
associated with the user to manage knowledge locales.
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How do | hide quick actions from the home page?

You can change the Fusion application homepage to hide quick actions from view. Here's an example showing you how
to hide the Create Service Request quick action.

Here's how you do it:

1. Signin to your Fusion application an an administrator and go to Application Composer.
2. Click Navigator > Configuration > Sandboxes to create a new sandbox.

Note: Make sure you select the Structure tool and Application Composer from the All Tools list.

When finished, navigate to the Structure page (Navigator > Configuration > Structure.)
Click the node where you want to hide quick actions from, for example Service.

On the Edit Group page, click the Quick Actions tab.

Expand the Service Center Quick Links list.

In the Quick Actions list, click Create Service Request.

On the Edit Quick Action dialog box, click the Visible drop-down list and select No.

Click Save and Close and then view your home page to verify the result.

WO U AW

How do | add a custom field to the landing page for
Adaptive Search?

Use these instructions to add a custom column to the Help Desk or Fusion Service landing page for Adaptive Search.

Create a Custom Field or Confirm it's Published

In your application, click Navigator, then, Configuration, and then select Sandboxes.

Create a new sandbox and make Application Composer active.

Open Application Composer.

In the explorer, search for Service Request or Help Desk object based on your need.

Expand the selected object and click Fields.

Create a new custom field, or just make sure the field you want to add is there and published.

For more information on creating a custom field, see How do | create a custom field?

cCUupPUNS

Make the Field Searchable

In the Setup and Maintenance work area, make sure Setup: Service is selected.

Select the Productivity Rules row, then in the task list, select All Tasks from the Show menu.
Click the Configure Adaptive Search link.

In the explorer, choose Setup.

Click the Advanced tab.

Find the object and the field, and select the Enable check box.

cCUupUNDL
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Now the field will be indexed for adaptive search.
7. Click Save.
8. C(lick the Actions drop-down list and select Full Publish to retain the change.

Add the Field to the Ul

On the Configure Adaptive Search work area, click Configure Ul in the explorer.

Find the object you want to add a new column to the landing page

Find the field of that object that you want to add.

If the Display in Ul check box is isn't checked for that field, select it to the display the field in the landing page.
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5. Click Save and Close.

Expose the Field in the Ul Landing Page

For this example, we'll add the field to the My Open Service Requests area in Service Center.

1. Navigate to Service Center, and in the My Open Service Center page, click the Actions menu and select
Manage Columns.

2. Query for the custom field and select the check box.

Drag the field to where you want it to appear on the list page.

4. C(lick Save.

W
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Can | create a reminder notification for requests still
waiting for a response?

Here's a sample object workflow trigger condition that sends a reminder to an agent after a request is in Waiting status
for over seven days.

How to create the notification:

1. Create a new field called "AgentResponseDateTime_c" to capture the date and time when an agent responds to a

request.

W N

Create a new field called "WaitingReminderSent_c" to track whether or not a waiting reminder has been sent.
. Create a new field called "EmployeeResponseReceived_c" to track whether the employee responded with follow-up

comments after an agent has responded to the request.
4. Write a Groovy script for the status field with the following actions:

a.
b.

Capture the date and time in the "AgentResponseDateTime_c" field when an agent responds to a request.
Reset the "WaitingReminderSent_c" field to "N" as the timer for reminders is reset to zero when an agent
responds to a request.

If the employee has responded with follow-up comments, set the "EmployeeResponseReceived_c" field to
IIYII-

5. Create an Object Workflow to trigger waiting reminders.

Object Workflow Trigger Condition:

o

o

Object: HR Help Desk Request

Name: RequestWaitinglstReminderEmail

This sends first reminder email to requester when a request status is in waiting for over 7 days.
Active: Yes

Event Point: When a record is updated

Condition:

/" Added By: Your Name, Date

Purpose: Send reminder email when request status is set to Waiting */

if (isAttributeChanged('StatusCd') && StatusCd == 'ORA SVC_ HRHD WAITING' &&
WaitinglstReminderSent_c!= 'Y') {

return true

}

else {

return false

}

Object Workflow Schedule:

o

o

Groovy Script Name: RequestWaitinglstReminderEmail

Execution Schedule: 1 Days After AgentResponseDateTime_c

Note: The groovy script should contain the code with reminder email content and send reminder email when
employee hasn'’t put any follow-up notes and the status is Waiting. For example, EmployeeResponseReceived_c !=
'Y' && StatusCd == “ORA_SVC_HRHD_WAITING”
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How do | enable Audit History for Help Desk?

To enable Audit History for Help Desk do the following:

Go to Setup and Maintenance.

Click the Tasks icon.

Select Search.

Enter Manage Audit Policies in the search field and click Search.
Select the Manage Audit Policies task.

On the Oracle Fusion Applications line, change Audit Level to Auditing , then click Configure Business
Object Attribute.

Select Service from the Product drop-down list.

Select the items you want to audit.

Click Save.

10. From the Objects Actions menu, select Synchronize.

11. Click Save and Close.

A video for this feature is found on Oracle Video Hub.

CUuPUNDR
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How do | enable mass update for help desk requests?

You can enable the feature to mass update for select fields for help desk requests. Mass updates can be done for
either Internal Service Request or HR Help Desk Requests. Here's instructions on how to enable, who can enable, and

important considerations for using mass update.

Why use mass update?

Here are some examples where mass update can save time.

1. Reassign all open requests from an employee going on vacation to their backup.
2. Change the status of many requests at once.
3. Use to update commonly used fields.

Important Considerations

By default, there's a limit of 10 items that can be changed at once. To change this limit up to a value between 1
and 25 (inclusive), change the value of the parameter for Maximum Number of Records that can be Selected in
Configure Adaptive Search.

Mass update shouldn't be used for queue or product. (Even though these possibilities are shown).

Don't try mass updating help desk requests that span multiple Business Units for the item you're trying to
update, it won't work appropriately.

- The amount of time it takes to update the multiple requests is directly related to the number of requests
selected.

Mass update isn't available on smaller resolution devices like mobile phones.
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Access Requirements
All Help Desk administrators can enable Mass Update.

Once Mass Update is enabled, the feature is available to all Help Desk agents. This is controlled by the following
privileges:

- SVC_VIEW_AGENT_HR_HD_PRIV (HR Help Desk Agent)
« SVC_VIEW_AGENT_ISR_HD_PRIV (Internal Help Desk Agent)

Enable Mass Update

Enabling Mass Update is a one-time set up.

First, set the Configure Adaptive Search parameter Enable Mass Update to Y. To do this:

_‘—I
-
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Go to Setup and Maintenance.

Click the Tasks icon.

Enter Configure Adaptive Search in the search field.
Click Search.

Click the link for the Configure Adaptive Search task.
Click the Parameters tab.

Highlight the Enable Mass Update line.

Click Edit.

When prompted to continue, click Yes.

Change the valueto Y.

. Click Save and Close.

Now, configure the fields that can be mass updated.

5.

Click the link for Configure Adaptive Search.
Click the Configure Ul tab.

In the left panel, select either HR Help Desk Request or Internal Service Request, depending on which you want
to configure.

Check the Enable for Mass update boxes in all the columns for those fields that you want to make available for
mass updates.

Click Save and Close.

Finally, set a variable in Visual Builder Studio on the Agent's List Page:

oV hWUNRA

Navigate to the Agent's List Page (Help Desk Requests card in the Help Desk tab).
On the left-hand panel, expand the following options:

Click elastic-search-sr-list.

In the Variables tab, select enableMassUpdate.

On the right panel, change the Value to true.

Preview your changes before publishing.
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What are some common reasons why my Help Desk
requests aren't getting assigned?

If your requests aren't getting assigned to agents or queues, here are a couple common issues:

Make sure Adaptive Search (Elastic Search) is running.

Make sure your rules reflect an effective start date.

Related Topics
» How do | get started with Oracle MR - HR Help Desk?

Where can | get more information about routing and
queues for help desk?

This presentation given by our Technical Support team reviews the different methods of assigning Help Desk requests
to Help Desk agents and addresses best practices and logistics for configuring your Help Desk in the Redwood
Experience.

Find the presentation here: Routing and Queuing for HR Help Desk

Can | change what predefined Help Desk roles can do?

You can't change ready-to-use (or what's sometimes called "out-of-the-box") job roles. You can, however, make copy of
a role and edit it to meet your business objectives.

For example, let's say you want to make your existing agents have read-only access to certain types of requests.

If the privilege of Edit Service Request came from a ready-to-use employee role, create a new role and remove the
privilege of Edit Service Request. Then and attach your new role to your user and remove the old one.

Make sure you run the ESS jobs after making changes. Go to Navigator > Tools >Scheduled Processes and run the
following:

Send Pending LDAP request

Retrieve latest LDAP changes

Import User and Role Application Security Data
Synchronize Person Records

Sign out and sign in.

i UWN
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Can | use HCM Data Loader (HDL) or HCM Spreadsheet
Data Loader (HDSL) to convert requests to cases?

Help Desk and Case Management don't use HDL/HSDL, but they use something similar to it known as Import and
Export management.

You can find more information about Import and Export Management here.

Can | copy a Help Desk request and keep the
attachment?

Copying the attachment when you duplicate a request saves you from downloading and reattaching attachments.
You must have the correct privileges do this. If you can't duplicate a request and keep the attachment, contact your
administrator for the correct privilege.

To copy attachments when copying requests, agents should be assigned the privileges that allow viewing and adding
attachments:

- View Attachment (SVC_VIEW_ATTACHMENT)
- Add Attachment (SVC_ADD_ATTACHMENT)

Note: The copy attachment when copying help desk requests feature is only available with Help Desk in the Redwood
experience.

What's the maximum attachment size?

The profile option FND_FILE_UPLOAD_MAX_SIZE defines the maximum attachment size.

By default the profile option is set to 2 GB at site level. Oracle recommends, in the interest of performance, that you
upload smaller attachments.

Can | notify all members of a queue?

You can set up Help Desk to notify all members of a queue to receive of notifications. With this feature, everyone in
a queue can be notified that a new issue was routed to them. Here's how you enable the feature for queue member
notifications.

To enable this feature:
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Note: If your queues have many agents, defining a notification that's sent to all members, this feature might have
a slight impact on performance of the delivery of the notification. Oracle doesn't recommend using the notification
recipient option for queues with a large membership.

Navigate to Setup and Maintenance.
Click the Tasks icon to expand the options and click Search.
Enter the task name Manage Administrator Profile Values and click Search.
Click the Manage Administrator Profile Values task.
Search for the appropriate Profile Option Code:
o For HR Help Desk: ORA_ENABLE_QUEUE_MEMBER_HELPDESK_NOTIFICATIONS

o For Internal Service Request (ISR) Help Desk:
ORA_ENABLE_QUEUE_MEMBER_INTERNAL_SR_NOTIFICATIONS
6. On the Site Level line, update the value to Yes.
7. Click Save and Close.
8. C(lick Done.
Once you've enabled the appropriate profile option, you need to define and publish a notification trigger through a
sandbox in Application Composer.

MVAhWNA

For detailed instructions, see: How do | define notification triggers?
Now, after enabling the feature and defining the notification trigger:

1. From the Navigator menu, expand Tools and click Notification Preference Manager.
2. From the Object drop-down list, select either HR Help Desk Request or Internal Service Request as
appropriate.
3. Click the Add icon.
4. Complete all the required fields.
o Enabled: Yes

o OverrideFlag: Yes

o Triggering Event: The new notification trigger that you'd like to override to send to the entire queue's
resources.
o Notification Name and Description should give other administrators the understanding of what it does.

vl

For Recipients, click the Edit icon to edit the recipients.

6. To send notifications to all members of the queue, select the check box option for Bell Notifications or Email
Notifications as desired for the line All Queue Members.

Add the New SmartText to give an appropriate message.

Click Publish.

Click Save.

0 0N

Related Topics

Can | recall an email that was sent through Object
Workflow?

Currently there isn't a way to recall emails sent through Object Workflow.
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Can | default the business unit (BU) of the primary
contact?

You can set a default value for business unit (BU) for the Help Desk Request Primary Contact on the employee and
agent pages using VBS.

To do this, enable the enableEmployeeDefaultBU variable under heipdesk in VBS.

How do | enable the Group By drop-down for HR Help
Desk?

You can add the Group By drop-down to the Help Desk list page and choose what fields to appear in the drop-down.
Here's how:

1. Navigate to Setup and Maintenance
o Setup: Service

Search for and open the task Configure Adaptive Search.

Select Configure UL

Select HR Help Desk Request in Find Objects.

Check the Enable for Group By box for the fields you want to appear in the Group By drop-down list.
Click Save and Close.

U A WN

Note: Make sure Enable Group By is enabled in Parameters. To do this, while you're in the Configure Adaptive
Search task, click Parameters . Make sure the Current Value for Enable Group By is setto Y.

How do | set up tags to use with Help Desk requests?

Tags can be set up in Help Desk so that agents can select an existing tag or create a new tag to classify Help Desk
requests in whatever way is helpful.

The tags field appears on the Edit Details page for any agent Ul user with appropriate permissions.

Tags also appears as a link on the Help Desk request page. When clicked, the link opens the tags field at the top of the
page and allows tags to be edited or deleted from the request.

The Manage Tags (SVC_MANAGE_TAGS) privilege is required to use tags.
By default, this privilege is provided for the following duty roles:

HR Service Request Administration
Internal Service Request Administration
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Users with the Manage Tags privilege will automatically see the Tags field on the Agent UL. If you want individual agents
to view, add, and delete tags, you can create a custom role to include this privilege.
Here's a video showing how to configure Help Desk so that agents can associate a tag or tags to a help desk request.

Note: This is for release 24A. More tag-related functionality is expected in future releases.

Video Hub: Tagging Help Desk Requests

How long can a help desk request remain in the
application?

There's no limit for holding a request in the application. If you've not set any of the profile options or purge, the request
will remain in the application.

For more information about Help Desk profile options, see: What are the profile options for Help Desk?

How do | configure live chat for Help Desk?

For immediate help, employees can use the chat widget from the My Help page to request a live chat with an agent. In
the chat window, agents confirm the employee's identity and can view their request history. When done chatting, the
chat transcript is captured and shown on the employee interactions page. Here's how to set up live chat for Help Desk:

An employee starts the chat, by clicking the chat icon and filling in the relevant information.

For an agent to have a chat routed to them, they must set themselves as available to accept a chat. When the dialog box
appears, the agent must accept the chat.

Note: This feature includes a component that's only available through controlled availability. Please open an SR with
Technical Support to enable this feature.

Access Requirements
For Employees to have ability to chat with an agent, they should have the Help Desk User role.

Chat Agents must be given the privilege Use Chat Agent Features, which is given to the duty role Chat Agent by default.

Administrators who are first configuring Chat should have the Service Request Administrator job role (at least
temporarily while setting up the chat) and either the HR Service Request Administration or Internal Service Request
Administration role or a similar role having the Setup Service privilege.
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How to Enable Chat

Before you begin, be sure that your Chat Agents have the appropriate permissions as outlined in the Access
Requirements Section below.

There are several steps to configure chat:

1. Enable the ability to chat.

2. Configure the queuing and routing rules.
3. Configure chat in visual builder.

4. Validate screen pop rules.

Enable the Ability to Chat

1. Navigate to Setup and Maintenance.
o Setup: Service (Not Help Desk)

2. Click Change Feature Opt-In.
3. Select the Communication Channels row.
4. Inthe Features column, click the Edit icon.
5. Click the check boxes to enable both Digital Engagement Channels Service and Chat.
6. Click Done.
7. Click Done.
8. Now, select Help Desk from the Setup drop-down list.
9. C(lick the Tasks icon.
10. Click Search.
11. Search for Manage Service Assignment Objects.
12. Select the HR Help Desk Queue row with the code: ORA_HRHD_Queue_Candidate_Object
13. In the Manage Service Assignment Objects region, click the Attributes tab.
14. Look for Stripe Code (StripeCd). If it doesn't exist, create it.
15. Click Save and Close. If you've created the Stripe Code, click Save and Publish.
16. On the task Search page, enter Manage Administrator Profile Values in the search field and click Search.
17. Click the link to open the Manage Administrator Profile Values task.
18. Search for each profile code in the table below and set the value for each (if not already done).

Relevant Administrator Profile Values

Profile Code Value

ORA_SVC_MCA_GLOBAL_PRESENCE_ = Yes

ENABLED

SVC_HD_SHOW_AVAILABILITY N
SVC_ENABLE_OMNI Yes
SVC_ENABLE_CHAT Yes

SVC_CHAT_INLAYS_ACCESS_ENABLED Yes

ORA_SVC_ENABLE_DEC_WITH_ No
LIVEWINDOW
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Profile Code Value

SVC_CHAT_ANONYMOUS_ACCESS_ No*
ENABLED

Note: *Set Anonymous Access to No if chat is only used for Help Desk. If it's being used for other
applications, such as Service Center, then use the default for whatever value is required for the other
applications.

Configure the Queuing and Routing Rules

Create a new chat queue:

1.
2.

VOO ULhWw

On the navigator, go to Home > Help Desk > HR Help Desk Queues.
Click Create Queue and complete the required fields.
a. Check the box to make Activation Enabled.
b. Click the Automatic (Push) option for Distribution.
Click Save and Continue.
Click the Resources tab and add the desired agents as resources on the queue.
Click Save and Close.
On the HR Queues page, click the row containing the queue you just created.
Click the Capacities button.
Set the chat capacity for each agent resource to the desired value.
Click Save and Close.

Create the assignment rules:

VEWNA
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10.
1.
12
13.
14.
15.
16.

Navigate to Setup and Maintenance.
Click the Tasks icon.
Click Search.
Search for Manage Service Assignment Rules.
Select the Rule Set Category as appropriate:
a. For HRHD: HR Help Desk Generic Queuing Rules
b. For ISR: Internal Generic Queuing Rules
Click the Add icon to create a new rule set.
In the Rules section, click the Add icon to create a new rule for the rule set.
Complete the Rule Name, Description, and Effective Date.
Click the Add icon to add one or more conditions for the assignment. For example:
o Object = Any
o Attribute = Stripe Code
o Operator = Equals
o Value = ORA_SVC_HRHD (for HRHD) or ORA_SVC_ISR (for ISR)

In the Assign Help Desk Queue region, click the Add icon.

Select and add the queues to be assigned to the rule.

Click Apply.

Click Done.

When you've completed all rule assignments, click Save and Close.
Click Save and Publish.

Click Done.

136

ORACLE



Oracle Fusion Cloud Applications Chapter 1
Help Desk: Questions and Answers Questions and Answers

Configure Chat in Visual Builder Studio (VBS)

To enable Chat and make the chat icon appear in the MyHelp page:

From Navigator, go to Configuration > Visual Builder.

In VBS, navigate to Extensibility > App Uls > helpdesk.

Click the Variables tab.

Click the chatSetup variable and replace the JSON to set the enableChat variable.

PN

Here's an example that you can use. (Substitute TBD for the queue values in your environment):

{ "enableChat": true, "position": { "bottom": "1O0px", "right": "10px" }, "launchForm": [ { "name":
"serviceRequestNumber", "required": false, "relaunchValue": "keep"} , { "name": "subject", "required":
false, "relaunchValue": "clear" } , { "name": "stripeCode", "required": true, "relaunchValue":
"default", "options": [ { "value": "ORA_SVC HRHD", "text": "Personnel/Personal Issue (HRHD)" },

{ "value": "ORA_SVC_ISR", "text": "Business Issue (ISR)"} ] }, {"name": "queueld", "required": true,
"relaunchValue": "clear", "options": [ { "value": "TBD", "text": "Benefits" }, { "value": "TBD",
"text": "Complaint/Grievance" }, { "value": "TBD", "text": "Payroll" } ] } ], "wcfsCdnPath": "https://

ee.channels.ocs.oraclecloud.com/wcfs/23.10.0/wcfs-sdk.js"}
When calling chat, the following is set based on which type of Help Desk is enabled:

o ORA_HRHD - App Classification
o Stripe code: ORA_SVC_HRHD (for HR Help Desk) or ORA_SVC_ISR (for all other Help Desks)

Set Up Screen Pop Rules

Rules must be set up so that the screen pop will act appropriately based on the application and types of data known.
For example, if an HR Help Desk request number is provided, you might want to be taken directly to the request, while if
you know the person but not the exact help desk request, then you'll likely want to be taken to the Employee Summary

page.

Navigate to Setup and Maintenance.
Click the Tasks icon.
Click Search.
Search for Manage Screen Pop Configuration.
Create a Default Rule Set (if one doesn't already exist).
a. Application Classification = Human Resources Help Desk. (This is whether you're using Internal Help
Desk or HR Help Desk.)
b. Interface Type of Redwood.
6. For the Rules, you'll confirm that the following tokens are mapped to the Page to Pop, by default:
o HR Help Desk Request Number > VB Edit HR Help Desk Request

o Internal Help Desk Request Number > VB Edit Internal Help Desk Request

uvhWNRA

o Person Id > VB Edit Employee
o Contact Id > VB Edit Employee
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How do | implement chatbot for Help Desk?

If you're using Help Desk in the Redwood experience, you can implement the Help Desk Assistant chatbot to streamline
knowledge searches and new help desk requests. You can also update and close requests from the chat window.

Here are the steps to enable the Help Desk Assistant chatbot.
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Navigate tO ODA console > Development > Skills > Helpdesk .
Select the Extend option.
The two Knowledge Article intents disabled as a default. Only enable Search Knowledge Article.

Note:
o ‘Search Knowledge Articles’ intent uses:
- "versionedContentApi": "https://host:port/km/api/latest"
- "versionedSearchApi": "https://host:port/srt/api/latest"
o Search terms must be double quoted which will match against “Title”, “Article Code”,
“Description” (also known as content)

Export Intents.

Change those utterances with "hardcoded search term" that aren't relevant to your site query intent.

Replace them as per configuration data.

Navigate tO oDA Console > Development > Skills > Helpdesk > Settings: Configuration: Custom Parameters .
Configure contentTypeMap format for a brief summary to appear in the Chat window.

Note:
o If atypeisn't configured, the Bot response renders the Article Title coupling with simple text and
Open Link button.
o If the answer contains more than 100 lines, only the first three or four lines will render with See
Summary button followed by a View Full Article button.

o The content type in expression should be taken from the Reference Key of the content type. You
can find the reference key in Setup and Maintenance in the Manage Knowledge Content Types

task.
Sanity check your settings:
da.FARestEndPoint — correct environment pairing both at the skill and DA levels

HCM Knowledge - either disable/not exposed or delete from FADigitalAssistant whichever is applicable
da.FAEnableSingleSignOn and da.lsJWTEnabled - unique to respective skills
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How do | secure my help desk?

If you need help understanding the options and best practices for securing your help desk, this video presentation is a
great place to start.

The HCM Security for HR Help Desk presentation reviews different options and best practices for securing your Help
Desk.

Also see How do | get started with Help Desk? playbook.

How do | configure Slack or Microsoft Teams for Help
Desk?

Slack and Teams allows users to participate in threaded conversations using the native web, Ul, email, Slack, or
Microsoft Teams. This presentation is an in-depth look at the configuration:

The Configuring Slack or Teams for Help Desk presentation shows how to set up Slack or Teams to work with Help Desk.

How do | create an Internal Help Desk Request (ISR)
card?

When you implement or test a dual-role (HRHD and ISR) agents, you can't see both cards in Help Desk Requests if HR
Help Desk is enabled. So, for a single agent to act as both an HR Help Desk agent and an ISR Help Desk agent, you'll
need to create a new entry point.

The How to Create an Internal Help Desk (ISR) Card video shows how to change the structure and have entry points for
the Internal Help Desk for both the Navigator and Help Desk Springboard.

Can | limit actions provided to employees?

To prevent employees from prematurely closing help desk requests, Help Desk administrators can configure whether
employees are given the option to close or copy requests.

Here's how to limit what the employee can do:

1. Navigate to Configuration > Visual Builder.

2. Go to Oracle CX HelpDesk Ul Extension App > helpdesk > employee > service-request-detail.
3. Click the Variables tab.

4. C(lick enableActions.
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5. Choose the appropriate option from the drop-down list.
o AllActions: Both Close and Copy action is displayed

o CloseAction: Only Close action is displayed and Copy action is hidden.
o CopyAction: Only Copy action is displayed and the Close action is hidden.
o NoAction: The entire action bar is hidden.

6. Preview to make certain the change is working as expected.
7. Publish your changes.

Can | change the standard text in an email
acknowledgment that's appended to the email template?

If you've enabled an email acknowledgment and created an email template in Application Composer, the appended text
can't be completely removed because the Short Text field in the Message Properties is a required. However, it can be
shortened.

Here's how you can shorten the appended text:

Go to Setup and Maintenance.

Search for the task Manage Messages.

Enter SVC_EMAIL_ACK_FOR_KNOWN_CUST in the Message Name field.

Click Search.

In the search results, highlight the SVC_EMAIL_ACK_FOR_KNOWN_CUST row and click Edit.

You can make the User Details null and the text in the Short Text field can be updated as desired.
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How do | remove a resource user from the resource
directory?

You can End Date the resource, by adding a value in To Date field.

Using the role Next Gen Human Resource Help Desk Administrator, navigate to the resource directory. Search for the
resource name and click Edit and Change on the To Date field.

How do | enable Help Desk to use Intelligent Advisor?

You can integrate Help Desk with Intelligent Advisor to help make decisions on what information agents should collect
to update and close help desk requests. Agents access your Intelligent Advisor interviews through Smart Actions in the
Action Bar.
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The interview can provide step-by-step guidance to help make sure agents are following the defined process,
performing all the necessary tasks, and collecting all information before taking the next action like closing the request
or escalating it to a case.

Note: This feature requires a license for Oracle Intelligent Advisor. The Oracle Intelligent Advisor administrator and
Help Desk Administrator should work together to configure this feature.

Prerequisites

Before you can use Intelligent Advisor, you need to create an interview using Oracle Policy Modeler and deploy the
interview to your Oracle Intelligent Advisor hub. When you create the interview, make sure you note the URL of the
Intelligent Advisor Hub for your environment, and the name of the Interview that you'll be using for existing help desk
requests.

For more information, see Prerequisites for Adding an Interview to Fusion Interfaces and Add an Interview to Fusion Help
Desk.

Steps to Enable

After you Opt In to the feature, configure the Smart Action to use Intelligent Advisor in Help Desk.

1. On the Navigator, expand the Configuration Section and click Application Composer.
2. Go to the Smart Actions Page.
3. If you're not already in a sandbox:
a. Activate a sandbox by selecting the link in the warning at the start of the page.
b. Check the Application Composer tool.
Click Create Sandbox.
Give the sandbox a name and description
Click Create and Enter.
In Tools, choose Application Composer.
g. Navigate to the Smart Actions page.
4. Type Assess in the Search box and hit enter on your keyboard.
5. Highlight Assess Help Desk Request.

6. Click the Duplicate icon to create a Smart Action (You need to define it to use the Intelligent Advisor Hub and
Interview Name as noted in the introduction of this procedure.

7. Inthe Ul-Based Action Details section of the Smart Action Edit page, click the Edit icon.

8. C(lick the Edit icon for Deployment Name and enter the name of the Intelligent Advisor interview to be run by
this Smart Action.

=0 2 n

No full path is required.
9. C(lick the Edit icon for opasiteurL and enter the Intelligent Advisor URL for your environment.

No URL paths following the .com is required.
10. Click Continue.
11. Click Submit.
12. Follow all the steps above for each of the interviews you want to run from the Help Desk action bar.
13. Publish the sandbox.
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How do | integrate and assign HCM journeys from Help
Desk?

You can connect HCM Journeys to Help Desk so an agent can assign Journeys to the primary contact on a help desk
request. This allows employees to use the guidance of a Journey. Employees can also browse or search popular Journey
resources and start a journey that helps resolve an issue (if configured).

Enable Journeys

For Journeys to be enabled you'll need to:

- Categorize Journeys to be displayed in the Help Desk (optional)
Enable Journeys to be displayed on the My Help page.
- Add the Journey category using Visual Builder (optional)

Enable Journeys to be Displayed on the Employee My Help Page and
Categorize

Navigate to the My Help page in Help Desk.
Click your photo icon and go to options. Choose Edit Pages.
The page will open for Oracle CX HelpDesk Ul Extension App > helpdesk > employee.
In the Designer tab, click the default rule.
Change the name of the rule to Layout with Journeys.
In the Section region, click the add icon and add Assignable Journeys.
Click the Variables tab.
In the Constraints section, click IncludeJourneylnMyHelpPage and change the default value to true. This
enables Journeys to be viewed on the My Help page.

9. If you want Journeys to be considered when users are searching through the search bar, enable the constant

IncludeJourneylnMyHelpSearch by setting it to true.

10. To filter Journeys so the Journeys section in My Help is limited to a select category or categories, navigate to
the employee page (Oracle CX HelpDesk Ul Extension App > helpdesk > employee) and use the constant
JourneyCategoriesToDisplayForEmp with a list of comma separated values that match exactly the desired
categories associated with the journeys to be included.

XNOo VA WN

To Allow Agents to Assign a Journey in Smart Actions

1. Navigate to your existing sandbox or create a new sandbox session.

To create a sandbox:
a. Inthe Navigator, select Sandboxes.
b. Click Create Sandbox, with the following values:
- Name = nelppesk (Note: it's best practice to avoid using names with spaces)
- Publishable = Yes
c. Select the tool Application Composer.
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d. Click Create.
Navigate to the Application Composer by selecting it from the Tools drop-down list.
Click Smart Actions in the Common Setup on the left-hand panel.
Type Journey in the search bar and hit Enter on your keyboard.
In the Enabled column, change the value to Yes.
In the sandbox name drop-down list, select Publish.
If prompted, click Continue.
Click Done when publishing is completed.

NSV AWN

Note: Journeys are only seen on the My Help page by employees if the journeys can be assigned to the employee.
Employees can assign a Journey to themselves by clicking on the person-plus icon. Agents can assign a Journey by
typing Assign Journey in the Action Bar and choosing the Journey to be assigned.

For more information about integrating Journeys, see the Help Desk Journeys Integration (WN 24B) video on Oracle
Video Hub. The video shows the different ways that Help Desk can integrate with Journeys and how to set up the
configuration for both the employee Ul and for agents.

Access Requirements

To assign journeys to workers, Help Desk agents need the following duty role assigned to them:
Manage Journey By HR (ORA_PER_MANAGE_JOURNEY_BY_HR)

To view the global journey templates configured by the administrator, and assign the global journey template to
themselves, employee users need the following functional privileges assigned to them:

Explore Journeys (PER_EXPLORE_JOURNEYS)
- View Global Journeys (PER_VIEW_GLOBAL_JOURNEYS)

To view and act on journeys assigned to them, employee users need the following duty role assigned to them:
« Access Journey by Worker (ORA_PER_ACCESS_JOURNEY_BY_WORKER)

How do | change the default subject line in a help desk
request?

By default, if an agent doesn't include a subject title in a new service request, the first few characters of the SR message
is used as the subject. You can change this to default to the SR title by doing the following:

In your Fusion application, from the employee edit details page, select Edit Page in Visual Builder Studio.
In VB Studio, navigate to the variables section of the service-request-details-start page.
Add an event listener with the action: transientInternalServiceRequest.

Navigate to that action chain, then add a condition to verify whether the defaultMessagecomposesubject variable
is set.

5. If the variable isn't set, assign the defaultMessageComposesubject Value with sraoumber.

PUOUN
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Can | define which values | want to be copied when
copying a help desk request?

Yes, you can change what attributes are carried over when a help desk request is copied. Defining the values you want
copied is helpful when you want to remove Queue or AssignTo so the request is routed as a new help desk request. It
can also be used to set a value for a calculated field or any other changes that can be done through JavaScript.

Anyone with access to the Visual Builder Studio development workspace for Help Desk can make these changes.

To learn more about extending your application using Visual Builder, visit Oracle Help Center > your apps service area of
interest > Books > Configuration and Extension.

Note: Be cognizant of removing or changing fields that are required or have limited values within the APIs or
database rules, validation rules.

For a how-to video presentation showing how to configure this feature, see Removing Attributes from the Copy Function
on Video Hub.

To Change What Values are Copied:

From the Navigator, go to Configuration > Visual Builder.

Navigate to Oracle CX HelpDesk Ul Extension App > helpdesk > agent > service-request-copy-start.
Click the Variables tab.

Click enableBeforeUpdate.

Set the value enableBeforeUpdate to true.

Click the JavaScript tab.

Make the changes by adding a new PageModule function that returns the payload. For example, you can
define something like this:

SN N

var PageModule = function PageModule() {};
PageModule.prototype.removeQueue = function (payload) {
delete payload.Queueld;

delete payload.AssignTo;

return payload;

}

return PageModule;

o

Click the Action Chains tab.

9. Create an Action Chain.

a. Create a new action chain and provide a descriptive name such as changeCopyPayload.

b. Click the Diagram tab.

c. Add Call Function and give it the name of your function from the JavaScript (like, removeQueue).
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i. InInput Parameters, click Payload.
ii. Map the payload to the variable copyRequestPayload.
iii. Click Save.
d. Next add the action Assign Variables.
i. Give the step an ID or Name.
ii. Click Payload.

iii. Select the Target of copyRequestPayload, and set the expression to
$chain.results.changeCopyPayload or whatever name you chose for the Action Chain.

iv. Click Save.
e. Add a Return action.
i. Give the step an ID or Name.
ii. Set Outcome to success.
f. Click the Event Listeners tab.
i. Create a Custom Event Listener for beforeCopy.
ii. Add the Action Chain.
iii. Go to the Action Chain.
10. Click the Event Listeners tab.
a. Create a Custom Event Listener for beforeCopy.
b. Add the Action Chain.
c. Go to the Action Chain.
11. Preview to make sure the change works as expected.
12. Publish your changes.

How do | configure personalized signatures for help desk
agents?
Your agents can create a personal rich text signature that's automatically inserted at the end of a help desk request

email message. Agents can manage their own signatures and add images such as a company logo.

Agents who've used SmartText in the past as a way to define their signature might see a performance improvement
using this method to create their signature.

You must be an administrator to configure the profile option that enables agents to create personal signatures.
Agents need the Manage Signature (SVC_MANAGE_SIGNATURE_PRIV) privilege to use this feature.
This privilege is included in the standard Job Roles:

Next Gen Human Resources Help Desk Agent

Next Gen Human Resources Help Desk Manager

Next Gen Human Resources Help Desk Administrator

Internal Help Desk Agent

Internal Help Desk Manager

Internal Help Desk Administrator
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This privilege has also been granted to the following Duty Roles:

HR Service Request Administration

HR Service Request Analysis

HR Service Request Management
Internal Service Request Administration
Internal Service Request Analysis

Internal Service Request Management

Use the following steps to configure this feature:

You can also see a demo of how to configure this feature here: Create a Personal Signature

1.

S

Go to Setup and Maintenance.

2. Click the Task icon.

3. Click Search.

4.

5. Search for the profile option code for the type of Help Desk that you're using:

Search for the Task Manage Global Search Profile Options.

o ORA_SVC_HRHD_ENABLE_PERSONAL_SIGNATURE for the HR Help Desk
o ORA_SVC_ISR_ENABLE_PERSONAL_SIGNATURE for the Internal Service Request Help Desk

Set the site level profile value to Yes.

Click Save and Close.

Click Done.

You need to sign out and sign in again for this change to take effect.

The agent's signature will be included in the body of the email. You don't need to include more signatures in the email
template.

How do | manage my personal signature for Help Desk?

You can add or change your personalized email message signature including adding a company logo.

If you've used SmartText in the past as a way to define your signature, you might see a performance improvement using
this method to create your signature.

You can see a demo of how to manage your signature on Video Hub. (For managing signatures, start at the 1:35 minute
mark): Create a Personal Signature

Here's how you can create and manage your personalized signature:

1.
2
3.
4.
5

. Use the icons below to format text, add links, or insert images.

6.
7.

Navigate to the Help Desk menu on your home page and click the My Signature Quick Action.

. The signature name is defaulted to My Signature.

Enter a name for your signature (limited to 50 characters with no special characters)
Enter the text for your signature line.

Note: There's a size limit to your signature. If you experience issues with sending messages with images, try
reducing the size of your image.

Click Save and Close.
Now when you're signed in as a help desk agent, your personalized signature is displayed in messages.
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How do | control user types displayed in the contact
picker?

You can configure the types of HCM contacts that are visible in the contact picker.
Here's how you set the profile options to control visibility in the contact picker:

Navigate to Setup and Maintenance.

Click the Tasks icon.

Click the Search link.

Enter Manage Administrator Profile Values in the Search field.

Click Search.

Click the Manage Administrator Profile Values link.

In the Search field, enter the profile option code from the following table.
Click Search.

NSV AUN

Profile Options to Control What's Displayed in Contact Picker

Profile Option Name Profile Option Value Description
ORA_HELPDESK_CONTACT_PRIMARY_ Primary Determines if all assignments or only the
ASSIGNMENT All primary assignment is displayed in the

search results.

ORA_HELPDESK_CONTACT_TERMINATED_  Active Determines if both active and terminated
EMPLOYEES All employees or only active employees are
displayed in the search results.

ORA_HELPDESK_CONTACT_ASSIGNMENT_ E,C Help Desk supports assignment types of
TYPE Employee (E), Contingent Worker (C), Non-
E,C,P,N Worker (N) and Pending Worker (P). This

profile option lets you either include all
types in the contact picker results or just

the Employees and Contingent Workers.
(Note: Pending workers can't open help desk
requests)

9. Select the appropriate profile value.
10. Click the link for the profile option in the search results.
11. Click Save and Close.
12. Click Done.

The default value for each profile option is All.
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Why can't | add my help desk managers as resources to
new queues?

This could mean that the help desk manager only has access to the Help Desk Manager role.

You need a data security policy (DSP) that grants access to all requests. To grant required access for your business
needs, assign both the HR Help Desk Agent role and the HR Help Desk Manager role. This allows the DSP that grants
access to all SRs in all queues.

What happens when multiple object workflow conditions
are met?

When multiple object workflow conditions are met, the following actions might take place:

1. Sequential Processing: Process the workflow conditions in a sequential manner based on the order they're
defined. Each condition is evaluated, and if the condition is met, the associated actions are executed.

2. Execution of Actions: If multiple conditions are met, the actions associated with each met condition will be
executed. This means if there are multiple workflows with different actions, all actions for the met conditions
will be triggered.

3. Order of Execution: The order in which the conditions and their respective actions are executed can be crucial.
Depending on the configuration, it could impact the final outcome, especially if actions have dependencies on
previous actions or conditions.

4. Notification and Logging: Typically, any actions performed because conditions are met, such as sending
notifications, updating records, or invoking other processes, will be logged for auditing and tracking purposes.

To ensure your desired outcome, carefully design the workflow conditions and actions, considering their sequence
and potential interactions. For example, if there are many "Before Update" triggers, consider combining the Object

Work Flows (OWFs) so that they don't run at the same time to avoid a run-around condition. You should also test the
workflows to observe their behavior and make changes as needed.

What's the difference between a message and a
conversation?

Use conversations for communication and team collaboration with other resources within your organization. Use
messages to send messages to customers or team members.
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How can | restrict access to categories in Help Desk?

To restrict access to categories in Help Desk you can use one of these possible options:

Solution Option 1

Set up multiple business units where categories can be managed through business units.

Navigation: Setup and Maintenance > Service > Business Units > Manage HR Help Desk Service Categories for Business
Unit

See: How are business units set up for Service and Help Desk?

Solution Option 2
Change Data Security Policies (DSP).

| cauTiON:

You can't change Oracle predefined data security policies. You must create your own. Be very careful when creating Data
Security Policies.

See: How do | define system-access-group-based data security policies?

How do | define access-group-based data security policies?

How do | remove a smart action from the Smart
Navigator?

You can remove entries from the Smart Navigator so that unnecessary actions aren't shown to agents. For example,
only those modules used and relevant to the agents can be listed, while all others are hidden.

Showing only relevant links to users simplifies navigation for agents and avoids confusion if they were to navigate to a
module that isn't in use.

Limiting options is done by extension in Visual Builder Studio (VBS). The Help Desk Administrator needs the ability to
make changes using VBS. No extra privileges are required.

1. Navigate to Visual Builder Studio.

2. Navigate to Oracle CX Help Desk Ul Extension App >
helpdesk

3. C(lick the Variables tab.

4. Click the Constant hideHcmNavEntries.
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5. For Default Value, add the exact names of the items from the Smart Navigator, using double quotes
around each item, comma separated items, and the entire list within brackets. For example, \["Workforce
Modeling","Learning","Compensation”,"Team Social Reputation"\]

6. Save your changes.
7. Preview to make certain they're showing correctly.
8. Publish your changes.

Note:
- Theitems can either be the general category or individual items within the category.

- When entering the values in hideHcmNavEntries, the names must exactly match those found in the Smart
Navigator. The names are case-sensitive.

For a video demonstration of this feature, see: Limiting HCM Smart Navigator Options in Help Desk

How can | remove the Copy or Close options from the
actions bar?

When viewing a request, by default the action bar has the option to either Close or Copy a request. You can remove one

or both of these options. This will prevent employees from prematurely closing or copying help desk requests.

To limit the actions that an employee can do:

From the Navigator, go to Configuration > Visual Builder.

Navigate to Oracle CX HelpDesk Ul Extension App > helpdesk > employee > service-request-detail.

Click the Variables tab.

Click enableActions.

Choose the appropriate option from the drop-down list:
a. AllActions: Both Close and Copy actions are shown
b. CloseAction : Only Close action is shown, Copy action is hidden.
c. CopyAction: Only Copy action is shown, Close action is hidden.
d. NoAction: The entire action bar is hidden.

6. Preview to make certain that the change is working as expected.

7. Publish your changes.

A WND

Note: If neither option is allowed, or if only Close is allowed when the help desk request is already closed, the bar at
the top of the page is removed.

For a video demonstration of this feature, see: Limit the Options Given to Employees.
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How do | configure Help Desk so that requests can be
escalated to a case?

Escalations allow Help Desk agents to forward sensitive issues like grievances to the Case Management team. You can
configure HR Help Desk (or Internal Help Desk) to allow agents to copy information from a help desk request to create a
case. This topic shows you how to configure this feature.

While grievance processes are the most likely use for this feature, Escalate to Case can be used for any type of
escalations your organization needs to forward from the Help Desk to the Case Management team.

For a video demonstration on configuring this feature, see Escalate a Help Desk Request to Case.
Here are the high level steps to enable this feature:

1. Add the Action Number to the layout for Action Plan Actions in Application Composer.
2. Create an Action Plan of type HRHD (or ISR) that creates a Case in Setup and Maintenance.

3. Set the Action Number in the Visual Builder variable that will be executed when an agent performs Escalate to
Case in Visual Builder.

4. Enable the Smart Action Escalate to Case for either the HR Help Desk or Internal Help Desk as appropriate in
Application Composer.

Detailed instructions for each step:

1. Add the Action Number to the Layout for Action Plan Actions

1. Create or enter a Sandbox that has Application Composer as a chosen tool by going to Navigator > Tools >
Sandboxes.

From the Tools drop-down list choose Application Composer.
In the left-hand panel, set Application = CRM Cloud.
Navigate to Objects > Standard Objects > Action > Pages.
Under Landing Page Layouts:
a. Duplicate the Standard layout.
Name the New Layout "Layout with Action Number" or something similar.
Click Save and Edit.
Click the Edit icon at the top of the large box under the Layout Name.
Select Action Number from the Available Fields.
Click the single Right Arrow to move it to Selected Fields.
Click Save and Close.
Click Done.
Complete the same set of steps (a-h) in the step above for Creation Page Layouts and Action Details Layout.
When this is complete, return to the Home Page.
Change the Sandbox Mode to Preview as if Published.
Click Yes to go into Preview mode to test that the Action Number can now be seen.

10. Navigate back to Setup and Maintenance > Help Desk > Action Plans > Action Plan Actions. If you Create Action
or click a link to an existing action, you should be able to view the Action Number.

u bk UN
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2. Create an Action Plan that creates a Case from a Help Desk Request

1. Navigate to Setup and Maintenance.
2. Select Help Desk from the Setup drop-down list.
3. In Functional Areas, click Action Plans.
4. C(lick the link for Manage Action Plan Actions.
5. Click Create Action.
6. Complete all required fields, and any others that you'd like to use.

o Action = the action name

- For example, Escalate HRHD to Case for HR Help Desk, (Escalate ISR to Case for Internal Help Desk)
or some other unique name of your choosing.
o Type = Case

o Visibility = Internal Only

o Context = HR Help Desk Request

o Duration =1Days (this is irrelevant, but the field is required)
o Stripe Code = HR HelpDesk Request Stripe

o Object Link Type = Object Link Type of escalates

o Check Copy Attachments

7. Add any attributes that you'd like to include when creating the Case.
o Inthe Attribute column, add those fields you want to have set to a value in your escalated Case.

o In Mapped To, define from where the value for the Case attribute comes.
o For more details, see How do | manage action plan actions?

Create Action: Escalate to Case
8. C(lick Save and Close.
9. Click Done.

3. Set the Action Number in the Visual Builder Variable

1. From the Navigator, go to Configuration > Visual Builder.
2. Navigate to Oracle CX HelpDesk Ul Extension App > helpdesk > agent > service-request-escalate > service-
request-escalate-start.
3. Click the Variables tab.
4. Enter the Action Number for the appropriate Constant:
o hrhdActionNumber to escalate an HR Help Desk Request to a Case

o isrActionNumber to escalate an Internal Help Desk Request to a Case.

5. Publish your changes. (To test in preview mode before publishing, you'll need to complete the next section first,
and then restart Visual Builder Studio from within the Sandbox that you'll create.)

4. Enable the Smart Action "Escalate to Case"

1. Create or enter a Sandbox that has Application Composer as a chosen tool by going to Navigator > Tools >
Sandboxes.

2. From the Tools drop-down list choose Application Composer.

3. Click the Smart Actions link.

4. Type Escalate and enter to search.
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ui

Change the value for Enabled to Yes for the appropriate Smart Action "Escalate to Case" for either HR Help

Desk or Internal Help Desk.

6. Close the Tab and return focus to the Application Composer.

7. Under the Sandbox Mode drop-down list, choose Preview as if Published.

8. C(lick Yes to continue to enter the preview mode.

9. Navigate to Help Desk > Help Desk Requests.

0. Clink on alink to an existing Help Desk Request.

11. Type 'Escalate to Case' in the action bar to make certain the option is shown in the list.

12. To test this feature end to end before publishing, you can start Visual Builder from within the Sandbox Preview,
and then Preview Visual Builder. This allows it to be tested end-to-end. Otherwise, you can continue without an
end-to-end test.

13. Return to Edit Mode in Application Composer.

14. Publish the Sandbox.

How can | remove the standard text from the email
acknowledgment?

The text can't be completely blanked out because the Short Text field in the Message Properties is a required field.
However, it can be shortened using the following steps:

1. In Setup and Maintenance, go to the Manage Messages task.
2. Search for and edit the message SVC_EMAIL_ACK_FOR_KNOWN_CUST
3. You can delete the contents of the User Details field and edit the Short Text as desired.

How can | restrict who can view help desk requests by
category or type?

To make specific categories of requests visible to some employees and not others, do the following:

Create your own conditions and data security policies for the SVC_CATEGORIES object. Then, associate those data
security policies with the appropriate user roles. Your new conditions then identify which categories are visible to
specific user groups.

How can | hide the queue for employees in HR Help Desk
(Classic)?

To hide the queue field in create request page for a particular role, set the hidden property of Queue field on the page
layout to Expression with the following Groovy script.

def secCtx = adf.context.getSecurityContext ()
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if (secCtx.isUserInRole('<RoleCode>))
return true
else

return false

Note: Replace the Role Code value with the role for which the field needs to be hidden.

Can | enable milestones for requests that were created
before milestone configuration was completed?

Milestone generation starts from the point the milestone configuration was completed. If the catalyst for creating a
milestone was before the milestone configuration being complete, there's no way to go back in time and create those
milestones.

Whether any milestones are applied to these in-flight Requests depends on the milestone's Start Condition.

For example, if a First Response milestone is supposed to be created when the Request was created, but the milestone
creation was completed after the Request already existed, then you'll not have the First Response milestone for that
Request.

However, if you also created a milestone to Confirm Closure when the Request is put in a Waiting status, and this
milestone was configured immediately after the Request was created, then the new Confirm Closure milestone will be
added if the Request's status is changed to Waiting.

How do | enable Computer Telephony Integration (CTI)
for Help Desk in the Redwood user experience?

Here's how:
To enable users to access the availability controls, check for the following:

In Setup and Maintenance, confirm:

Manage Administrator Profile Values: ORA_SVC_MCA_GLOBAL_PRESENCE_ENABLED = Yes
Manage Administrator Profile Values: SVC_HD_SHOW_AVAILABILITY =N
Manage Omnichannel Profile Options: SVC_ENABLE_OMNI = Yes

Users need to set their availability in the Global Shell.

For more information about CTI see:

Playbook: How do I use Computer Telephony Integration (CTI)?
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- Video demonstration: Help Desk Computer Telephony Integration (CTI)

How do | enable the Create Request by Interview button
for Help Desk?

To be sure employees provide all necessary information to agents during the first interaction, enable the Create Request
by Interview button. Here's how:

1. Create an interview using Oracle Policy Modeler and deploy the interview to your Oracle Intelligent Advisor hub.
2. Configure the Create by Interview button for the Employee flow, if desired:
a. In Visual Builder Studio, open Oracle CX relpdesk Ul Extension App.
b. Select heipdesk > employee in the 1eft-hand panel.
c. Inthe right-hand panel, under the Variable section, set the following constants to configure the
interview.

You can click the Show in Variables link to open the Constants page and enter the variables there.
For HR Help Desk:

o lAenableCreateHRHDBYyInterview = true
o |AhrhdOpaHubUrl = Your Intelligent Advisor Hub URL
o IAhrhdOpaDeploymentName = Deployment name of the project created using Policy modeler

For Internal Service Request Help Desk:

o lAenableCreatelSRBylInterview = true
o lAisrOpaHubUrl = Your Intelligent Advisor Hub URL
o lAisrOpaDeploymentName = Deployment name of the project created using Policy modeler

3. Configure the Create by Interview button for the Agent flow, if desired.
a. InVisual Builder Studio, select heipdesk > agent > elastic-search-sr-list on the 1eft-hand panel.

b. Inthe right-hand panel, under the Variable section, set the following constants to configure the
interview.

You can click the Show in Variables link to open the Constants page and enter the variables there.
4. Once the variables are entered, click Publish.
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How can | populate the Primary Point of Contacts Area of
Responsibility (AOR) details in the Help Desk SR Details

page?

If the HR Help Desk team needs to see AOR details in the SR Details page, you can populate this information after SR
creation by doing the following:

Location, BU, and Department aren't standard fields used in a Help Desk SR. These fields are captured from HCM
database tables. You'd use script (REST API) doc link to capture these attributes.

See the REST API documentation to capture Department or Location.

As an alternate solution, you can use the following script as a guide. Change to meet your business requirement:
def hcmPersonlListVL = hcmPersonList

while (hcmPersonListVL.hasNext ())
{

def hcmPersonListRow = hcmPersonListVL.next() ;
def primaryFlag = hcmPersonListRow?.PrimaryFlag;
if (primaryFlag == "Y"){

def loc=hcmPersonList?.last()?.LocationName;
def bu=hcmPersonList?.last()?.BusinessUnitName;
def dp=hcmPersonList?.last()?.DepartmentName;
if (loc !'= null && bu != null && dp '= null) {
setAttribute ('LocationSite_c',loc);
setAttribute ('BusinessUnit_c',bu);

setAttribute ('Department_c',dp);

break;

}

}

}

How can | notify all members of a queue for help desk
related events?

When a notification event is defined, here's how you can identify all members of a queue as recipients of the
notification.

Note: Many agents defining a notification that's sent to all members might have a slight impact on performance in
the delivery of the notification. Oracle recommends that you don't use this notification recipient option for queues

with a large membership.

To enable this feature:

1. In Setup and Maintenance, click the Tasks icon to expand the options and click the Search link.
2. Type Manage Administrator Profile Values and click Search.
3. Click the Manage Administrator Profile Values task.
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4. Search for the appropriate Profile Option Code:

o For HR Help Desk: ORA_ENABLE_QUEUE_MEMBER_HELPDESK_NOTIFICATIONS

o For Internal Service Request (ISR) Help Desk:
ORA_ENABLE_QUEUE_MEMBER_INTERNAL_SR_NOTIFICATIONS

5. On the Site Level line, update the value to Yes.
6. Click Save and Close.
7. Click Done.

Once you've enabled the appropriate profile option, you now need to define a notification trigger as you typically would
through a sandbox in Application Composer then publishing it.

For detailed instructions on defining a notification trigger, see: How do | define notification triggers?

After enabling the feature and defining the notification trigger do the following:

1.

From the Navigator menu, expand the Tools section and click Notification Preference Manager.

2. From the Object drop-down list, select either HR Help Desk Request or Internal Service Request as

ui

7.
8.
9.

appropriate.

Click + Add.

Fill in all required fields and drop-down lists.
o Enabled = Yes

o OverrideFlag = Yes

o Triggering Event = The new notification trigger that you'd like to override to send to the entire queue's
resources.
o Notification Name and Description should give other administrators an understanding of what this
does.
In Recipients, click the pencil icon to edit the recipients.
To send to all members of the queue, click the checkbox option for Bell Notifications or Email Notifications as
desired for the line All Queue Members.
Add the New SmartText to give an appropriate message.
Click Publish.
Click Save.

For a video demonstration showing this configuration, see: Notify All Members of a Queue

How do | configure Help Desk so that agents can enable
their presence in the global header?

Enable the ORA_SVC_MCA_GLOBAL_PRESENCE_ENABLED profile option so Help Desk Agents can set their availability
in the global shell using the Redwood user experience. Here's how:

Only enable this profile option if you're using Service Center in the Redwood user experience.

VA WNRD

Navigate to Setup and Maintenance and open the Tasks panel tab.

Click Search from the list of displayed tasks.

Type Manage Admin in the Search field.

From the displayed list of tasks, click Manage Administrator Profile Values.

Search for the profile option code ORA_SVC_MCA_GLOBAL_PRESENCE_ENABLED.
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6.

7.

8.
Note:

1

ov A WN

0 P 3

10.

In the Profile Values region, specify the values in the Profile Value column for the Site Profile Level to Yes if
you want all users to set their presence from the global header.

Or, set the Site level value to No and add a new row for every user who would set their presence from the
global header.

Click Save and Close.

The global header controls are only available in pages within Redwood apps running on AppUI v2. If you were

using the presence feature available before that version, you'll need to revert those changes to configure global
presence using following the steps:

Navigate to Setup and Maintenance.

Click Tasks.

Search for the Manage Administrator Profile Values task.

Click Search.

Click the link for the Manage Administrator Profile Values task.

On the Manage Administrator Profile Values page, enter the Profile Option Code:
SVC_HD_SHOW_AVAILABILITY.

Click Search.

In the Profile Values region, set the Profile Value for Site to N.
Click Save and Close.

Click Done.

How do | do enable dynamic links for email notifications
in Help Desk?

Adding dynamic links in email notifications for help desk allows recipients the ability to drill directly into a help desk
request from an email notification. Here's how to enable:

First, make sure you've set the ORA_SVC_ENABLE_DYNAMIC_LINKS_FOR_HELPDESK_NOTIFICATIONS profile option to

Yes.

P WN

In Setup and Maintenance search for the Manage Service Request Dynamic Links task.
Click the object Service_Request_HRHD.

Click Add.

Select the business unit (BU) and enter the URL to the object detail page.

To get the required URL: Navigate to a Help Desk request from a different window.
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a. Copy the URL. For examDIEthtps ://fa-wzzd-pintlabfadev.fa.ocs.oc-test.com/£fscmUI/redwood/helpdesk/
edit-hrhd?srNumber=HRHD0000007026

b. Remove everything from the URL after the question mark (?) and add the following: (srNumber={0}

c. The final URL that you enter should look like this: https://fa-wzzd-pintlabfadev.fa.ocs.oc-test.com/
fsemUI/redwood/helpdesk/edit-hrhd?srNumber={0}

5. Click Save.
6. Configure a notification trigger. How do | enable notifications?

Be sure you're defining a notification trigger for a Help Desk request.

How can | enable or disable email addresses in the email
channel?

Search for the Manage Communication Channels task in Setup and Maintenance. Set the email channels that you want
as active or delete the ones which you don't need.

How can | hide the Add Infolet option from agents?

You can restrict access to analytics infolets or reports by removing the respective duty role. For example, for agents,
remove the Next Gen HR Help Desk Agent Transaction Analysis Duty role.

How can | get the Help Desk Requests tile to appear on
my homepage?

Contact your administrator to make sure you've been set up as a Service Manager or Service Representative and that
you're assigned to both the Next Gen Human Resource Help Desk Agent and Resource roles.

How do | make sure the only resources shown in the
AssignTo field are associated with the queue that's
assigned to the help desk request?

To limit the AssignTo field options to only included members of the queue:
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1. Navigate to Setup and Maintenance and search for the Manage Administrator Profile Values task.
2. Search for the ORA_HELP_DESK_ASSIGNEE_LIST in the Profile Option Code.
3. Change the Profile Value to QueueMembers.

Note: You won't see the changes until the next time you sign in. If you're changing the assigned queue, you don't
need to save the new queue before the new AssignTo takes effect.

To see a video demo of this topic, see: Show only Resources for the Queue in the AssignTo Field.

How do | change the display name of attachment
categories?

You can change the name from the Manage Attachment Categories task in Setup and Maintenance.

Can | manually delete a closed help desk request?

You can't delete a closed request manually. The Delete Closed HR Help Desk Requests job will delete closed requests
that have been closed the number of days specified in the ORA_SVC_CLOSED_HRHD_RETENTION_DAYS profile option.

How can | automatically update a help desk request
status after a customer response?

You create a trigger in Application Composer on the Message child object of either the Service Request parent object or
the HR Help Desk Request object

Here's how:

1. Create a new sandbox or open an existing one. From the sandbox Tools menu, select Application Composer.
In the object panel, expand Standard objects, then HR Help Desk Request (or Service Request), then the
Message child object, and then select Server Scripts.

Click the Triggers tab, then click Add a new Trigger.

From the Trigger drop-down list, select Before Insert in Database.

Enter an error message in case the validation fails.

In the Trigger Definition field, paste the following Groovy script:

N

cupwWw

Note: Change CUST_REPOND in the script to your own status value.

def parentSR = ServiceRequest
def msgSource = SourceCd
def msgChannel = ChannelTypeCd
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def parentStatus = ServiceRequest?.StatusCd
def msgType = MessageTypeCd

if (msgSource =='ORA SVC_INBOUND MSG' && msgChannel =='ORA SVC_EMAIL' &&
msgType == 'ORA_SVC_CUSTOMER ENTRY' && ParentMessageld '=null)

parentSR.setAttribute ('StatusCd', 'CUST_RESPOND')

7. Click Save and Close.

How do | remove agent access?

You can end date the resource with following steps:

Navigate to the Resource Directory (Navigator > Others> Resource Directory).
Click the Tasks icon and select View Resources.

Search for the resource and open the record.

Populate the To Date field with the current or past date.

Save.

VAWNRA

The agent will no longer have access to help desk requests.

How do | enable dynamic links for email notifications in
Help Desk?

Your administrator can add dynamic links so that recipients can drill directly into a Help Desk request from an email
notification.

To enable this feature, ensure that the profile option
ORA_SVC_ENABLE_DYNAMIC_LINKS_FOR_HELPDESK_NOTIFICATIONS is set to Yes.

In Setup and Maintenance, search for the Manage Service Request Dynamics Links task.

In the Manage Dynamic Links page:

1. Click the object Service_Request_HRHD.
2. Click Add.
3. Select the business unit and enter the URL for the object detail page.

To get the required URL, navigate to a help desk request from a different browser window and copy the
URL. For example: https://fa-wzzd-pintlabfadev.fa.ocs.oc-test.com/fscmUl/redwood/helpdesk/edit-hrhd?
srNumber=HRHDO000007026

4. Remove everything in the URL after the question mark (?) and replace it with: (srNumber={0}.

The final URL will look like this: https://fa-wzzd-pintlabfadev.fa.ocs.oc-test.com/fscmUl/redwood/helpdesk/
edit-hrhd?srNumber={0}
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Once this is completed, you want to configure a notification trigger for a Help Desk request.
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